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Notices
FCC Compliance
In order to comply with FCC/CFR47: Part 15 regulations, it is necessary to use Mini HDMI to 
HDMI high-quality triple-screened cable assemblies with integrated ferrite suppression at 
both ends.

Copyright and Trademark Notice
Copyright © 2019, Grass Valley Canada. All rights reserved.

Belden, Belden Sending All The Right Signals, and the Belden logo are trademarks or 
registered trademarks of Belden Inc. or its affiliated companies in the United States and 
other jurisdictions. Grass Valley, Momentum are trademarks or registered trademarks of 
Grass Valley Canada. Belden Inc., Grass Valley Canada, and other parties may also have 
trademark rights in other terms used herein.

External Trademarks
• Baton is a registered trademark of Interra Systems, Inc.
• Cerify TEKTRONIX and TEK are registered trademarks of Tektronix, Inc. Cerify is 

trademark of Tektronix, Inc.
• Dolby. Manufactured under license from Dolby Laboratories. ‘Dolby’, ‘Pro Logic’, and the 

double-D symbol are trademarks of Dolby Laboratories. Confidential unpublished 
works. Copyright 1992-1999 Dolby Laboratories. All rights reserved.

• FlipFactory is registered trademarks of Telestream, Inc.
• FFmpeg. This product uses software developed by the FFmpeg project, 

www.ffmpeg.org, specifically, support for DV is provided by some components of the 
libavcodec and libavutil libraries.

• iCR is a registered trademark of Amberfin, Inc.
• Matrox®, DSX™, DSX.sdk™, DSX.utils™, FlexEffects.sdk™, X.mio2™, X.mio3™ are registered 

trademarks of Matrox Electronic Systems Ltd.
• Morpheus is a registered trademark of Grass Valley.
• Rhozet WFS and Promedia Carbon is a registered trademark of Harmonic inc.
• Pulsar is a trademark of Venera Technologies Pvt Ltd.
• Windows Media. This product is protected by certain intellectual property rights of 

Microsoft. Use or distribution of such technology outside of this product is prohibited 
without a license from Microsoft.

• MXFTk is a registered trademark of OpenCube Technologies SAS

Terms and Conditions
Please read the following terms and conditions carefully. By using Momentum 
documentation, you agree to the following terms and conditions.

Grass Valley hereby grants permission and license to owners of Momentum to use their 
product manuals for their own internal business use. Manuals for Grass Valley products may 
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not be reproduced or transmitted in any form or by any means, electronic or mechanical, 
including photocopying and recording, for any purpose unless specifically authorized in 
writing by Grass Valley.

A Grass Valley manual may have been revised to reflect changes made to the product 
during its manufacturing life. Thus, different versions of a manual may exist for any given 
product. Care should be taken to ensure that one obtains the proper manual version for a 
specific product serial number.

Information in this document is subject to change without notice and does not represent a 
commitment on the part of Grass Valley.

Warranty information is available from the Legal Terms and Conditions section of Grass 
Valley’s website (www.grassvalley.com).

Title Momentum Operator’s Guide

Part Number Issue 1 Revision 1

Revision 2019-04-04, 09:20
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Notices
Important Safety Information
This section provides important safety guidelines for operators and service personnel. 
Specific warnings and cautions appear throughout the manual where they apply. Please 
read and follow this important information, especially those instructions related to the risk 
of electric shock or injury to persons.

Symbols and Their Meanings

Indicates that dangerous high voltage is present within the equipment 
enclosure that may be of sufficient magnitude to constitute a risk of electric 
shock. 

Indicates that the user, operator or service technician should refer to the product 
manuals for important operating, maintenance, or service instructions.

This is a prompt to note the fuse rating when replacing fuses. The fuse 
referenced in the text must be replaced with one having the ratings indicated.

Identifies a protective grounding terminal which must be connected to earth 
ground prior to making any other equipment connections.

Identifies an external protective grounding terminal which may be connected to 
earth ground as a supplement to an internal grounding terminal. 

Indicates that static sensitive components are present, which may be damaged 
by electrostatic discharge. Use anti-static procedures, equipment and surfaces 
during servicing.

Indicates that the equipment has more than one power supply cord, and that all 
power supply cords must be disconnected before servicing to avoid electric 
shock.

The presence of this symbol in or on Grass Valley equipment means that it has 
been tested and certified as complying with applicable Underwriters Laboratory 
(UL) regulations and recommendations for USA.

The presence of this symbol in or on Grass Valley equipment means that it has 
been tested and certified as complying with applicable Canadian Standard 
Association (CSA) regulations and recommendations for USA/Canada.

The presence of this symbol in or on Grass Valley equipment means that it has 
been tested and certified as complying with applicable Underwriters Laboratory 
(UL) regulations and recommendations for USA/Canada.
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Warnings
A warning indicates a possible hazard to personnel, which may cause injury or 
death. Observe the following general warnings when using or working on this 
equipment:

• Appropriately listed/certified mains supply power cords must be used for the 
connection of the equipment to the rated mains voltage.

• This product relies on the building's installation for short-circuit (over-current) 
protection. Ensure that a fuse or circuit breaker for the rated mains voltage is used on 
the phase conductors.

• Any instructions in this manual that require opening the equipment cover or enclosure 
are for use by qualified service personnel only.

• Do not operate the equipment in wet or damp conditions.
• This equipment is grounded through the grounding conductor of the power cords. To 

avoid electrical shock, plug the power cords into a properly wired receptacle before 
connecting the equipment inputs or outputs.

• Route power cords and other cables so they are not likely to be damaged. Properly 
support heavy cable bundles to avoid connector damage.

• Disconnect power before cleaning the equipment. Do not use liquid or aerosol 
cleaners; use only a damp cloth.

• Dangerous voltages may exist at several points in this equipment. To avoid injury, do 
not touch exposed connections and components while power is on.

• High leakage current may be present. Earth connection of product is essential before 
connecting power. 

• Prior to servicing, remove jewelry such as rings, watches, and other metallic objects.
• To avoid fire hazard, use only the fuse type and rating specified in the service 

instructions for this product, or on the equipment.
• To avoid explosion, do not operate this equipment in an explosive atmosphere.
• Use proper lift points. Do not use door latches to lift or move equipment.
• Avoid mechanical hazards. Allow all rotating devices to come to a stop before servicing.
• Have qualified service personnel perform safety checks after any service.

The presence of this symbol in or on Grass Valley equipment means that it has 
been tested and certified as complying with applicable Intertek Testing Services 
regulations and recommendations for USA/Canada.

The presence of this symbol in or on Grass Valley product means that it complies 
with all applicable European Union (CE) directives.

The presence of this symbol in or on Grass Valley product means that it complies 
with safety of laser product applicable standards.
v



Notices
Cautions
A caution indicates a possible hazard to equipment that could result in equipment 
damage. Observe the following cautions when operating or working on this 
equipment:

• This equipment is meant to be installed in a restricted access location.
• When installing this equipment, do not attach the power cord to building surfaces.
• Products that have no on/off switch, and use an external power supply must be 

installed in proximity to a main power outlet that is easily accessible.
• Use the correct voltage setting. If this product lacks auto-ranging power supplies, 

before applying power ensure that each power supply is set to match the power 
source.

• Provide proper ventilation. To prevent product overheating, provide equipment 
ventilation in accordance with the installation instructions.

• Do not operate with suspected equipment failure. If you suspect product damage or 
equipment failure, have the equipment inspected by qualified service personnel. 

• To reduce the risk of electric shock, do not perform any servicing other than that 
contained in the operating instructions unless you are qualified to do so. Refer all 
servicing to qualified service personnel. 

• This unit may have more than one power supply cord.  Disconnect all power supply 
cords before servicing to avoid electric shock.

• Follow static precautions at all times when handling this equipment. Servicing should 
be done in a static-free environment.

• To reduce the risk of electric shock, plug each power supply cord into separate branch 
circuits employing separate service grounds.

Electrostatic Discharge (ESD) Protection
Electrostatic discharge occurs when electronic components are improperly 
handled and can result in intermittent failure or complete damage adversely 
affecting an electrical circuit. When you remove and replace any card from a frame 

always follow ESD-prevention procedures:
• Ensure that the frame is electrically connected to earth ground through the power cord 

or any other means if available.
• Wear an ESD wrist strap ensuring that it makes good skin contact. Connect the 

grounding clip to an unpainted surface of the chassis frame to safely ground unwanted 
ESD voltages. If no wrist strap is available, ground yourself by touching the unpainted 
metal part of the chassis.

• For safety, periodically check the resistance value of the antistatic strap, which should 
be between 1 and 10 megohms.

• When temporarily storing a card make sure it is placed in an ESD bag.
• Cards in an earth grounded metal frame or casing do not require any special ESD 

protection.
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Battery Handling
This product may include a backup battery. There is a danger of explosion if the 
battery is replaced incorrectly. Replace the battery only with the same or equivalent 
type recommended by the manufacturer. Dispose of used batteries according to 

the manufacturer’s instructions. Before disposing of your Grass Valley equipment, please 
review the Disposal and Recycling Information at:

 http://www.grassvalley.com/assets/media/5692/Take-Back_Instructions.pdf

Cautions for LCD and TFT Displays
Excessive usage may harm your vision. Rest for 10 minutes for every 30 minutes of 
usage.

If the LCD or TFT glass is broken, handle glass fragments with care when disposing 
of them. If any fluid leaks out of a damaged glass cell, be careful not to get the liquid crystal 
fluid in your mouth or skin. If the liquid crystal touches your skin or clothes, wash it off 
immediately using soap and water. Never swallow the fluid. The toxicity is extremely low 
but caution should be exercised at all times.

Environmental Information

European (CE) WEEE directive.

This symbol on the product(s) means that at the end of life disposal it should not be mixed 
with general waste.

Visit www.grassvalley.com for recycling information.

Grass Valley believes this environmental information to be correct but cannot guarantee its 
completeness or accuracy since it is based on data received from sources outside our 
company.  All specifications are subject to change without notice.

If you have questions about Grass Valley environmental and social involvement (WEEE, 
RoHS, REACH, etc.), please contact us at environment@grassvalley.com .

On Receipt of the Momentum System
Any equipment is supplied in dedicated packaging provided by the manufacturer and 
should not be accepted if delivered in inferior or unauthorized materials.
vii
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Notices
Carefully unpack the system components and check them against the packing list. 
If there is anything incorrect notify your Grass Valley Partner, or Grass Valley, at once.
Check that the equipment has not been damaged in transit. If any damage has occurred 
notify your Grass Valley Partner (or Grass Valley directly) and the carrier immediately.
Always retain the original packing materials if possible, they could prove useful should it 
ever be necessary to transport or ship the system units.

Always read the Installation Guide, Configuration Guide and the Operator’s Guide (separate 
manuals) carefully, it will provide you with helpful hints and tips about care and 
maintenance and help you get the most out of your Momentum system.

In the unlikely event of an equipment failure, contact your Grass Valley Partner, or Grass 
Valley, at once, contact details are at the rear of this manual.
viii
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Introduction
Welcome to Momentum!
Momentum is a powerful, media asset management and workflow automation system, 
designed to suit the requirements of leading media organizations. An incredibly flexible, 
enterprise level system, Momentum features fully configurable workflows, detailed process 
reporting and extensive integration with third party applications and platforms, enabling 
you to take complete control of your media assets, operations and business processes.

Based on service-oriented architecture (SOA), Momentum provides access to your business 
processes through the Internet or the company intranet - supplying an extensive suite of 
tools for different stages of the production process.

Momentum maintains and tracks your media assets in an Oracle database, makes them 
searchable, augments them with rich metadata, manages various job queues, controls 
archive and other third party devices, and enables assets to be ingested and exported in a 
number of different formats.

Fig. 1-1:  Example Momentum Workflow Page
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Momentum Key Features
Most of these operations take place through managed workflows, in which you can define 
when and how a new or existing asset requires additional automated or manual processing 
to meet your needs. Powerful workflow modeling tools provide the building blocks to 
manage media assets on the Momentum Workflow page, a canvas on which your business 
processes are represented as a series of interconnected and easy-to-use schematic 
diagrams. Using the workflow functions, you can design and implement your workflows 
and the desired processing paths for the different media asset files. In addition, you can also 
monitor and analyze the progress of running processes and any associated tasks. As a file-
based solution,

In summary, Momentum enables you to:
• Automate the processing of content through reliable and repeatable workflows.
• Extend your organization's capability as operations grow through configurable 

workflows and resource pooling.
• Deliver content to a range of platforms including social media and VOD applications.

Momentum Key Features
Momentum supports the following features:

• User configurable workflows with support for scripting in C#, Python, IronPython and 
Visual Basic.

• HTML5-based user interface for web browser access to a multi-user environment for 
media-file cataloging and faster content distribution.

• Automated media file ingest and delivery using watch folders, standard file transfer 
protocols, and proprietary applications Signiant and Aspera.

• Automated metadata ingest using watch folders, BXF messaging and other third party 
system integrations.

• Video and audio editing using the built-in editor or other integrated SAM editors.
• Desktop proxy browsing, including automated generation of proxy files.
• Integration with a wide range of third party, automated quality checking, transcoding 

and archive devices.
• Integration with other SAM products such as the Go! Video Timeline Editor, sQ Suite 

and Morpheus Playout Automation.
• Configurable metadata publishing templates for delivery to linear playout and non-

linear delivery platforms.
• Web services API for third party integration.
• Oracle 12c database clustering.
• Support for Microsoft Windows 2012 with IIS for dual redundancy and user load 

balancing.
• Reporting and statistical analysis to understand processes and improve capacity 

planning.
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Summary of Supported Formats
The following formats are supported by Momentum:

The management and support of the different formats strongly depend on the third party 
application and devices controlled by the Momentum system. For information on 
supporting specific formats, refer to the third party documentation.

For more detail on supported formats, see Appendix B Supported File Formats, on page 219.

Supported Web Browsers
The Momentum system uses a web-based Graphical User Interface based on HTML5. It is, 
therefore, recommended to use a Google Chrome browser to access the Momentum user 
interface. We cannot guarantee that any other browser can provide the full Momentum 
operational capabilities.

Type Formats

Wrappers • MPEG-2 Transport Stream 

• MPEG-2 Program Stream 

• MPEG-4 Parts 1, 14 & 15 

• 3GPP

• MOV

• ASF

• BXF

• GXF

• MXF

Video • MPEG-2 

• IMX 30/50 

• D10

• D11

• XDCAM 

• MPEG-4 AVC (H.264) 

• VC-1/WMV9

• MPEG-4 Part 2

• H.263

• DV/DVCPro25

• DV/DVCPro50

• DVCPro100/HD

Audio • MPEG-1 

• MPEG-2 

• MPEG-2 AAC

• AAC-Plus (MPEG-4 AAC) 

• HE-AAC 

• PCM

• WMA

• AC3

• Dolby E

Formats All frame format sizes, bit rates and resolutions for SD/HD and mixed workflows, 
including: 

• QCIF

• CIF

• D1

• 720p

• 1080i

• 1080p
3
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Playback Supported File Formats
Playback Supported File Formats
The Momentum system provides built-in media players that enable you to view and 
manage material.

For playback purposes, Momentum supports only an MP4 container with an h264-encoded 
video track and ACC-coded audio.

Other file formats are not supported and playback attempts will result in a blank media-
player pane.
4



Using the Momentum Interface
The Momentum user interface is web-based so that you can work from the Local Area 
Network or from a remote network using a virtual private network (VPN) or similar network 
protocol.

Using an Internet connection and a standard Web client, you can access the login page and, 
after entering your username and password, you can start your session. 

Momentum is HTML5 compatible, therefore, you can use any HTML5 browser, but 
preferably Google Chrome, to display the application pages.

Logging in to Momentum
To log in to Momentum:

1 Open your browser (for example, Chrome) and type in the address bar:
http://<MyMomentumServer>/Momentum/html5/Login.aspx
where <MyMomentumServer> is the hostname of your Momentum Web server. 
The login dialog box appears:

2 Enter your user name and password to login. When logging in for the first time, the 
default username is administrator and the password is password.
When a new session starts, you are redirected to the Momentum Web Site which 
displays a Menu Bar with tabs linking to the pages that you can access according to 
your permissions and user rights, see Figure 2-3.
The top right-hand part of the toolbar displays the username of the current user. Click 
on the user name work area display a drop-down list with an option to change your 
password and an option to log out. When you log out, Momentum remembers the 
current page and returns you to the same page when you next log in.

Fig. 2-2:  Login Screen
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Using the Momentum Main Menu Toolbar
Using the Momentum Main Menu Toolbar
The Momentum main menu toolbar is displayed across the header of all Momentum 
screens and provides links to open the various Momentum screens, see Figure 2-4:

The Main Menu toolbar displays the following pages, depending on the permissions 
assigned to your role or configuration:

• To Do: Contains the list of the tasks to be performed by users. This is the default 
page which appears when you log in for the first time. For information 
on this page, see Chapter 8 Working with User Tasks in the To Do Page, on 
page 149.

• Catalog: Enables you to search the entire database content using metadata 
keywords or criteria.

• WorkFlow: Enables you to create workflows and monitor all the current operations.
• Logger: Enables you to create new segments from existing material.

Fig. 2-3:  Momentum Toolbar

Momentum Main 
Menu Tabs

More Menu 
Options

Currently Logged In User

Connection Status Indicator

Search Tool Pane
Notification Panel Icon

Fig. 2-4:  Momentum Main Menu Toolbar

Additional Menu Items 
in More Drop-down List

Current Active Page 
Always Displayed in 

First Position

Access to Admin 
Menu Items

Open Task Notification Panel

Change Password / Logout
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• Transfers: Enables you to monitor the status of and manage transfer requests for 
material.

• More: Provides access to a drop-down list of additional menu items 
containing:

• Schedules: Enables you to import, export and review Morpheus schedule 
files (.sch) to identify missing materials.

• Pam-Evs: Enables Momentum to ingest files received from an EVS 
Production Asset Manager (PAM) system

• Dashboard: Enables you to monitor the status of running workflow tasks.
• Services: Enables you to monitor the Momentum Servers and Nodes and 

report on their running status.
• Admin: Administrative tools page, which enables you to perform various 

administrative tasks on Momentum, including:
• Defining Users and assigning roles
• Defining metadata and metadata masks
• Configuring attributes for search results
• Editing metadata
• Configuring BXF routes
• Configuring Watchfolder templates
• Defining custom lists
• Managing metadata categories
• Configuring target social media sites
• Setting-up the virtual keyboard
• Defining ISA mappings.

• Logs: Lists the status of the overall operations performed in 
Momentum.

• Stats: Displays statistics about resources and hardware utilization.
• About: Provides information about the version and license configuration 

of this instance of Momentum.

To select a page, click the page tab in the toolbar. Click the More button to see additional 
pages that are not currently visible in the toolbar.

Viewing the Task Notification Panel
The Task Notification Panel enables you to view a list of tasks that require a manual user 
action before they can be progressed through a workflow. For example, a media file may 
require a manual quality check before being re-submitted to the automated workflow.

Note: The position of the page tabs changes depending on the current 
selected page, the tab for which opens in the left-most position at the 
front of the list of tabs.
7
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Viewing the Connection Status of the Task Notification Panel
Open the Task Notification Panel as follows: 
• Click the Task Notification Panel icon at the top-right corner of the screen: .

This opens the Task Notification Panel and lists all unexpired notifications showing 
tasks awaiting manual user interactions, see Figure 2-5:

You can use the Element or Material Id links to go directly to the specific User Action 
workflow element or material respectively. Alternatively, use the appropriate action button 
(Take, Skip to) either to accept the task or to skip it to the next stage of the workflow.

Viewing the Connection Status of the Task Notification Panel
Momentum provides visual feedback to show the current connection status of the Task 
Notification Panel. To do so, it changes the color displayed in the top right-hand corner of 
the Task Notification icon located at the top right of the screen, next the name of the 
logged-in user:

If you hover your cursor over the icon, a tool-tip will inform you as to whether the Task 
Notification Panel is either:

• Connected:

Note: You can only view tasks in the Task Notification Panel if you have been 
assigned the role: CAN_HAVE_TASKS_NOTIFICATION .

Fig. 2-5: User Action Notification Panel

Open Notification Panel 
Icon

User Action Manual 
Review Task Required

User Action Generating 
the Task Required

Button to Take Ownership 
of the Task

Button to Progress the Task 
to an Output Port

Connection Status Indicator
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• Locally disconnected - the node to router connection is down:

• Remotely disconnected - the server to router connection is down:

Overview of the Screen Icons
The following screen icons are common to all Momentum pages:

Screen Icon(s) Function

, , ,   Collapse or expand a screen element or pane. The arrows indicate the direction of 
the expand/collapse action of a pane.

Lock the status of the element.

Add / Create an element.

Delete an element.

Edit an element.

Update / refresh the contents of the pane / element. Also provides an Eject 
function in a Media Player, which can eject and reload a clip.

Maximize / Reduce Down the size of the player.

Display data in a table with thumbnails.

Display data in a table as a list, without thumbnails.

Open / Close a pane or menu.

Planner icon to allow the selection of a date from a calendar.

Delete an element / Close a pane.

Open a workflow page, highlighting the selected element.
9
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Editing Metadata Fields
Editing Metadata Fields
Several Momentum pages enable you to modify metadata associated with material if you 
have the appropriate permissions see the Configuration Guide for more information.

When the metadata of an item of material is displayed in a Details pane, it is initially in a 
read-only state as shown below:

To modify the metadata values:
1 Click the edit icon  at the top right corner of the pane. This enables the text field 

input for all the editable metadata listed on the pane as shown below:

2 Enter the new values as required.
3 Click the edit icon  again to save the changes into the database.

If an item of metadata cannot be modified, it remains grayed out. For further 
information on metadata, see Chapter 5 Working with Metadata, on page 93.

Working with Momentum Tables
Tables in Momentum are dynamic objects and you can decide which information appears.

Fig. 2-6:  Metadata Read-only State

Collapsible Metadata Groups

Fig. 2-7:  Metadata Edit State

Editable Metadata Field

Non-editable Metadata Field
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A table is composed of a variable number of rows and columns, and can be generated 
automatically by the software using predefined criteria or in response to a user’s query. In 
both cases, the first row of the table is the header of the table.

The header reports the names of the fields in the table. Each name is in the color blue as it 
is an active element. The following rows report the data of the fields described in the 
header.

Hovering the mouse over a row, changes its background color to a dark shading to 
highlight the position in the table as shown below:

Clicking on a row, selects the row itself and outlines the active row in blue.

When selected, the row becomes an active element. Selecting a row can display new data 
in other panes on the page and can also activate a media-player for playback. Sometimes 
the active state is bound to the presence of buttons in one or more cells of the table. In this 
case, the selected row, or the content of one or more of its cells, is the target of the available 
modifications.

When hovering the mouse over a header field, a new symbol appears on the right side of 
the field cell. Click on the triangle symbol to open a new, drop-down menu.

This menu contains two options which enable you to change the sort order of the column 
data between ascending or descending values:

Fig. 2-8:  Generic Table

Fig. 2-9:  Hovering the Mouse over a Table Row

Fig. 2-10:  Selecting a Row in a Table

Fig. 2-11:  Hovering the Mouse over a Field in the Table Header 
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Save Pending
The Columns option displays a second level menu as shown in the example below:

This menu lists all the field names available for inclusion as columns of the table. By default, 
all fields appear but you can choose to hide any columns that are not required by 
unchecking the appropriate checkbox(es).

Clicking on a header cell displays a shortcut to change the sort order of the data in the 
related column. In this case, the direction of the triangle next to the field name indicates 
the sort type (either ascending or descending).

Save Pending
Whenever an asterisk (*) is displayed near the title in the heading of a pane, it means that 
the data in the pane was modified but the modified version is still unsaved.

As a general rule, to avoid the loss of data, if a pane is in a save-pending status and you 
activate a different pane or try to change page, a pane opens to warn you that data can be 
lost if a save action is not performed.

Media Players
Some of the Momentum pages include a Media Player, which you can use to review the 
material files as shown below:

Note: The Click & Drag action on an column header enables you to drag the 
related column to a different position in the table.

Fig. 2-12:  Table Header First Level Menu

Fig. 2-13:  Table Header Second Level Menu

Fig. 2-14:  Selecting a Field in a Table
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The Momentum Player Controller automatically selects the appropriate Player for the 
selected Media Asset.

The header reports the name of the material selected and its duration in hh:mm:ss:ff 
format.

At the right side of the header is the icon  which maximizes the size of the player on the 
page (this is not available on all the media players).

The icon  collapses the player on the page (this is not available on all media players).

On the left side of the player is the Tracks button. Click this button to display the following 
menu:

The first part of the Tracks menu enables you to select which elements, related to the 
selected material, are available for the playback. The options are: Media assets, Audio 
tracks or Captions. You can expand each of these options to select any elements of that 

Note: If the Player cannot play-back the selected material (for example, an 
auxiliary file) all control buttons and the Tracks menu are disabled.

Fig. 2-15: Media Player Pane

Player Control 
Panel

Refresh Pane and/or 
Eject / Reload Clip

Fig. 2-16:  The Player Tracks Menu
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Media Players
kind related to the selected material. The None option in the Captions menu enables you 
to unload subtitle contents to prevent a forced, continuous display in the Player, making it 
possible to view only the video content after visualizing the subtitles.

The View section of the Tracks menu displays a list of all media player controllers currently 
available to Momentum, however, if the selected media asset cannot be played by a 
specific PlayerController, the corresponding item cannot be selected in the View menu. For 
example, you might select either the standard Proxy Player, the GoPlayer or the 
ImagePlayer, if available. The GoPlayer is an optional integration of the Grass Valley Go! 
Media Player running in a Momentum panel.

For more information, see the section Using the Tracks Menu to Change the Media Player 
Controller, on page 142.

Using the Tracks menu, you can select and play-back different instances of a Title, or any of 
the multiple audio tracks or caption files available.

The final part of the Tracks menu enables you to interact with the content of the player, for 
example you can download a proxy file, save the current frame or save an icon.The available 
options are:

• Download proxy 

• Save current frame
• Save icon.

Use the Download proxy option to save the proxy file in the default browser’s download 
folder. If an audio-only asset is selected, the Download proxy option will download an MP3 
format file.

Use the Save current frame option to save a picture of the current content of the player, 
using the maximum resolution available from the HQ version of the material, and store it in 
a folder specified in the section <ThumbFullFramePath> of the configuration file 
MantricsServer.xml.

Note: The Proxy Actions are available only if you have the required permissions.

Fig. 2-17:  The Tracks Menu, Sub-menu Audio Tracks Expanded

Fig. 2-18:  The Tracks Menu, Detail of Proxy Actions Section
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Use the Save icon option to save the current content of the player as an icon or thumbnail 
with a filename reflecting the timecode at that point, and store it in a folder specified in the 
section <ThumbPath> of the configuration file MantricsServer.xml.

A field above the volume control reports the current timecode. This field is not editable but 
it can be selected and its content highlighted and copied for pasting into other fields.

If necessary, you can choose to reload a clip into the Player by clicking the refresh icon , 
which first ejects the clip and then reloads it in the preview server. Momentum also issues 
an eject command when changing the displayed clip and after completing the current task.

An optional GoPlayer, which integrates Momentum with the Go! player, includes two audio 
meters (left and right) just beneath the volume control, which are available if the material 
includes one or more audio tracks. This audio metering component of the QPlayer splits the 
audio signal into two channels (left and right) and renders the loudness of each channel 
graphically. This feature can help to identify whether an audio track is missing.

Regulate the volume using the slider or by clicking the Sound icon, to switch the player 
between Active Sound , and Mute status.

You can drag the playback head along the timeline slider to display different time segments 
of the selected media file. The playback controls are located below the timeline slider as 
shown below:

Note: The Save current fram e option is disabled if the media asset loaded in 
the player is an AUDIO asset.

Note: The Save icon option is disabled if the media asset loaded in the player 
is an AUDIO asset.

Fig. 2-19:  Media Player Current Timecode and Volume Control

Fig. 2-20: Left and Right Audio Meters

Fig. 2-21:  The Basic Media Player Playback Control
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The Media Player controls have the following functions

Move the cursor to a point on the timeline of the player to display a thumbnail and 
timecode for the frame, as shown in Figure 2-22:

On some pages, the media players contain additional functionality to achieve specific goals 
and the control panel of the player may contain additional buttons and icons. These 
specific features are described in the documentation for the relevant page.

Control Function

Go to start.

Go to previous frame.

Play / pause.

Go to next frame.

Go to end.

Note: The player does not add black content at the edges of the frame, if black 
is seen then it is part of the clip, or frame, displayed.

. 2-22:  Timeline Frame Thumbnail

Thumbnail
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Using the Search Tool
Several pages of the Momentum system enable you to review or edit material. To help you 
select the required material, a Search tool is provided. The Search Tool enables you to build 
flexible, complex queries to search for, and match, material in the Momentum database.

Overview of the Search Tool
The Momentum Search tool pane appears as follows:

The Search tool includes the following functional areas:
• Query area - where the search queries are built and managed. The first field is a logical 

operator field, which, in a query composed of only one line, is inactive. From the second 
row onward this field is activated and enables you to toggle or select one of the 
relational operators from the menu shown in Figure 2-24.

Fig. 2-23:  Search Tool Components - Details View

Query area

Saved searches area

Search results display 
area (Details)

Navigation bar

Search result options
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Overview of the Search Tool
• Saved searches area: Displays previously saved searches for use.
• Search result options: Provides Select and Actions menus for use on the 

search results together with buttons to switch between 
Thumbnail and Detail views.

• Search results display area: Displays the results matching the search query 
conditions.

• Navigation bar: For browsing through and refreshing the search results
• Thumbnail images: Make it easier to identify material.
• Checkboxes: Select and activate the material in the search results for 

further actions.

The Search Results menu buttons, Select and Actions enable you to select material in your 
search results and submit that material to further tasks as follows:

• The Select menu provides a short-cut method for selecting or de-selecting all items in 
the search results.

• The Actions menu enables you to perform further tasks on your selected search results;
 

You can choose from the following options:
• Create...: Create a Title or Project and include in the search results 

area.

Fig. 2-24:  Logical Operator Menu

Fig. 2-25:  Actions Menu

Fig. 2-26:  Actions Menu - Create Title Dialog
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• Add to project...: Add the selected item to an existing Project.

• Send to: Lists all Send to workflow elements available in the existing 
workflows. Selecting an element enables the item to enter a 
workflow using the Send To element as a starting point.

• Delete...: Removes the selected material from the system. It deletes 
everything related to the selected material including files 
and data structure.

• Bulk send to...: Upload the Material IDs of all search results to a file and 
select a target workflow to which to send the file.

• Export as...: Export the selected items to file. You are prompted for the 
output file name and start and end pages of the search 
results to include. You can also select the desired export 
template using the format drop-down menu.

Note: To use the Send to action, a user must be assigned either of the roles: 
CAN_SEND_TO_WORKFLOW or CAN_SENDTO_ALL_ELEMENTS.

Fig. 2-27:  Actions Menu - Create Project Dialog

Fig. 2-28:  Actions Menu - Add to Project Pane

Fig. 2-29:  Actions Menu - Bulk send to Dialog
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Using Thumbnails in the Results Table
The first button at the top of the Result area enables you to manage the thumbnails in the 
results table. To activate thumbnail images, click . To deactivate the thumbnails and 
switch to the list display layout, click .

The following thumbnail icons can be displayed:

Fig. 2-30:  Actions Menu - Export as Dialog

Fig. 2-31:  Search Tool Components - Thumbnails View

Details View

Thumbnails View
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Defining a Search Query
You can use the fields in the Search Query area to define precise queries to retrieve target 
material by matching metadata to a text string or regular expression. 

The Search section enables you to define filter criteria to apply to the query as shown in the 
example below:

Thumbnail Description

Titles and Media assets are identified by a thumbnail image.
A black rectangle means that a black frame was selected as 
thumbnail.

Key segments are identified by a thumbnail with a small icon in the 
right bottom corner.

Titles, Key segment and Media assets which lack thumbnails are 
identified by an icon with a question mark. This means that the 
creation of thumbnails is not included in the workflow or their 
creation failed.

Identifies audio tracks.

 Identifies Edit Decision List (EDL) timelines.

Identifies albums.

Identifies projects.

Identifies documents. Document files are any files attached to a 
selected material.
21



Using the Momentum Interface
Overview of the Search Tool
The first field of the first Search row provides a drop-down menu that enables you to select 
either a blank string to leave the field empty (default) or a NOT logical operator.

Click the expression evaluation drop-down (see Figure 2-32) to display the options menu 
for the matching expression.

The buttons in the Search panel have the following functions:

Search Button Function

Enables you to add more criteria (rows) to the query.

Enables you to delete criteria (rows) from the query.

Toggles the logical operator used to evaluate the query rows 
between: and, or, and not, or not.
When set to and (default), the expression evaluates both or all rows 
inclusively. All of the filter values in the current and previous row(s) 
must match for an object to be included in the search results.
You can also select from the drop-down menu.

Fig. 2-32: Defining Filter Criteria in the Search Panel

Expression Evaluation 
Drop-down Menu

Calendar for Date Selection

Period Constraint Drop-
down Menu

Logical Operator Selection 
(Toggle or Drop-down)

Logical Operator NOT 
Drop-down Menu

Fig. 2-33: Expression Evaluation Advanced Options
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Toggles the logical operator used to evaluate the query rows 
between: and, or, and not, or not 
When set to or, the expression evaluates either row or all rows 
exclusively. Only one of the filter values in the current and previous 
row(s) must match for an object to be included in the search results.
You can also select from the drop-down menu.

Toggles the logical operator used to evaluate the query rows 
between: and, or. and not, or not 
When set to and not, the expression evaluates both or all rows 
inclusively, but uses the negative value of the current row to exclude 
matches. The filter value of the previous row(s) and the negative filter 
value of the current row must all match for an object to be included in 
the search results.
You can also select from the drop-down menu.

Toggles the logical operator used to evaluate the query rows 
between: and, or, and not, or not 
When set to or not, the expression evaluates either row or rows 
exclusively but uses the negative value of the current row to exclude 
matches. Only one of the filter values in the current and previous 
row(s) must match for an object to be included in the search results.
You can also select from the drop-down menu.

Enables you to define a filter string that the matching expression 
should Contain.

Enables you to define a filter string or value that the matching 
expression should be Equal to (or the same as.) You can also select a 
value equal to Is Null to check whether an item of metadata is null or 
empty.

Enables you to define a filter string or value that the matching 
expression Is either Blank (Null) or Not Blank (Not Null). 

 or 
Advanced Search option. Enables you to define a filter string including 
the wildcard operators ? and/or * that the matching expression should 
be Like. The string can be either case-sensitive (L) or case-insensitive 
(LI) respectively.

 or 
Advanced Search option. Enables you to define a filter comprising a 
Regular Expression. The Regular Expression can be either case-
sensitive (R) or case-insensitive (RI) respectively. These search tools 
are particularly useful for long text fields, for example, when searching 
a CLOB (character large object) like a dope sheet.

Save the search query in the Saved Searches section to use later as 
required.

Search Button Function
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Logging Off from Momentum
To log off from Momentum:

1 Go to the top right-hand part of the toolbar where Momentum displays your user 
name.

2 Click your user name to open a drop-down menu: 

3 Select Logout and you will be returned immediately to the Login dialog.
If you attempt to logout while you still have taken processing tasks assigned to your 
user ID from any User Action workflow elements, Momentum displays the following 
screen requesting you to confirm your logout:

At this point, you can choose one of the following actions:
• Release all: Releases all taken tasks before logging you off enabling other 

active users to take the tasks.
• Log off: Logs you off without releasing the taken tasks, however, this will 

prevent any taken tasks assigned to your User ID from being 
taken and progressed by other users.
Another user with the correct permissions can release tasks taken 
and locked by another user, by selecting the Actions > Release 

Reset the search filter settings to undo the criteria settings and start 
again.

Run the Search query.

Search Button Function

Fig. 2-34:  Logout and Change Password Menu

Fig. 2-35:  Logout Confirmation
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menu option, as described in Section 3.6.2 Performing Task 
Actions on page 53.

• Cancel: Cancels the log off / release operations without applying any 
action.
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Creating a Workflow
Overview of the Workflow Page
The Workflow page is the heart of Momentum where you can create or modify workflows to 
reflect your business processes. You can save different workflows as a series of pages and 
organize pages into Groups. In addition, operators can use the Workflow page to monitor 
each scheduled or running workflow process.

To access the Workflow page, click the Workflow button in the toolbar. The Workflow page 
is displayed as shown below:
 27
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Using the Pages Pane
The Workflow page includes the following panes, as shown in Figure 3-36: 
• Pages pane (1): Used to organize pages, each with a different workflow, 

into groups in order to better organize the overall 
workflow.

• Elements pane (2): Lists the workflow elements available to your 
configuration, ready for use in a workflow.

• Current page pane (3): Used to define and modify workflows, and to monitor 
workflow tasks.

Using the Pages Pane
The Pages pane lists all the workflow pages which exist in the database. The pages can be 
organized into groups and you can manage both groups and pages from this pane.

Fig. 3-36:  Workflow Page

1. Pages Pane 3. Current Page Pane

2. Elements Pane
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The groups and pages are listed in alphabetical order. If desired, you can move pages 
between groups by simply dragging and dropping.

Creating a New Workflow Page Group
To create a new group:

1 Click the Create group... button. The following dialog box is displayed:

2 Enter the name of the new group.
3 Click the OK button to confirm. 

The new group is now listed in the tree view of the Pages pane.

Creating a New Workflow Page
To create a new workflow page:

1 Click the Create page... button. The following dialog box is displayed:

Fig. 3-37:  Pages Pane

Group of Workflow Pages

Single Workflow Page

Fig. 3-38:  Create Group Pane

Fig. 3-39:  Create Page Pane
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Editing Pages or Groups
2 Enter the name of the new page.
3 Select a group from the list of existing groups.
4 Click the Roles tab.
5 Click the Add role button to in order to restrict the editing of the workflow page to 

specific roles. 
6 Select one or more roles from the list. 

A role that has not been granted the editing privileges for a particular page, can access 
this specific page in a Read Only mode, and cannot add, remove or copy elements or 
branches in the workflow. 
When the role list in the Edit pane of a page is empty (no roles are listed), it means that 
all roles can edit this page. To remove a role from the list, click on the  icon next to 
its name in the Edit pane.

7 Click Ok to confirm. 
The new page is now listed in the tree view of the Pages pane as a child of the selected 
group.

Editing Pages or Groups
In the tree view of the Pages pane, the  icon enables you to edit the related page or 
group. You can modify the name of the group or page and also move a page to a different 
group.

Deleting Pages or Groups
In the tree view of the Pages pane, the  icon enables you to delete the related page or 
group. In both cases (deleting a page or a group), confirmation is required.

Fig. 3-40:  Create Page Dialog - Adding Roles

Note: When deleting a group, all associated child pages are also deleted.
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Restricting the Ability to Edit a Workflow Page to Specific Roles
While creating or editing a page, you can define restrictions that allow only specific roles 
to access the editing functions of the selected page.

The editing options of a page are not only those related to the Pages pane but also those 
related to the Work Area. A role that is not granted permission to edit a particular page, can 
access this specific page in a Read Only mode, and cannot add, remove or copy elements 
or branches of the workflow.

Open the Roles tab, to list all roles permitted to edit the selected page. To add another role 
to this list:

1 Click the Add roles button in the Edit page or while creating a page.
2 Select one or more roles from the Add roles pane that opens (use [ Ctrl ] [ Click ] to 

make multiple selections).

3 Click Ok to confirm your selection or Cancel to abort the operation.

To remove a role from the list, click the  icon next its name in the Edit pane.

Using the Elements Pane
The Elements pane is the main toolbox for building a new workflow. The tree view of the 
pane contains all of the workflow elements, in categories, currently available in the 
database that are available for use in a workflow.

Note: When the role list in the Edit pane of a page is empty (no roles are listed), 
all roles can edit the page.

Fig. 3-41:  Edit Page Pane

Fig. 3-42:  Add Roles Pane
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Using the Elements Pane
The following workflow categories are available:
• Archive: Contains workflow elements to archive and restore material.
• Automation: Contains workflow elements to manage and manipulate 

material and metadata.
• Feature Extraction: Contains a workflow element to detect and extract 

information from the material in the database.
• Ingest: Contains workflow elements to ingest material into the 

workflow for further processing.
• Logical Operators: Contains workflow elements to perform logical operations 

on material, for example, requiring all inputs to be complete 
before enabling the workflow to continue.

• Quality Control: Contains workflow elements to check the material for 
unwanted frames and defects.

• Script: Contains workflow elements to create rules and customized 
functions for the workflow.

• Transcoding: Contains workflow elements to transcode files into different 
formats.

• User: Contains a workflow element to set a role that allows a user 
or group of users to complete workflow tasks manually.

A text search field enables you to search the tree for a specific matching workflow element. 
The prev and next buttons enable you to skip to the previous or following element in the 
tree matching the search string.

Some of the elements listed in the tree view may also have a delete icon as shown in 
Figure 3-44:

Fig. 3-43:  Elements Pane Showing Top Level Categories
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These are customized workflow elements created by users with specific parameters and 
saved as specialized workflow elements.

When no longer required, click the delete icon  to remove customized elements. See 
Section  Creating a Workflow Element from a Customized Element on page 49 for more 
details.

Using the Current Page Pane
The Current Page pane is where Momentum displays the workflow of the page selected in 
the Pages pane. Here you can create, add or modify new branches or elements and inspect 
and modify parameters for each element. This pane also enables you to create links 
between elements to create your workflows.

3-44:  Elements Pane
33



Creating a Workflow
Using the Workflow/Notes Menus
In the top left corner, the pane reports the name of the currently selected page in orange 
text. Below the header, a menu contains the following workflow options by default:

Using the Workflow/Notes Menus

Toggling Between the Workflow and Notes Menus
The top-right corner of the toolbar has an Edit toggle button that activates two different 
modes of working in the Current Page:

Fig. 3-45:  Current Page Pane

Fig. 3-46:  Current Page - Workflow Menu Options

Fig. 3-47:  Current Page Toolbar

Click to Toggle Between 
Workflow & Notes Mode

Click to Hide All Notes on Page

Move Slider to Change the 
Opacity of All Notes
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Click the Edit Icon  to toggle between the two editing modes: Edit workflow and Edit 
notes, the text of the toggle button changes, as shown in Figure 3-48.

In addition, a further toggle button Show notes/Hide notes, enables you to display or hide 
the content of the Notes layer. While the Notes are visible, the Notes opacity slider is 
available to set the transparency of the entire Notes layer.

By default, the Workflow page opens in Edit workflow mode.

Using the Workflow File Menu
The workflow File menu enables you to import a workflow as a new page or to export a 
page in one of the several formats available as shown in Figure 3-49:

Importing XML as a New Workflow Page
To load a previously saved page in XML format:

1 Click File in the toolbar.
2 Select Import XML as new page... 

The Import dialog opens as shown in Figure 3-50:

3 Enter a name for the new workflow page into the Name field.

Fig. 3-48:  Workflow and Notes Edit Toggle Modes

Fig. 3-49:  Workflow File Menu

Fig. 3-50: Import Page Dialog
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Using the Workflow File Menu
4 Select a parent group to contain the new workflow page from the Parent group drop-
down menu.

5 Browse to, or enter, the name of the XML file to import in the File name field.
6 Click the Ok button to import the file.

Saving a Workflow Page
To save a workflow page in XML format:

1 Click File in the toolbar and select the option Save As.....
2 Enter a name, the parent group and permitted roles for the new file.
3 Click Save.

Exporting a Workflow Page
You can export a workflow page in the following formats:

• As an XML file to allow a later restore of the page or for moving a workflow to another 
system.

• As an SVG (scalable vector graphic) object, for printing or displaying on resolution 
independent devices.

• As a PNG (portable network graphic) file to create customizable images for reports.

To export a workflow page:
1 Click File in the toolbar.
2 Open the Export menu.
3 Select the file format from the list. A new dialog opens for the selected format.

For XML Export:

By default, Momentum provides the name of the current active workflow page as the 
file name and appends the .XML file extension. If necessary, you can change the file 
name as required, without an extension. 
If you want to export multiple workflow pages, check the Select pages checkbox to 
open the Pages tree. Check any pages to include in the export, then click Save. 

Fig. 3-51: XML Export of Workflow
36



Momentum
Operator’s Guide
Momentum exports the XML format file to the Downloads folder of your browser, by 
default.

For SVG Export:

By default, Momentum provides the name of the current active workflow page as the 
file name and appends the .SVG file extension. If necessary, you can change the file 
name as required, without an extension.
If you want to export multiple workflow pages, check the Select pages checkbox to 
open the Pages tree. Check any pages to include in the export.
Check the Include tasks checkbox to include the workflow Tasks in the exported file.
Check the Include notes checkbox to include all Notes in the exported file.
You can also set a blank Margin for the final picture, in pixels, then click Save. 
Momentum exports the SVG format file to the Downloads folder of your browser, by 
default.

Note: Export in XML format creates a file that can be imported back into the 
same system or moved to a different but compatible system, storing all 
the data and parameters of the elements of the selected workflow. The 
Tasks associated with a workflow are not stored in this way.

Fig. 3-52: SVG Export
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For PNG Export:

By default, Momentum provides the name of the current active workflow page as the 
file name and appends the .PNG file extension. If necessary, you can change the file 
name as required, without an extension.
If you want to export multiple workflow pages, check the Select pages checkbox to 
open the Pages tree. Check any pages to include in the export.
In the Scale (%) field, enter a suitable value to size the resulting picture. As you change 
the scale factor, Momentum automatically adjusts the Width and Height settings 
accordingly.
Width (in pixel) defines the final width of the output picture. The Height and Scale 
settings are linked to the width.
Height (in pixel) defines the final height of the output picture. The Width and Scale 
values are linked to the height.
Check the Include tasks checkbox to include the workflow Tasks in the exported file.
Check the Include notes checkbox to include all Notes in the exported file.
You can also set a blank Margin for the final picture, in pixels, then click Save. 
Momentum exports the PNG format file to the Downloads folder of your browser by 
default.

Using the Workflow Edit Menu
The workflow Edit menu enables you to modify a workflow page using standard editing 
tools for copying/cutting and pasting elements, or stepping back from an action using the 
undo function.

Fig. 3-53: PNG Export
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Canceling a Modification to a Workflow Page
You can cancel unwanted modifications (like moving elements, or pasting an element) on a 
workflow page using the Undo option of the Edit menu. 

To undo a change:
1 Select Edit from the toolbar.
2 Click the Undo option of the Edit menu, or use the [ Ctrl ] [ Z ] shortcut.

Reapplying an Undo
If you need to reapply an Undo action, use the Redo option as follows:

1 Select Edit from the toolbar.
2 Click the Redo option of the Edit menu, or use the [ Ctrl ] [ Y ] shortcut.

Cutting Elements
If an element needs to move to a new location, use the Cut option as follows:

1 Select the elements to cut.
2 Select Edit from the toolbar.
3 Select the Cut option from the Edit menu, or use the [ Ctrl ] [ X ] shortcut.

Now the element can be pasted where it is needed.

Pasting Elements
After a cut or a copy action, elements can be repositioned by pasting them in a new 
location as follows:

1 Select Edit from the toolbar.
2 Select the Paste option from the Edit menu, or use the [ Ctrl ] [ V ] shortcut.

Fig. 3-54:  Workflow Edit Menu
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Deleting Elements
Elements on the Work Area can be removed using the Delete option on the Edit menu as 
follows:

1 Select the elements to delete. 
2 Select Edit from the toolbar.
3 Select the Delete option. A confirmation dialog appears. Click Yes to confirm or No to 

abort.

Selecting all Elements
All the objects in a work flow can be selected at once as follows.

1 Select Edit from the toolbar.
2 Select the Select all option from the Edit menu, or use the [ Ctrl ]  [ A ] shortcut.

Using the Workflow View Menu
The View menu enables you to focus on specific areas or objects in the workflow.

Focusing on Selected Elements
To zoom and center on just the selected elements:

1 Select View from the toolbar.
2 Click the Center selected elements option or use the S shortcut. The content of the 

Work Area changes to display the selected elements at the highest zoom factor 
available which can contain them all.

Focusing on the Current Selection
To zoom and center the selected elements, their links and link targets:

1 Select View from the toolbar.
2 Click the Center selection option or use the [ Shift ] [ S ] shortcut. The content of the 

Work Area changes to display the selected elements, links and link targets at the 
highest zoom factor available which can contain them all.

Fig. 3-55:  Workflow View Menu
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Framing all the Work Area Contents
To highlight the entire structure of the workflow for examination:

1 Select View from the toolbar.
2 Click the Extent option or use the [ E ] shortcut. All the elements in the Work Area 

(connected to the main workflow or not) are displayed on one screen. 

Searching for an Element
To search for an element:

1 Click Search to open the following dialog:

2 Enter an element name into the search field and click Search.
Momentum looks for any matching elements. If the Current page option is selected, the 
search only applies to the open workflow. If this option is not selected, the search 
returns results for all workflows in the system.

3 Click the element name in the list in order to highlight the target element on the 
workflow. If the element is not on the current workflow, Momentum opens the relevant 
workflow and highlights the element.

Editing Workflow Notes
Click the Edit Icon  to switch to the Edit Notes mode. This changes the menu at the 
top-left of the pane and displays the message: You are editing notes.

Fig. 3-56:  Toolbar Workflow Search Dialog
41



Creating a Workflow
Editing Workflow Notes
The Edit Notes mode activates a new layer in the Work Area. This layer does not interact 
directly with the elements and the workflow structure and you use it to write remarks and 
create notes commenting on the workflow, highlighting specific branches or making 
colored memos.

Using the Notes Create Menu
The notes Create menu enables you to annotate or mark-up a workflow to provide 
additional information or highlight specific areas of the workflow.

The Create drop-down menu enables you to create any of the following objects on the 
canvas:

• Rectangle: Use to construct colored frames.
• Text: Use to insert a text comment in a specific area of the canvas.
• Arrow: Use to create a straight arrow to place a pointer between text and 

workflow elements. 
• Memo: Use to create a text memo on a colored, rectangular, background.

Click the relevant option and create the element on the canvas. 

You can modify each object as follows:
• Click and drag an element to move it.
• Hover the cursor over a rectangle or memo object to display a small square in the 

bottom-right corner. Click and drag this square to resize the rectangle or memo.

Fig. 3-57:  Notes Create Menu

Fig. 3-58: Notes Create Menu

Fig. 3-59: Workflow Note Objects
42



Momentum
Operator’s Guide
• Hover the cursor over an arrow to display two circular handles. Click and drag either 
handle to change the position of the head or tail of the arrow, and to adjust its length.

• Double-click a Text or Memo object to open the Modify text or Modify memo dialog 
enabling you to edit the text content.

• Right-click a note object to open a context menu that enables you to select various 
options that you can perform on that object, including Delete, Cut, Copy, Change Color, 
Center on screen, or set the Extent.

Using the Notes Edit and View Menus
The Edit drop-down menu allows you to select the Undo and Redo options. In addition, 
you can cut, copy, paste or delete a Note object or select all note objects. 

The View drop-down menu allows you to:
• Center selected note objects on the screen.
• Select either the Extent (Notes) or Extent options, to frame all the contents of the 

Notes layer on screen.

Overview of the Workflow Elements
Momentum represents workflows as a group of interconnected elements which together 
form node diagrams. 

You can create a node diagram using a collection of workflow elements selected from the 
menu tree in the Elements pane, where they are organized in groups according to their 
function.

To build a workflow, select the elements required, drag them across and drop them into the 
working area of the Current Page pane. 

See the Configuration Guide for more detailed information on the individual elements and 
their parameters.

Fig. 3-60: Notes Edit Menu

Fig. 3-61: Notes View Menu
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Overview of the Workflow Elements
The elements are structured as shown in Figure 3-62:

• Header: Identifies the type of element.
• Input port: Tasks arrive at the element through this port. This is 

also the target for a link starting at another element.
• Logo area: This area displays the logo of the owner (Grass Valley 

or third party device) of the element.
• Element name label: Each element can be assigned a label when it is 

configured.
• Output port ok and label: Successful tasks leave the element through this port 

and can pass to elements further downstream in the 
workflow. 

• Failed output port and label:  If an error occurs, tasks leave the element through 
this port and can pass to elements further 
downstream in the workflow for fault finding, repair 
and possible re-introduction to the workflow.

You can customize certain elements by adding extra output ports, as required. This enables 
an element to connect to different branches in a workflow depending on specific 
conditions.

To add a new output port to an element, click the Add port button on the element. The 
area below the ok port and label moves down when a new port is added, which provides 
the ability to add an unlimited number of new ports, as required.

Fig. 3-62:  Workflow Element Components

Header

Element LabelInput Port

Output Port Labels

Output Ports

GV or Third Party Logo

Fig. 3-63:  Add Port Button on Workflow Element

Add Port(s) Button
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Once placed on the canvas of the work area, you can move the element, link it to other 
elements or configure its parameters by double-clicking on the element itself.

Using the Work Area Canvas
The work area canvas is an unlimited area; its size is defined by the actual size of the 
workflow you define on the Current page. 

To pan the content of the canvas, click and drag an empty area while the cursor looks like 
this:

To zoom the content of the canvas, with the cursor over the work area, roll the Mouse 
wheel to enlarge or reduce the size of the canvas contents.

To move an element to a new position on the canvas, move the cursor over the desired 
element then click and drag to its new position. The cursor changes to the following icon:

Adding a Workflow Element to the Canvas
To add a workflow element:

1 Find the element you need in the Elements pane.
Expand the element tree as necessary.

2 Click and drag the workflow element onto the work area canvas.

Changing the Workflow Element Settings
To change the configuration settings of a workflow element:

1 Double-click an element in the work area. 
The element settings dialog opens, see Figure 3-64 for an example.

Note: When adding a new port, the port label is limited to 64 characters in 
length. For long port labels, the first 12 characters are displayed followed 
by an ellipsis (...) to show that the label is extended. You can view the 
entire port label by hovering your cursor over the label to display the full 
text in a tooltip.
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2 Edit the settings as required and click the Save button.
For details of the possible settings for each workflow element, see the Configuration 
Guide. 

Removing a Workflow Element
To remove an element:

1 Click the workflow element to select it.
2 Press the [ Delete ] key.

Focusing on a Single Workflow Element
The workflow elements can appear small on the work area, especially if the workflow is 
large, complex and composed of many branches and elements.

To help visualize a workflow element’s name, ports and tasks, hover your cursor over an 
element smaller than 100% in size (due to the overall scaling of the canvas) then 
Momentum displays a tooltip, which lists the name, type, status and port labels of the 
element, see Figure 3-65.

Fig. 3-64: Settings Dialog for FFmpeg Proxy Workflow Element

Fig. 3-65:  Focusing on a Single Element

Tooltip Listing 
Element Details

Hover Cursor Over Zoomed 
Out View of Element
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You can use this method to make links and inspect tasks without scaling all the workflow 
content.

0.0.1 Selecting Workflow Elements

A selected element is outlined by a blue border and the links connecting its ports are also 
selected and are of the same color as shown below: 

Several modes are available to help you select the required element(s):
• Direct selection - move your cursor onto the required element and click it. Only the 

element and its related links are selected.
• Rectangular selection - if you need to select a group of elements, press [ Shift ] and 

click and drag. A semitransparent rectangle appears. When you release the mouse 
button, all the elements enclosed by the rectangle and their links are selected. While 
performing this action, the cursor changes to the following shape: 

• Connected selection - press [ Alt ] and click an element to select all the elements that 
can be reached from (and those that can reach) the selected element and related links.

Adding a Workflow Element to a Selection
To add an unselected workflow element to an existing selection:

1 Press [ Ctrl ].
2 Click an unselected element.

Removing an Element from a Selection
To remove an element from an existing selection:

1 Press [ Ctrl ].
2 Click an already selected element.

Fig. 3-66:  Selected Workflow Element

Selected Element 
and Links

Fig. 3-67:  Rectangular Selection Cursor
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Moving Workflow Elements
You can move a selection anywhere on the canvas of the work area. While the cursor hovers 
over a selected element, it has the following shape:

Click and drag the selection to move it to another location. Moving to an edge of the work 
area makes the canvas scroll in the opposite direction, making room for the new location of 
the elements.

Linking Working Elements Together 
Once placed on the canvas, the workflow elements need to be linked together in order to 
build a processing path through the workflow.

Creating a Link
To create a link between workflow elements:

1 Hover over the Output port of the first workflow element in the path. While the mouse 
is hovering over the port, the port and its label are activated and the cursor changes its 
shape to show a link, see Figure 3-69.

2 Click and drag the port. A curved line is drawn while moving the cursor.
3 Drag the cursor to the input port of the target workflow element.
4 Release the mouse button. Momentum automatically creates the link. Now tasks can 

flow from the first element to the second.

Removing a Link
To remove a link:

1 Select the link.
2 Press [ Delete ].
3 Confirm the link removal.

Fig. 3-68:  Move Workflow Element Cursor

Fig. 3-69: Workflow Element Link Cursor
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Creating a Workflow Element from a Customized Element
After changing the configuration of a workflow element, it can be useful to save it as a 
customized element in the Elements pane. If the same configuration is needed again, you 
can simply drag the custom element onto the canvas from the Elements pane.

To create a customized element:
1 Right-click the configured element.
2 Select Create workflow element.

Edit the name of the workflow element and click OK to store it in the same category as the 
parent element.

Context Menu Options
Right-click on a workflow element to display a context menu as shown in Figure 3-70.:

The dialog contains the number of elements selected and the following options:
• Cut: Removes the selected workflow element(s) from the 

workflow.
• Copy: Copies the selected element in order to create a 

duplicate element on the workflow.
• Delete: Deletes the selected workflow element(s).
• Center selected elements: Centers the workflow around the selected element(s).
• Center selection: Centers the workflow around the selected elements 

as well as their links and any connected elements, in 
order to focus more on the structure of a section of 
the workflow rather than just the selected elements.

• Extent: Reduces the size of the elements so that the entire 
workflow appears on the screen.

Fig. 3-70:  Element Context Options
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• Search: Enables you to search all of the workflows for a 
specific element.

• Create workflow element: Opens the Create workflow element dialog enabling 
you to save a new customized workflow element to 
the Elements tree.

• Link between: Enables you to link a workflow element between two 
already linked elements. For example, consider the 
example in Figure 3-72:

In this scenario workflow element A is already connected to element B and you would 
like to change this so that A connects first to element C and then to element B. To do 
so, select the link between elements A and B, then press [ Ctrl ] and right-click element 
C. This activates the Link between option in the context menu. Select Link between to 
establish the desired link between element A to element C then to element B. You are 
prompted to select the desired exit port from the new element C.

Using Variables in Momentum
The Destination Folder setting (also labeled Dst, DstFolder, Dest Folder, etc.) available for 
some elements can include variables which enable you to customize the folder structure. 
Variables are also available to describe an item of material (for example, in a search string) 
when creating email settings for elements, and in the Momentum Server or Node 

Fig. 3-71: Creating a Customized Workflow Element

Fig. 3-72: Using the Link Between Option
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configuration files to specify target paths (for example, when defining the output path for a 
QC report).

The following variables are available for use in Momentum:

The following are some examples of using variables in destination folder names:
• \\server\disk1\{MATERIALID}\

Variable Description

{Brick.Name} The name of the current element.

{DD} The current day expressed as two digits, for example, 26.

{DESCRIPTION} The description of the material.

{DEVICE_ID} The Morpheus DEVICE_ID of the active instance of the current task.

{FULLMEDIAPATH} The full path of an instance, selected using an instance switcher element, 
associated with the specific task.

{GUID} GUID is generated as a random value at runtime.The {GUID} variable does 
not identify a specific resource, but the stored value can be used as a 
Unique ID.

{INSTANCEID} The ID of the active instance of the current task.

{INSTANCELABEL} The label of an instance related to a specific task.

{JOBCREATOR_MAIL} Sets the email receiver dynamically in the element.

{JOBID} The ID of the job of the current task.

{LASTUSER_MAIL} The email address of the last user.

{MATERIALID} The material ID.

{MEDIAPATHDIR} The name of the folder where the instance is located, for example, for the 
file \\server\disk1\myFile.avi the folder is \\server\disk1.

{MEDIAPATHFILENAME} The full path and name of the file, for example, for the file 
\\server\disk1\myFile.avi the path and file is \\server\disk1\myFile.avi.

{MM} The current month expressed as two digits, for example, May is 05.

{MORPHEUSID} The Morpheus ID of an item of material.

{QCREPORT_PATH} The path of the QC report of the current material.

{Task.Previous.Remark} Reports the remark related to the propagation of the current material from 
the previous element of the workflow to the current one.

{TASKID} The ID of the current task.

{TASKLIST} The task history of the current material.

{TITLE} The title of the material.

{WEB_HOST} The Momentum Web Application path. This value is the one set in the 
MantricsServer.xml file.

{YY} The current year expressed as two digits, for example, 17.

{YYYY} The current year expressed as four digits, for example, 2017.
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Creates a new folder in \\server\disk1\ for each task using its {MATERIALID} in 
order to name the folder.

• C:\media\{YYYY}\ 
Creates a new folder in C:\media\ using the value of the current year {YYYY} in order 
to name the folder.

• C:\media\{DD}{MM}{YY}\ 

Creates a new folder in C:\media\ using the value of the current date in {DD}{MM}{YY} 
in order to name the folder.

Creating Custom Variables
If required, you can define your own, custom variables and add them to the available list as 
follows:

1 Open the More > Admin page.
2 Open the Custom lists tab from the left-hand side menu options.
3 Click Create custom list... and enter a label for the custom list.

The new custom list container is added to the list.

4 With the custom list selected, click Create value... in the Details pane to open the 
Create value dialog.

5 Enter a label for the custom variable, for example: FTPPATH.
6 Enter the value of the variable, for example: \\10.10.101.103\TESTFTP

.

7 If necessary, click Add role... to select the specific roles that can use the variable. If you 
do not select a role, all roles can use the variable.

8 Click Ok to save the variable to the Details pane.

Fig. 3-73: Creating a Custom List

Fig. 3-74: Creating a Custom Variable
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9 Add further variables as required by repeating steps 4 to 8 above.
10 Click Save to commit your changes to the Momentum database.

In the above screens, Momentum creates a new variable using the syntax:
{List/CustomListLabel.CustomListValueLabel}

When you use the variable, Momentum renders it using the syntax:
CustomListValueValue
For example, when:

• CustomListLabel = RDFC1
• CustomListValueLabel = FTPPATH
• CustomListValueValue = \\10.10.101.103\TESTFTP

Momentum creates the variable: {List/RDFC1.FTPPATH}
Which, when used in a string, Momentum renders as: \\10.10.101.103\TESTFTP

Working with Task Actions and Task Statuses
When a workflow is running, objects (usually material files ingested into the system,) start 
the workflow process. The end-to-end process is referred to as a Job and a job can comprise 
multiple Tasks. Tasks are propagated through the Workflow page in real-time.

Each element of the workflow performs one or more tasks, where tasks are effectively the 
actions that target the material currently available to the workflow element.

Reviewing the Task Status Indicators
Using the Workflow page, you can monitor the status of each task processed by any of the 
workflow elements. To highlight the current status of a processing task, Momentum 
displays one or more colored status indicators above each workflow element, see Figure 3-
76. 

Several other tools are also available to assist in monitoring and managing processing 
tasks. For further information, see Chapter 10 Task Monitoring and Statistics, on page 169. 

Fig. 3-75: Adding a Custom Variable to the List
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These processing status indicators can be displayed in different colors as follows:
• A purple square represents a waiting status to indicate that the task is waiting in a 

queue or waiting for a user action. This status indicator also contains the letter W as 
shown below:

• A red square represents a stopped status to indicate that the task has been stopped by 
user and is waiting for the user to resume the task (see the sections Using the 
Dashboard for Task Monitoring, on page 176 , or Using the Services Page, on page 182 for 
more information.) This status indicator also contains the letter S as shown in Figure 3-
78:

Fig. 3-76:  Generic Element Showing the Possible Task Processing Status Indicators

Processing Indicator
Reconnecting Indicator

Waiting Indicator
Stopped Indicator

Fig. 3-77:  Task Processing Status: Waiting 
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• A yellow square represents a reconnecting status to indicate that the task has lost its 
connection to an associated node and is attempting to reconnect. This status indicator 
also contains the letter: R.

• A green square represents a processing status to indicate that the task is currently 
being processed. This status square also contains the letter P as shown in Figure 3-79:

Fig. 3-78:  Stopped Status
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The number next to a status indicator represents the number of tasks currently in that 
state for the workflow element.

Performing Task Actions
You can use either of the following methods to view further information about a task 
progressing through the workflow and perform an action on that task:

• Using the status indicators.
• Using the Tasks pane of the workflow element.

Performing Task Actions Using the Status Indicators
Click a status indicator to display a pop-up window containing a summary of the tasks 
currently in that status, see Figure 3-80.

Fig. 3-79:  Processing Status
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In the header line, the User Action tasks window provides Select and Actions menus and a 
Material ID search field. The Actions menu only becomes active once a task (or multiple 
tasks) is selected.

In addition, the task summary provides certain information to help you to identify the task, 
for example, the thumbnail, Material ID, Title, Media asset type, Priority, In Date and time, 
and a description of the task status. In the event that a task in Processing status has been 
taken by another user, you will see a Remark: Task taken by <user ID>

Click a checkbox to select a single task then use the options in the Actions drop-down 
menu to submit the task to any of the following possible actions:

• Resume: Enables you to Resume a stopped task making it available again for 
processing through the workflow.

• Release: Enables you to release a task, in processing or waiting status on a 
User Action workflow element, that has been previously taken by 
another user but for some reason has not been progressed 
through the workflow.

Fig. 3-80: Listing All Tasks in Waiting Status for a User Action Workflow Element

Click Waiting 
Indicator
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• Stop: Enables you to stop a task, preventing it from going further 
through the workflow.

• Change priority: Enables you to increase or decrease the priority level of:
- A processing task, or
- A job and all its currently active, associated tasks.

The priority options are Low, Medium, High, Urgent and Immediate. Momentum 
automatically uses the priority setting for example, when processing a transcoding 
queue, material set to High takes priority over material set to Low.

The Actions > Change Priority menu is shown in Figure 3-82.

• Skip to: For modified material, this option skips the process that it is 
waiting for and moves it to the next workflow element in the 

Note: In Momentum, a Job consists of multiple Tasks.

Fig. 3-81: User Action Tasks List - Actions Release Task

Fig. 3-82: User Action Tasks List - Actions Change Priority Menu
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process. For multi-port workflow elements, you can choose which 
port the material skips through.

Performing Task Actions from a Workflow Element
All workflow elements have a series of underlying function windows that give you access 
to:

• Work element configuration Settings.
• Tasks that have already been processed by the element and tasks in different statuses 

at the element.
• Statistics showing the times tasks were processed and the duration of each task.

To display these additional functions, double-click the workflow element on the workflow 
canvas. By default, the workflow element opens to display the Settings pane as shown in 
Figure 3-83.
.

For more information on configuring the workflow element settings, see Section  Creating 
an Elementary Workflow on page 65.

To access the Tasks pane of the workflow element, click the option Tasks in the left-hand 
side menu. The Tasks pane opens as shown in Figure 3-84.

Fig. 3-83: User Action Workflow Element - Settings Pane
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The Tasks pane has the following tabs:
• History: Summarizes all tasks that have been successfully 

processed by the workflow element.
• Waiting / Stopped: Summarizes all tasks for which the current status is 

either Waiting or Stopped.
• Processing / Reconnecting: Summarizes all tasks for which the current status is 

either Processing or Reconnecting.

To display the current tasks held at, or being processed by the workflow element, click 
either of the tabs: Waiting / Stopped or Processing / Reconnecting.

Fig. 3-84: User Action Workflow Element - Tasks Pane (History Tab)
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The toolbar at the top of the tasks grid includes the following elements:
• Select: Provides methods to select or deselect all listed tasks, either 

directly by item, or using the selection checkboxes.

• Actions: Only activated when you select one or more tasks. When active, 
enables you to select an action to perform on the selected task or 
tasks.

Fig. 3-85: User Action Workflow Element - Tasks Pane (Processing /Reconnecting Tab)

Fig. 3-86: Task Selection Menu
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Some actions can be performed only on tasks in a specific status. If you attempt an 
action on a task for which the action is not allowed, Momentum displays a popup with 
a warning message, see Figure 3-88.

The Actions menu has the following options:
• Resume: Enables you to Resume a stopped task making it available 

again for processing through the workflow.
• Release: Enables you to release a task, in processing status on a User 

Action workflow element, that has been previously taken 
by another user but for some reason has not been 
progressed through the workflow.

• Stop: Enables you to change the stop a task, preventing it from 
going further through the workflow.

• Change priority: Enables you to increase or decrease the priority level of a 
processing task, or a job and all its currently active, 
associated tasks. The priority options are Low, Medium, 
High, Urgent and Immediate. Momentum automatically 
uses the priority setting for example, when processing in a 
transcoding queue, material set to High takes priority over 
material set to Low.

Fig. 3-87: Actions Menu for User Action Tasks

Fig. 3-88: Task Actions Menu Warning Message
62



Momentum
Operator’s Guide
• Skip to: For modified material, this option skips the process that it 
is waiting for and moves it to the next workflow element in 
the process. For multi-port workflow elements, you can 
choose which port the material skips through.
By hovering your cursor over the options, you can see the 
related, selectable values (e.g., for the Skip options a list of 
available ports is displayed.) 

• Material Id: Enables you to define a search string for a specific 
MaterialID or a generic MaterialID using variables. If the 
applied filter does not return any results, Momentum 
displays the message: No match found using the <string> 
filter. The User Action task panel remains open.

To change the status of a task, change its priority or skip the task to another element:
1 Select a specific task or group of tasks.
2 Open the Actions menu. The available options depend on the status of the 

corresponding task or tasks as follows:
• A processing task has a Stop option to stop the task.
• A processing task has a Release option if it has been taken by another user and is 

not being actioned.
• A stopped task has a Resume option for use with the Change priority and Skip to 

options.
• A waiting task has a Stop option for use with the Change priority and Skip to 

options.
3 To change the status of a task, select the Stop or Resume option.
4 To change the priority of a task, select a new value from the Change priority drop-

down list.
5 To make the task pass through a specific port of the element in order to move directly 

to another element, or to exit the workflow, select the appropriate port from the Skip 
to drop-down list.

The life-cycle of a task and its states is summarized in the following schematic:

Next ElementProcessing

Stopped

Waiting

Reconnecting

Skip

Skip

Skip

Temp Failure Recovery

Queued

Stop

Stop

Completed

Fig. 3-89: Momentum Task Life-cycle
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The path marked by the green arrows represents a typical workflow:
• The task waits (either queued or waiting for a user action).
• After waiting, the task is processed by the workflow element.
• Once processing is complete, the task moves to the next element in the workflow.

You can interrupt a task in either Waiting or Processing status (see the paths marked by 
the red arrows). If you do so, the task status changes to Stopped. The Stopped status is 
similar to the Waiting status but only the user who stopped a task can resume it from a 
Stopped status.

The blue arrows show changes of state managed automatically by Momentum. While 
processing there can be a temporary failure in the process where the task moves to 
Reconnecting status and Momentum attempts to recover the process. If successful, the 
task moves back to Processing status, otherwise it returns to Waiting status.

You can choose to skip the statuses Stopped, Waiting or Reconnecting, which progresses 
the task to the next workflow element, skipping the previous processing step.

You can choose to Stop a Processing or Waiting task or alternatively Resume a Stopped 
task using the tools available from the element, on the Dashboard page (see Using the 
Dashboard for Task Monitoring, on page 176) or in the Services page (see Using the Services 
Page, on page 182).

Working with Momentum Jobs
As previously described, a Workflow is composed of workflow elements and the elements 
perform tasks on the materials available to the workflow. The set of tasks performed by a 
group of connected elements on the available material is defined as a job. The Momentum 
Dashboard page displays a list of all jobs in their different statuses.

The concept of a job is widely used when monitoring and managing the tasks running in a 
workflow using specific tools and pages. Jobs also have a status to describe what is 
happening to a specific job at any moment. See Chapter 10 Task Monitoring and Statistics, 
on page 169 for further information.

A Momentum Job can have any of the following statuses:
• Aborted: Applies when at least one task has been deleted from the job using the 

 button on the Dashboard.
• Failed: One ore more tasks of the job has been marked as FAILED.
• Completed: This job has no active tasks in the workflow (an active task is a task in a 

Waiting, Running or Stopped status).
• Processing: At least one task from the job is in Processing status.
• Waiting: At least one task from the project is in Waiting status.
• Stopped: One or more tasks from the project is in Stopped status.

Note: The above status values are listed in a priority order (highest first) so, for 
example, the Aborted value is a higher priority than a Completed status 
and, therefore, the status Aborted is reported as the overall status for the 
job.
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Creating an Elementary Workflow
This section describes how to build an example of a workflow using a few basic Momentum 
workflow elements.

For example, some incoming Material needs to be processed before play-out. In 
Momentum, material is referred to as a TITLE. For further information about metadata 
definitions, see Chapter 5 Working with Metadata, on page 93.

The example in this section performs the following tasks:
• Ingest files by placing them in a folder specified in the Watchfolder element.
• Create a proxy for playback on a Momentum media player (for example, on the Catalog 

page).
• Screen the content of a specific item of material using the To Do page for the user 

associated with the User Action element.
• Send an email message automatically, containing a report on which materials have 

been approved.
• Populate the system database with the ingested materials. The material metadata can 

then be inspected and modified using the Catalog page.

To build a basic workflow for these tasks, you need to:
1 Create a blank new page.
2 Insert the entry point.
3 Convert incoming material.
4 Send an email.
5 Submit a file to the workflow.

Creating a New Blank Page
Open the Workflow > Pages pane and create a new page as follows:

1 Click Create Page at the top of the pane.
2 Enter a name for the page.
3 Select a Parent group (and role if required) and click Ok to confirm as shown in 

Figure 3-90:

4 Select the new page to start working on it.
Fig. 3-90:  Adding a New Workflow Page
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You can now proceed to add the following workflow elements to the newly created 
page:

• Watchfolder: Located in the Ingest category of the Elements pane.
• FFmpeg Proxy: Located in the Transcoding category of the Elements pane.
• UserAction: Located in the User category of the Elements pane.
• Send Mail: Located in the Automation category of the Elements pane.

Creating an Entry Point for Media Files
Add a Watchfolder element as the start-point of the workflow. This is the entry point to 
start ingesting files into the Momentum system.

To add a Watchfolder element:
1 In the Elements pane, open the Ingest folder by clicking the cross icon: .
2 Drag the Watchfolder element across to the Workflow pane and drop on the canvas. 

3 Double-click the element to modify the Watchfolder settings as shown in Figure 3-92:

Fig. 3-91:  Watchfolder Workflow Element

Fig. 3-92:  Watchfolder Element Settings
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Modify the settings as described in the Configuration Guide.
4 Click Save to store the Watchfolder settings.

Icon Creation for a Newly Ingested Title
The ingest of a media clip by a Watchfolder element automatically generates an icon or 
thumbnail to represent that clip as it progresses through the workflow. The icon is created 
by Momentum’s Thumbnail Generator utility.

Previously the icon was taken from the first frame of an ingested clip. To generate a 
representative icon, however, the Thumbnail Generator now takes a frame from a position 
two minutes into a clip to avoid any black frames and/or test signals that might exist at the 
beginning of the clip. If the total length of a clip is shorter than eight minutes, the 
Thumbnail Generator selects a frame from a time-point that corresponds to the end of the 
first quarter of the clip’s length.

Converting Ingested Material
Next, add an FFmpeg Proxy element to transcode the ingested material in order to create a 
low resolution proxy of the source file. If there is no supported third party software 
available for this function, use the generic FFmpeg Proxy workflow element for this task.

To add the FFmpeg Proxy element:
1 In the Elements pane, open the Transcoding folder.

Open the FFmpeg folder, drag the FFmpeg Proxy element across to the Workflow 
pane and drop on the canvas.

2 Double-click the element to modify the default element settings if required as shown 
below:

Fig. 3-93:  Ffmpeg Proxy Workflow Element
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3 Modify the element settings as described in the Configuration Guide.
4 Click Save to store the Ffmpeg settings.
5 Link the two elements together by clicking the ok port of the Watchfolder element 

and dragging the link to the transcoder input port, see Figure 3-95.

Assigning a User Action Task
Now add a UserAction workflow element to the workflow. The UserAction element assigns 
tasks automatically to the operator, and also provides instructions for performing the 
action. In this example, the task consists of inserting metadata into new material.

To add a UserAction workflow element:
1 In the Elements pane, open the User folder.
2 Drag the UserAction element across to the Workflow pane and drop on the canvas.

Fig. 3-94:  Ffmpeg Proxy Workflow Element Settings

Fig. 3-95:  Linking Watchfolder to FFmpeg Proxy Workflow Element
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3 Drag the UserAction element to Workflow pane and drop on the canvas.
4 Double-click the UserAction element to modify its settings, see Figure 3-97.

5 Modify the settings as described in the Configuration Guide.
Modify the following settings as required:

• Edit the Name field to change the element label (for example, if the action is to add 
metadata, call the element Metadata).

• In the Role field, select the user role permitted to complete the assigned action. 
The action becomes available on the To Do page of the users belonging to the 
selected role.

• Edit the To Do field to describe the action to perform (for example, add metadata 
to the incoming material). This is not an automatic action. To modify the value of an 
item of metadata, the user can edit it in the details pane of the To Do page and 
then choose the required action from the Actions pane to move the task along the 
Workflow.

• In the Task Layout field, select the Default Layout option.
6 Click Save to store the UserAction settings.
7 Link the OK port of the Transcoder workflow element to the input port of the 

UserAction element.

Fig. 3-96:  User Action Workflow Element

Fig. 3-97:  UserAction Element Settings
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Sending an Email
The final component in this example workflow is a Send Mail element. This element 
informs a Supervisor that the task processing is complete and that the processed material is 
ready for the next step.

To add a Send Mail workflow element:
1 In the Elements pane, open the Automation folder.
2 Drag the Send Mail element across to the Workflow pane and drop on the canvas.

3 Double-click the element to modify the element settings, see Figure 3-99. 

4 Modify the settings as described in the Configuration Guide.
5 Click Save to store the settings.
6 Link the ok port of the UserAction element to the input port of the Send Mail 

element.

Note: The User Action element enables a user to add one or more ports to the 
element in order to allow different solutions, for example, a Waiting port 
can indicate that the user is waiting for something to complete the 
process.

Fig. 3-98:  Send Mail Workflow Element

Fig. 3-99:  Example Send Mail Element Settings
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Your workflow should now appear as follows:

Creating the Elements of a Workflow Using the Wizard
It is possible to use the Create New Element Wizard to view elements and set their 
parameters without moving them into the work area.

To start the wizard:
1 Right-click anywhere in the Workflow pane.
2 Select Create new brick... from the context menu. 
3 Select a workflow element from the Elements tree, for example, click UserAction.

The following dialog appears:

The pane is divided into two areas as follows:
• The Elements pane - This is the same as the Elements pane in the Workflow page. 

Here you can browse the available elements to select the one you need.

Fig. 3-100:  Example of an Elementary Workflow

Fig. 3-101:  Example User Action Element Settings

Elements Pane Parameters Pane
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• The Parameters pane - This pane becomes active when you select an element in the 
Elements pane. Here all the element settings are available for modification.

If the element has configurable ports, an Edit Element Ports button is available at the 
bottom of the Parameters pane. Click to open a new dialog enabling you to configure the 
output ports.

After setting the parameters, click Save to close the wizard. The element appears in the 
workflow pane already initialized with the new values.
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The ingest process provides new material for processing by the Momentum system. When a 
new item is ingested, multiple actions take place. When ingesting content, Momentum:

• Stores a copy of the original file
• Creates an instance of the new element in the database
• Applies a metadata schema to the new material
• Starts a workflow.

Contents are ingested into Momentum using a variety of workflow elements and 
associated methods as follows:

• Watchfolder: Use a Watchfolder or Watchfolder FTP element in the workflow.
• BXF Receiver: Ingest new Titles from a Morpheus Playout Automation system or 

another Momentum system by way of a BXF XML message.
• Morpheus: Interface with a Morpheus Playout Automation system.
• XCache Receiver: Ingest a new Title by way of an XCache message.

• Pam-EVS: Ingest files from a Production Asset Management / Morpheus 
Playout Automation system to start workflows to replace or 
update missing material or metadata in the Morpheus database.

• Etere Receiver: Ingest new Titles from a third party Etere Receiver.
• sQ Sync: Listen for event types Clip Created, Clip Modified, or Clip Created 

originating from an sQ Zone and initiate a workflow to 
synchronize Momentum with an sQ Server environment.

These workflow elements are grouped together in the Ingest folder of the Elements pane 
in the Workflow page.

Momentum can ingest the following main classes of object as files:

Note: The XCache Receiver workflow element is planned to be deprecated 
from Momentum version 5.1. It is recommended to use the BXF Receiver 
in preference to the XCache Receiver.

Note: To start an ingest operation, at least one workflow with an entry point 
must exist in the current system (see Section 3.6 Working with Task 
Actions and Task Statuses for details).
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Momentum automatically manages audio tracks and subtitles as children of a specified 
video Title. They are not considered as autonomous elements and only a limited range of 
actions is available for these types of material (no archiving of soundtracks is permitted, 
only the ingest of audio tracks linked to specific video Titles.)

Object Class Description

Video The following video types are eligible for ingest: 

• MOV

• MOV Ref (Mediadir folder needed to ingest media contents) 

• MXF

• MXF-D10 (each audio channel becomes an audio track)

• LXF

• GXF

• AVI

• MP4

• MPEG-2 (IMX, XDCAM, XDCAMHD, AVC-INTRA)

• Apple ProRes.

Sequence of 
Images

The following sequences are eligible for ingest: 

• JPG

• TIFF

• PNG

• TGA

• YUV

• DPX

Audio Momentum ingests Audio tracks for video assets separately, and then uses the 
AudioMorph workflow element to render them with the required video Title. The 
following audio types are eligible for ingest: 

• WAV

• AIFF

• AC3 

The file name must be the same as the related video file and include a suffix _ABC (where 
ABC is a three character label to specify the language), together with a supported audio 
file extension.

Subtitles / 
Captions

Momentum ingests captions files separately and automatically associates them with the 
related video Title. The following subtitle types are eligible for ingest: 

• STL 

• SCC 

• SRT

• WebVTT 

The file name must be the same as the related video file and include the suffix _ABC 
(where ABC is a three character label to specify the language), together with a supported 
subtitle file extension.
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Ingest from a Watchfolder
The Watchfolder element is an entry point for a workflow. This element enables you to 
define a folder that Momentum checks periodically for incoming material. When a new file 
is added to the folder, the ingest process starts automatically. When ingesting material, the 
most appropriate of several libraries (e.g., MediaInfo, Omneon, etc.) is automatically used to 
extract structural metadata information.

When ingesting assets that include embedded audio channels, you can define a stereo 
audio layout, linked to the Watchfolder element used for the ingest, and constrain the Titles 
created to use only this layout, see the Momentum Configuration Guide for more details.

For more details about the settings of a Watchfolder element, see Section 3.8.2 Creating an 
Entry Point for Media Files on page 63.

The Watchfolder element has configurable output ports to manage the result of the ingest 
action and these can be defined in the Watchfolder template.

For more information, see:
• See Section 3.8.2 Creating an Entry Point for Media Files on page 63 for a description of 

the Watchfolder element. 
• See the Momentum Configuration Guide for further information on configuring the 

Watchfolders.

Note: To ingest Caption files the option Set Subtitle must be activated and 
the Default Language specified for the Watchfolder element involved 
in the ingest process.

Note: In the Elements pane of the Workflow page, the Ingest section contains 
two elements related to the Watchfolder function: Watchfolder and 
Watchfolder FTP. The only difference is the protocol used to access the 
monitored folders. 

Fig. 4-102:  Watchfolder Element
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A Watchfolder working in Sidecar mode, expects that a matched pair of files, one media file 
(video), and a sidecar XML file (metadata description), are ingested to start a workflow.

To activate the Sidecar mode on a Watchfolder element, additional configuration is 
required in the Watchfolder template, see the Momentum Configuration Guide for a 
detailed description of the configurable parameters.

When working in Sidecar mode, the Watchfolder element fails if only one of the two 
expected files arrives in the monitored folder. After a configurable timeout, Momentum 
checks the database and if no reference to the expected material is found, then the task 
progresses through the failed port.

Ingest from Another Momentum or Morpheus Playout Automation 
System

Momentum is able to ingest BXF message files originating from either another Momentum 
system or a Morpheus Playout Automation system by way of the BXF Receiver workflow 
element. This enables Momentum to receive events relating to the creation, update or 
deletion of materials, depending on the operations performed in the database of the 
source system.

Prior to version 5.0, Momentum interfaced with a Morpheus Server application using the 
Morpheus workflow element. 

In addition to the recommended ingest method using the BXF Receiver element, several 
other methods are currently available to interface between Momentum and a Morpheus 
system for the ingest of material, including:

• Morpheus (XMLDB Interface) workflow element (to be deprecated in Momentum 
version 5.1)

• XML Gateway Receiver workflow element (to be deprecated in Momentum version 
5.1)

• XCache Receiver workflow element (to be deprecated in Momentum version 5.1)

Ingest Using a BXF Receiver Workflow Element
When ingesting material using the BXF Receiver workflow element, Momentum monitors 
a configurable location, referred to as the BXF Route, for the arrival of BXF format XML 
message files. See Section  Defining BXF Routes for the BXF Workflow Elements on page 79 
for more information on setting up BXF Routes.

Fig. 4-103:  BXF Receiver Workflow Element
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When a BXF format XML message file arrives at the BXF Receiver, Momentum reads the 
values of the specific tags <action> and <housenumber>, validates the content of the 
message against the Momentum database and uses these values to determine the output 
route of the subsequent path for the task as follows:

• If the <action> tag contains the value remove, Momentum queries its database to 
check for a Title with a matching Morpheus ID or Material ID. If a matching Title exists in 
the database, then the BXF Receiver element routes the task through the ok port to 
initiate a workflow to remove the original Title from the Momentum database.
To improve the clarity of your workflow, you might use the Add port function of the 
element to configure an additional port through which Momentum routes tasks 
intended to remove material from its database.

• If the <action> tag contains the value add, Momentum queries its database to check 
for a Title with a matching Morpheus ID or Material ID. If a matching Title exists in the 
database, then the BXF Receiver element routes the task through the ok port to initiate 
a workflow to update the original Title in the Momentum database with the newly 
ingested Title, or to create the new Title in the database, if there is no matching Title.
To improve the clarity of your workflow, you might use the Add port function of the 
element to configure an additional port through which Momentum routes tasks 
intended to update material in the database.

• If the BXF message is a Transfer Request, Momentum queries its database to match 
the value of the <housenumber> tag to a Morpheus ID. If a matching Title exists in the 
database, then the BXF Receiver element routes the task through the ok port to initiate 
a workflow to complete the Transfer Request.
To improve the clarity of your workflow, you might use the Add port function of the 
element to configure an additional port through which Momentum routes tasks of this 
type.

• If the BXF message is a Transfer Request that refers to an object that is not present in 
the Momentum database, then the BXF Receiver element routes the task through the 
ok port to initiate a workflow to complete the Transfer Request without supporting 
material.
To improve the clarity of your workflow, you might use the Add port function of the 
element to configure an additional port through which Momentum routes tasks of this 
type.

• The task goes through the failed port if any system or connection errors occur during 
the ingest of the BXF message.

See Figure 4-104 for a schematic overview of the receipt of Morpheus transfer requests by 
the BXF Receiver workflow element.

See the Momentum Configuration Guide for more details about the BXF Receiver and its 
parameters. 
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Fig. 4-104: Schematic Overview - Receipt of Morpheus Transfer Requests & Notifications by BXF Receiver 
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Defining BXF Routes for the BXF Workflow Elements
Using the Admin page, you can define BXF routes for use by the BXF Receiver, BXF 
Morpheus Query, BXF Morpheus Export and BXF Transfer Metadata Receiver workflow 
elements, see Figure 4-106. 

In the BXF Routes pane, Momentum lists all existing routes for the import and export of 
BXF messages. You can use this pane to create new BXF routes and modify existing BXF 
routes as required. The route refers to the communication path followed by the BXF 
messages.

To create a new BXF route, click Create BXF route... The following dialog box is displayed 
requesting you to enter a label for the new BXF route:

Enter a unique label to identify the new BXF route you are defining, then click Ok. 
Momentum adds the new BXF route to the list and opens a new configuration pane for you 
to enter the details of the BXF route, see Figure 4-107.

Fig. 4-105: Admin Page - Defining BXF Routes

Fig. 4-106:  Admin Page - Create BXF Route Dialog
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The BXF Agent section enables you define the following components:
• Receiver Mode - Define the mode employed by the BXF Receiver workflow element to 

receive BXF messages. You can choose between WatchDir or Socket modes. The 
socket mode enables Momentum to receive BXF messages directly, using a socket 
reader, rather than wait for BXF files to appear in a watched directory. Using a socket 
connection can help to reduce latency in the communication between the source and 
target systems. If a socket connection fails, Momentum will retry to receive any 
messages that cannot be processed as a result of the connection failure. The WatchDir 
mode requires you to define the path to a directory that Momentum monitors for the 
arrival of BXF messages.

• Export Mode - Define the mode employed by the BXF Export workflow element to 
receive BXF messages. You can choose between WatchDir or Socket modes. The 
socket mode enables Momentum to export BXF messages directly, using a socket 
writer, rather than wait for BXF files to be placed in a watched directory. Using a socket 
connection can help to reduce latency in the communication between the source and 
target systems. If a socket connection fails, Momentum will retry to export any 
messages that cannot be processed as a result of the connection failure. The WatchDir 
mode requires you to define the path to a directory to which Momentum writes BXF 
messages.

• Default template - Select a default XML configuration file for the BXF workflow 
elements. These configuration files contain settings for the general action of the 
corresponding BXF element and the types of task routed through the ok and failed 
output ports.
The default templates are located in the following folders on the Momentum server:

Fig. 4-107: Defining BXF Routes
80



Momentum
Operator’s Guide
• C:\Mantrics\BxfReceiverTemplates\default.xml

• C:\Mantrics\BxfExportTemplates\default.xml

• C:\Mantrics\BxfQueryTemplates\default.xml

For more information on the default configuration files for the BXF workflow elements, 
see the Momentum Configuration Guide.
For a schematic overview of the configurable components of the BXF workflow 
elements, see Figure 4-110 on page 84.

• Default label - Select a default label used for the BXF workflow element.

Configure the BXF Agent components as follows:
1 In the BXF Routes pane, select the label of the BXF route you want to configure.
2 In the Receiver Mode section, either keep the default WatchDir mode or click the 

Mode drop-down menu and select Socket.

a For the WatchDir mode, enter the full path to be monitored by the BXF Receiver for 
the arrival of new BXF messages in the Watch dir field. This is the source directory 
from which a BXF Receiver workflow element receives BXF files. 

You can also click the browse icon ( ) to browse to the desired directory.

b For a socket connection, enter the IP address and Port number of the source server 
into the corresponding fields. This is the source from which a BXF Receiver 
workflow element receives BXF messages.

3 In the Export Mode section, either keep the default WatchDir mode or click the Mode 
drop-down menu and select Socket.

a For the WatchDir mode, enter the full path to the target destination directory used 
by the BXF Export element in the Destination dir field. This is the target directory 
to which a BXF Export workflow element exports BXF files.

Fig. 4-108: Defining BXF Routes - Configuring the BXF Agent Section
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You can also click the browse icon ( ) to browse to the desired directory.

b For a socket connection, enter the IP address and Port number of the destination 
server into the corresponding fields. This is the target server to which a BXF Export 
workflow element exports BXF messages.

4 Click the Default template drop-down menu and select the required template name 
from the available list. Generally this will be Default unless you have configured your 
own BXF templates.

5 Click the Default label drop-down menu and select the required label for all BXF 
elements in that BXF route.

6 Click Save to save the BXF Agent settings.

The Archive section of the BXF Routes configuration enables you to define archive folder 
locations for certain types of acknowledgment or error messages, resulting from BXF 
message communications, see Figure 4-109. This ensures that the messages are available 
for troubleshooting and diagnostic purposes.

Defining the Archive Components

In the Archive section you can define the following components for the BXF Receiver and 
BXF Morpheus Export workflow elements:

• An Acknowledge directory in which to store received or exported acknowledgment 
messages (Acks), confirming the validity of the BXF message.

•  A Nacknowledge directory in which to store received or exported negative 
acknowledgment messages (Nacks) rejecting the validity of the BXF message.

• A directory in which to save invalid or failed BXF messages.

In addition, you can also define the following components for the Morpheus File Reader:
• A directory for completed messages.
• A directory for error messages.

Fig. 4-109: Defining BXF Routes - Configuring the BXF Message Archive Paths Section
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Configure the Archive components as follows:
1 In the Archive BXF Receiver section, browse to, or enter the full path for, the following 

directories:
• A directory in which to archive Acknowledgment messages (ACKs), confirming a 

successful receipt of a BXF message.
• A directory in which to archive Negative Acknowledgment messages (NACKs), 

confirming a failure to receive a BXF message.
• A directory in which to archive invalid or failed messages relating to received BXF 

messages.
2 In the Archive BXF Morpheus Export section, browse to, or enter the full path for, the 

following directories:
• A directory in which to archive Acknowledgment messages (ACKs), confirming a 

successful export of a BXF message.
• A directory in which to archive Negative Acknowledgment messages (NACKs), 

confirming a failure to export a BXF message.
• A directory in which to archive invalid or failed messages relating to exported BXF 

messages.
3 In the Archive Morpheus File Reader section, browse to, or enter the full path for, the 

following directories:
• A directory in which to archive Completed messages.
• A directory in which to archive Error messages.

4 Click Save to save the Archive settings.

To remove an existing BXF route, click the delete icon    corresponding to its label in 
the BXF Routes pane. No confirmation is required.

If necessary, the Reset button recalls the last saved version of the BXF route, discarding any 
changes since the last save. The Clear button clears the content of all the fields.
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Fig. 4-110: Configuring the BXF Elements for Momentum / Morpheus Integration
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Ingest from a Morpheus System (XMLDB Interface) Element

Using the Morpheus workflow element, the Momentum system can interface with a 
Morpheus Playout Automation system by analyzing the messages generated by the XMLDB 
Interface.

Momentum uses the insert, update and delete commands contained in the message to 
determine the subsequent workflow of a task.

If a message contains the commands insert or update, then Momentum checks the 
existence of an Instance for the specified Title and for the specified Device ID.

• If the Instance is not found in the database, then a new Instance is created and the task 
goes through the ok port.

• If the Instance is already present in the database:
• If the Instance was originally ingested from another source, it is updated to appear 

as if it was ingested by the XMLDBInterface. The task goes through the Instance 
Updated port.

• If the Instance was created by an older version of the XMLDBInterface, then it is 
deleted together with all of its children. The new Instance in inserted into the 
database. The task goes through the ok port.

• If the Instance is the same as the one already in the database and only a few items 
of metadata are different, the original Instance is preserved, the metadata is 
modified and the task goes trough the Metadata Updated port.

If the message contains a delete command, Momentum checks for the existence of an 
Instance for the specified Title and for the specified Device ID. If the Instance is found, 
depending on the configuration, its label can be set to Deleted. The task goes through the 
Deleted port and is automatically set to refer to the instance specified in the 
XMLDBInterface message.

See the Momentum Configuration Guide for more information on the Morpheus workflow 
element, its parameters and the configuration file settings.

Note: The M orpheus workflow element will be deprecated from Momentum 
version 5.1 and should not be used. It is recommended to use the BXF 
Receiver, BXF Query and BXF Export workflow elements to interface with 
a Morpheus system in preference to the Morpheus element.

Fig. 4-111:  Morpheus Workflow Element
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The Morpheus Server is able to track all the received events and use a synchronization 
parameter to recall all the events up to the last received. You can also force synchronization 
with the Morpheus Media Management database (MAPP) to ingest only the material 
created or updated during a defined time span.

To synchronize the Momentum database with the Morpheus Media Management 
database:

1 Open a command prompt and navigate to the directory where the Morpheus Server 
application is installed. In a standard installation, the directory is:
C:\Program Files\Mantrics S.r.L\Morpheus Server 2.2

2 Enter the following:
MorpheusServer.exe -sync 01-jan-2017 01-feb-2017

Where the first date is the start day and the second date is the last day of the 
synchronization time span.

Ingest using an XML Gateway Receiver Element

When ingesting using the XML Gateway Receiver workflow element, Momentum 
monitors a specified target folder for the arrival of XML Gateway files. These files have a 
predefined format and contain both the metadata description of a material, and the path 
where the media file is located.

This element has several specialized output ports to manage the result of the ingest action 
as follows:

Note: If material with the same ID is ingested, Momentum verifies the dates 
and if the material is to be deleted, it creates a new ingest to update the 
material with the new content.

Note: The Gateway Receiver workflow element will be deprecated from 
Momentum version 5.1 and should not be used. It is recommended to 
use the BXF Receiver, BXF Query and BXF Export workflow elements to 
interface with a Morpheus system in preference to the Morpheus 
element.

Fig. 4-112:  XML Gateway Receiver Workflow Element
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The Gateway Receiver workflow element does not directly monitor the media file, only the 
target location specified in the XML file in order to ensure that the material is reachable. If 
the ingest process can progress with no errors, Momentum creates a new Instance and Title 
and starts the next stage of the connected workflow.

For more details about the XML Gateway Receiver element, see the Momentum 
Configuration Guide.

Ingest using an XCache Receiver Element

The XCache Receiver monitors a target folder for incoming XCache messages and 
manages the routing of Delete and Transfer Request message types.

Port Description

ok Used when the XML is correct and the files are available.

Missing Media Used when the media files specified in the XML file are not 
available or reachable.

Missing Metadata Used if one or more mandatory items of metadata are not 
initialized in the XML file.

Invalid Metadata... Used when values specified as mandatory are missing from the 
XML file.

ID Mismatch Used when the Material ID differs from the Filename specified.

Duplicate Used if the material is a duplicate. To verify this condition, 
Momentum checks the metadata specified in the configuration 
file.

Failed Used if any system or connection errors occur during ingest of 
the XML Gateway file.

Note: The XCache Receiver workflow element will be deprecated from 
Momentum version 5.1 and should not be used. It is recommended to 
use the BXF Receiver, BXF Query and BXF Export workflow elements to 
interface with a Morpheus system in preference to the Morpheus 
element.

Fig. 4-113:  XCache Receiver Workflow Element
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When an XCache message arrives, it contains a Morpheus ID. Momentum retrieves this ID 
and carries out the following checks:

• If the same Morpheus ID is already associated with an item of material in the database, 
then the task goes through the ok port, regardless of message type.
You can activate more strict matching by setting the <DeviceIdIgnore> tag to true in 
the configuration file:
C:\Mantrics\XCacheReceiverConfig.xml

In this case the Material must have the Morpheus ID specified and an instance with the 
DeviceId metadata equal to the DeviceId specified in the XML message. If both the 
conditions are true, the task goes through the ok port.

• If there is no Material with the same Morpheus ID, then Momentum creates a new item 
of material with the Morpheus ID. The task goes through either the TransferRequest 
port or the DeleteInstance depending on the message type received.

• If the XML received is not valid, then Momentum creates an empty Title and the task 
goes through the failed port.

See the Momentum Configuration Guide for the configuration details of the XCache 
Receiver.

Ingest using a PAM-EVS Element
The Pam-EVS workflow element is an entry point that enables Momentum to ingest files 
received from an EVS Production Asset Manager (PAM) system and update a Morpheus 
Playout Automation system accordingly.

This PAM-EVS workflow element ingests files in several stages, as follows:
1 Inbound files are first delivered to a specific location on a NAS storage platform (for 

example, EMC Isilon).
2 Depending on its configuration mode (Socket or DirWatcher) the PAM-EVS workflow 

element either:
• Takes delivery of various format files (*.*, *.TXT, *.MXF, or *.XML) files across the 

defined socket connection between Momentum and the NAS.
• Monitors for the appearance of TXT or XML files in the specified watch directory.

3 Momentum validates the incoming files.
4 If necessary, Momentum uses the configured Conversion Script to convert the 

incoming file to a suitable XML format for Momentum.

Fig. 4-114:  PAM-EVS Workflow Element
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5 For new XML files, Momentum starts a workflow on the Complete path as follows:
• If media is not found, the element starts a Missing Media workflow to send 

notifications.
• If a value is missing from the XML file, the element starts a Missing Metadata 

workflow. 
• If a specific value (for example, MATERIAL_ID or LONGFILE_ID) does not match the 

filename, the element starts a Mismatch workflow.
• If the XML file fails validation against the XML standard, or certain values are 

missing, the element starts the Failed or Missing Metadata workflow.
• If the same ID is already in the Momentum DB then the workflow start the 

Duplicate path
Momentum attempts to export new material to the Morpheus database.

Ingest from sQ Server Systems
The sQ Sync workflow element provides an interface to an sQ Server environment. This sQ 
Sync interface registers with one or more sQ ISA Managers, using th configured sQ Zones, 
for updates on material and also to allow updates and deletion requests to be sent from 
Momentum to the ISA Manager. 

The sQ Sync workflow element enables Momentum to listen for the sQ events: 
ClipCreated, ClipModified and ClipDeleted generated from the sQ environment and then 
makes the appropriate changes in Momentum. Momentum communicates with the SQ ISA 
Manager using the Common Object Request Broker Architecture or CORBA. 

When a clip is created in the sQ database, the sQ Sync workflow element captures the 
ClipCreated notification and creates a Momentum TITLE with a TITLE ID taken from the Clip 
GUID value, contained in the sQ database.

The detected event then triggers an appropriate workflow as follows:
• On detecting a ClipCreated event, after processing the task, Momentum:

• Creates a new Material Title.
• Creates a new mediaAsset child of the new Title.
• Creates a thumbnail and sets it as the Title icon.
• Allocates metadata to the sQ mediaAsset.
• Propagates the task through the Clip Created port.

• On detecting a ClipModified event, after processing the task, Momentum:
• Modifies the sQ Metadata.
• Propagates the task through the Clip Modified port.

• On detecting a ClipDeleted event, after processing the task, Momentum:
• Takes no action on the material.
• Propagates the task through the Clip Deleted port.

For a schematic overview of the Momentum / sQ integration, see Figure 4-115.
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Fig. 4-115: Overview of the Integration Between Momentum and sQ Server
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Ingest from an Etere Receiver
The Etere Receiver workflow element enables Momentum to analyze XML files published 
by the Etere system. Each Etere XML file can specify HQ or LQ paths and segmentation of 
the related material, so it is not required to ingest the media asset, provided that 
Momentum can access the network locations specified in the HQ and LQ paths.

Momentum parses the content of the Etere XML file and at the first occurrence of .MXF or 
.MP4 in its content, uses the related tag values to initialize the path for the HQ and LQ 
versions of the new Title. In addition, it is also possible to extract the metadata Season 
Number and Episode Number from the received XML file.

The following table provides some examples of content that can be received from Etere:

Fig. 4-116:  Etere Receiver Workflow Element

Title Essence Type Number of 
Tracks

Channels Per 
Track

Sample Rate 
(KHz)

Bits Per Sample

SDC-5-0018.mxf MPEG IMX 30 1 4 48 16 bit

SDC-5-0022.mxf MPEG IMX 30 D-
10

4 1 48 24 bit

SAH-3-
0004_SID1118.
mxf

XDCAM HD 422 8 1 48 24 bit

DBZ-1-0001.mxf XDCAM HD 422 8 1 48 24 bit

PRS58741.mxf MPEG 2 2 2 48 16 bit

AA00507.mxf MPEG 2 2 2 48 16 bit

CZ-6-0002.mxf MPEG 2 4 1 48 16 bit

AA00495.mxf MPEG 2 2 2 48 16 bit

WI-2-0001.mxf MPEG 2 4 1 48 16 bit

PRS52487.mxf MPEG 2 4 1 48 16 bit

SZO-4-0001.mxf MPEG IMX 30 1 4 48 16 bit
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Overview of the Momentum Database Objects
Objects of different types in the Momentum database are associated with specific sets of 
metadata. Momentum automatically assigns a unique ID (the GUID) each time a new object 
is created.

In normal operation, most users search for and control a TITLE object; the common term 
used in Momentum for all versions of the same media asset.

The following objects are available in the Momentum database:

Object Description

PROJECT A virtual folder that can contain any kind of object. It is 
publicly available to users.

TITLE An object that can contain multimedia material.

MEDIAASSET An object that contains a media file.

AUDIOTRACK An object that represents the audio component of a media 
asset file.

KEYSEGMENT A sub-video material; it does not have any specific file content, 
but instead contains pointers to the video material.

TAPE An object that originated from a tape source, for example, a 
VTR.

HDD An object that originated from a Hard Disk Drive source.

OPTICAL An object that originated from an optical support mechanism, 
for example, a DVD or BluRay disk.

PROTOCOL An object that originated from a data transfer mechanism 
such as FTP.

DOCUMENT Any type of support file that the user considers useful to 
attach to an item of material (for example, PDF or EML files).

IMAGE An object that contains an image file.

TIMELINE An aggregate of audio/video and text, as represented in the 
Momentum timeline.

DEFECT An object that contains metadata.

THUMBNAIL A single thumbnail linked to a TITLE or a MEDIA ASSET.

CAPTION An object child of a title containing the subtitles of the MEDIA 
ASSET.
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Database Schemas
The following schema represents how a movie is structured in Momentum.

Example Schema

The Movie (PROJECT)
The Movie 1st half (TITLE)

The_Mov_1st_half.mxf (MEDIA ASSET)
The Movie 2nd half (TITLE)

The_Mov_2nd_half.mxf (MEDIA ASSET)
The Movie_Final (TITLE)

The_Mov_final.mxf (MEDIA ASSET)
TIMELINE for On Air (TIMELINE)

The_Mov_1st_half.mxf (MEDIA ASSET)
The_Mov_2nd_half.mxf (MEDIA ASSET)

TIMELINE for prime time trailer (TIMELINE)
The_Mov_Trailer.mxf (MEDIA ASSET)

Shot1 for trailer (KEYSEGMENT)
Shot2 for trailer (KEYSEGMENT)

Supplier NDA.pdf (DOCUMENT)

In this example, the movie:
• Is split into two halves,
• Has a defined prime-time trailer,
• Has playout automation for stitching together the two parts,
• Includes some document material.

A schema of metadata is automatically applied to the material during ingest, depending on 
the category selected in the start element of the workflow (see Creating a Workflow for 
details).

Creating Metadata
The process for creating metadata can be automatic or manual:

• Automatic - Momentum extracts items of metadata, which are embedded in the file or 
signal, and inserts them into the database, see Automatic Metadata for more 
information.

• Manual - Metadata is defined and added by users and each modified value is 
immediately updated in the database.

Some metadata items such as Title, Description and Keywords are common to all 
material, while others depend on the material category.

All Momentum pages in which a Details pane is active (for example, the Catalog or To Do 
pages), users with the correct role permissions can edit metadata. All non-system metadata 
in the Details pane is editable by clicking the edit icon  .
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Automatic Metadata
Momentum automatically extracts the following items of metadata from the material and 
places it in the database:

• Picture Aspect: WxH, Aspect Ratio, Frame Rate, Interlacing
• Timecode related: TC IN, TC OUT, isDropFrame
• Codec: Codec Name 

Momentum also extracts the following audio metadata:
• Length: Duration
• Sampling: Sample Rate, Bit per Samples, Number of Channels
• Codec: Codec Name
• Additional information: StreamPos, Language

Editing Metadata

To edit an item of metadata:
1 Select the material in the Results pane of a search tool.
2 In the header of the Details pane, click the edit icon  .
3 Scroll down the pane to find the required metadata to modify.
4 Enter the new value.

Fig. 5-117:  Editing Metadata in the Catalog Page

Title Selected 
in Search 

Results Pane

Metadata Details 
Displayed for 
Selected Title
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5 In the header of the Details pane click the edit icon   to save the changes.
You will need to refresh the search before your changes are reflected in with the 
thumbnail or details of the search results.

Customizing Metadata Schemas Using Metadata Masks 
A metadata mask defines how the metadata is displayed in the Catalog Details pane.

By default, Momentum provides some categories with preconfigured schemas. You can, 
however, customize the category fields in a schema using the Admin > Metadata masks 
page. You can modify the related schema by adding or removing attributes and also by 
selecting metadata for each attribute.

You can manipulate metadata listed in the metadata mask Description area by dragging 
the selected metadata and dropping into the other pane. You will need to save any changes 
to the metadata schema in order for them to become active.

Fig. 5-118:  Admin Page Metadata Masks Configuration

Note: Attributes listed in the configuration are directly visible in the Catalog 
Details pane, while others are placed into groups, if created, or into the 
All group, which is created by default.
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Adding an Item of Metadata to a Schema
To add an item of metadata to a selected metadata schema:

1 Select the Schema from the Schemas list in the left-hand pane. The Available 
Metadata and the Metadata mask panes update automatically.

2 Select the required metadata in the Available metadata pane, then and then drag and 
drop it into the Metadata mask pane. The metadata is added to the mask.

3 Click Save to save and activate the new configuration.

Modifying the order of Metadata in a Schema
To reorder the metadata in a selected schema:

1 Select an item of metadata in the Metadata mask pane.
2 Drag and drop it into its new position.
3 Click the Save button to save and activate the new configuration.

Modifying the Order Label of Metadata into a Schema
To modify the label of a metadata in a selected schema:

1 Select an item of metadata in the Metadata mask pane.
2 Click the edit icon .

This opens the Details dialog.
3 Enter a new name for the metadata in the Name field.
4 Assign the group to which the metadata belongs by selecting from the Group drop-

down menu, if necessary. 
5 Click Ok to save your change
6 Either make further metadata changes, or click Save to save and activate the new 

configuration.

Deleting an Item of Metadata from a Schema
To delete an item of metadata from a selected schema, click the Delete icon .

The metadata is removed from the Metadata mask pane and moved into the Metadata 
available pane.

Creating a New Metadata Group
The metadata masks define how Momentum displays the metadata for a selected element 
on the Catalog page. An item of material added to the metadata mask shown in Figure 5-
118, appears as follows on the catalog page:
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The Details pane first lists the metadata which is included in a mask but that is not included 
in a metadata group. The metadata placed in the Programme and All groups is listed in 
collapsible lists below.

To create a new group in a metadata schema:
1 Click the edit icon    next to the name of an item of metadata in the metadata mask 

pane.
A new Details dialog is displayed which enables you to edit the metadata label and 
create or assign a group to the selected metadata (select a group from the drop-down 
list if you want to assign it to an existing group).

2 Enter the name of the new group in the Group field.
3 Click Ok. 

Momentum creates the new group and assigns the selected metadata to that group.

New Item Added to 
Metadata Mask in 

Details Pane

Fig. 5-119: Metadata Added to Metadata Mask in Details Pane of Catalog Page

Collapsible Metadata 
Groups

Fig. 5-120:  Creating a New Metadata Group
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Organize the metadata content of the new group by dragging and dropping metadata 
from the Available metadata pane or within the same metadata mask pane.
Figure 5-121 shows that a new Generic group has been added to the schema.

4 Click Save to save the change and activate the new configuration.
On the Catalog page, the same material now shows the new group of metadata in the 
Details pane.

Fig. 5-121:  New Metadata Group Added to Metadata Mask
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Configuring Search Result Attributes
When Momentum displays the results of a material search (either in the Thumbnails view 
or List view) it includes some metadata for each item reported. You can customize this 
information, as required, using the Admin > Results config page.

Fig. 5-122:  Catalog Page New Metadata Group Added to the Details Pane

Generic Metadata Group Added 
to Metadata Mask in Catalog 
Details Pane

Fig. 5-123:  Results Configuration
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The configuration of the Results page affects all of the material in a selected schema and all 
of the results in the GUI search tools.

Making Metadata Visible in a Results list 
To add attributes to the search Results pane:

1 Navigate to the Admin > Results config page.
2 Select a metadata schema from the Schemas list.
3 Select an item of metadata from the Available metadata list and drag it to the Visible 

metadata pane.
4 Click Save to save and activate the new configuration in the Search Results pane.

Modifying the Display Order of Metadata in a Results List
To reorder the metadata in a specific configuration:

1 Navigate to the Admin > Results config page.
2 Select a metadata schema. The current metadata configuration is loaded into the 

Visible metadata pane.
3 Click and drag the selected metadata to a new position in the list.

4 Click Save to save and activate the new configuration.

Removing Metadata from a Search Results List
To remove an item of metadata from a configuration so that it is no longer visible in a 
Results list:

1 Navigate to the Admin > Results config page.
2 Select the metadata schema. The configuration is loaded into the Visible metadata 

pane.
3 Click the Delete icon  next to the metadata name.
4 Click Save to save and activate the new configuration.

Note: The saved configuration also affects the items listed in the To Do page 
and in the material browser on the Editing page (see Chapter 8 Working 
with Metadata, on page 93 and Chapter 7Creating Content in the Logger 
Page, on page 139 for details).

Fig. 5-124: Changing the Order of Metadata in Search Results List

Marker to Show New Position 
of Metadata in Search Results
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Using the Advanced Mode
In both the Metadata masks and Results config pages, an Advanced mode checkbox 
enables you to display more information about the metadata. When activated, Momentum 
displays additional columns in the Available metadata, Metadata mask and Visible 
metadata panes as shown in Figure 5-125:

The additional columns include the Metadata ID and the Full name columns. This 
information provides the full name of the metadata and is useful to understand which 
schema inherits the selected metadata.

Managing System Metadata
The Admin > Metadata page provides an overview of all metadata available in the 
database schema used on a specific Momentum installation. You can also make changes to 
the metadata as required.

. 5-125:  Admin Page Advanced Mode Active

Advanced Mode 
Checkbox 
Selected
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The Metadata page is divided into two panes:
• The Metadata Pane

This pane lists all metadata available on the system, grouped by category. The follow-
ing information is reported for each item of metadata: 

• Name: The name displayed in the interface for the item of metadata.

• Metadata ID: The ID which uniquely identifies each item of metadata, for 
example, this is the value used to map the value of the item of 
metadata to a specific XPath.

• Type: Description of the kind of metadata, for example, number.

In this pane, you can filter metadata to locate specific items quickly using the Search 
field filter in the top-right corner. Enter a search string to display any items partially or 
fully matching the name or the Metadata ID.

• The Details Pane

This pane lists the detailed characteristics of the metadata selected in the Metadata 
pane. For each item of metadata, the following information is listed:

• Name: The name displayed in the interface for the item 
of metadata.

• Metadata ID: The ID which uniquely identifies each item of 
metadata, for example, this value is used when 

Fig. 5-126:  Admin Page Metadata Editing Tool
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mapping the value of the item of metadata to a 
specific XPath.

• Full name: Full name used to refer to the metadata item. By 
default, this is the same as the Metadata ID but 
this value can never be modified, while the 
Metadata ID can be edited.

• Type: A description of the kind of metadata, for 
example, number, text, date, timecode, Clob, etc.

• Editable: Indicates whether the metadata can be edited.
• Category: Reports the Category parent of the selected 

metadata.
• List of possible values: Enables you to associate a custom list of values 

with an item of metadata. This capability means 
that, when a user defines a search query in any of 
the Search panes, the custom list values can be 
used in the search criteria. When defining a search 
query, the user can select an item of metadata 
from the list and if this metadata is associated 
with a custom list, the user can select a value from 
a drop-down list instead of typing.

• Allow blank: Makes an empty field a valid value for metadata.
• Max length: The maximum number of characters that can be 

used to give a value to the selected metadata.
• Excluded chars: A list of characters which are forbidden for the 

selected item of metadata.
• Regexp: Can contain a regular expression (Oracle). The 

data inserted in the metadata must comply with 
the rule stated in the regular expression.

For the editable fields, (Max length, Excluded chars, etc.) you can insert custom values and 
store them in the database using the Save button in the bottom-right corner.

The Reset button helps you to avoid making accidental database modifications by 
discarding all unsaved values.

Editing Metadata Categories
You can use the Admin page Edit category to edit existing metadata schema and to create 
custom metadata categories, which inherit metadata from the MomentumInstance or 
MomentumCore categories.

This enables you to ingest material associated with custom metadata, so that it inherits 
from the Momentum Instance category, and at the same time extends the set of metadata 
available for the Momentum instance material.

Momentum provides the following default metadata Categories:
• AudioInstance
• Commercial
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• DivaInstance
• ImageInstance
• Junction
• MomentumCore
• MomentumInstance
• Movie
• Programme
• Promo
• SQInstance
• SocialInstance
• Sport
• SubtitleInstance

On occasion, you may need to add one or more items of metadata to a Title or Instance 
schema. For example, you might want to add one or more metadata elements to the 
MomentumCore schema. To do so, you can add a new typedef (type definition) to the 
MomentumCore category using the Create typedef function in the Edit category page. 
This will create a new data structure or Struct containing the original metadata of 

Fig. 5-127:  Admin Page - Edit Category

Selected Metadata 
Category

Details of Selected 
Metadata Category

Click to Create New 
TypeDef for Category
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MomentumCore, together with one or more types of metadata that you want to associate 
with the TypeDef, see Figure 5-128 for a schematic overview.

Creating a New Metadata Category
Add a new Metadata Category as follows:

1 Select Edit category from the Admin menu.
2 Click Create category...
3 This opens the Create category dialog, see Figure 5-129.
4 Enter the name to assign to the new metadata category into the Name field, for 

example RCTest.
5 Click the Inherits from drop-down menu and select the Category from which to inherit 

the metadata schema, see Figure 5-129.

Fig. 5-128: Schematic Overview of Metadata Category Tree Structure

Note: Both fields must be completed. If you leave a field empty, it is underlined 
in red and you will be unable to save your changes.
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6 Click Ok to save the new category.
Momentum adds the new metadata category to the list in the Categories pane, see 
Figure 5-130.

Creating a Typedef for a Metadata Category
You can use the TypeDef functions to associate inherited metadata structures with existing 
or new metadata categories as follows:

1 Select a metadata Category from the list in the Categories pane.
This loads the metadata category into the Details pane. For example, select the 
category RCTest added in the previous section.

2 In the Details pane, click Create typedef.
3 Enter a suitable label to identify the new TypeDef in the Label field.

The TypeDef label is displayed as a container for the individual metadata elements 
defined by the TypeDef Struct.

Fig. 5-129:  Admin Page - Create Category Drop-down Menus

Fig. 5-130: Admin Page - New Metadata Category Added to Categories Pane
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4 Either select an existing structure from the Struct drop-down menu or select the 
option Create struct...
When you select an existing structure, the new typedef inherits the metadata elements 
from that structure.

Click Create struct... to open the Create struct dialog, see Figure 5-132.
5 Enter a name to identify the data structure in the Name field, for example 

SeriesInstance.

Fig. 5-131: New Metadata Category Added to Admin Metadata Page

Fig. 5-132: Admin Edit Category - Create Struct Dialog
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6 Click Add type to add each additional metadata element and data type to the new 
data structure.

7 For each data type, enter an appropriate name and select the required data type from 
the Type drop-down menu. You can select from:

• Text (and set maximum number of characters)
• Date
• Timecode
• Number (check Advanced to set Precision and Scale for the number) 
• User
• Clob (character large object)
• Boolean

The name and associated data types will represent the actual metadata element you 
will see when using the Catalog page.

8 Click Ok to save the data types associated with the new structure.
You can review the new data types in the structure by clicking the Types drop-down 
menu, see Figure 5-133. To remove a TypeDef from a Category, click the Delete icon.

To change a Category or TypeDef name, select the Category and over-type the name as 
required.

9 Click Save to save the new or modified metadata Category.
Figure 5-134 shows how the components of a new Category structure are rendered in 
both the Admin Metadata page and in the Catalog page, when used to define a search 
query.

Fig. 5-133: Review Data Types

Expand to Review 
Data Types 
Associated with 
TypeDef 

Delete typedef
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Fig. 5-134: New Metadata Category Available for Use in Search Query

New Metadata Category Listed in Admin Metadata Page

New Metadata Category Displayed in Search Query Tree

TypeDef Struct 
Metadata 
Elements

TypeDef 
Label

Category

Metadata 
Field Type
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Fig. 6-
Using the Catalog Page to Search the 
Momentum Database
135
Introduction
The Catalog page enables you to search the entire content of the Momentum database 
using specific keywords and complex search criteria. On completion of a search, you can 
select the content in order to examine the material and its related metadata.

The Catalog page contains the following panes:
• Search Tool: See the section Using the Search Tool, on page 17 for details.
• Material Tree: Reports the parents and children of the selected material in a 

collapsible/expandable tree structure, which shows, for example, 
associated media assets, key segments, thumbnails, timelines, 

: Catalog Page

Material Tree 
Pane

Material 
Search Tool

Details Pane

Media Player 
Pane
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tasks, auxiliary files, etc. Momentum dynamically creates the tree 
structure, depending on the specific relationships of the selected 
material. In addition, the Actions menu enables you to add 
material to a project or to upload an auxiliary file (for example, 
TXT, PDF, DOC, DOCX, etc.) to associate with the selected material. 
The Tasks... button opens a Tasks pane for the selected material. 

• Details Pane: Lists the metadata details of the item(s) currently selected in the 
Material Tree, for example, Project, Media Asset, Title, Key 
segment, Thumbnail, Audiotrack, etc. If a metadata value 
contains a URL it is rendered as an active file name, which you can 
click to go to that item of material. You can review and, if 
necessary, edit Metadata in the Details pane. See Editing 
Metadata Fields, on page 10 for information on editing the 
metadata fields or Chapter 5 Working with Metadata, on page 93 
for more information.

• Media Player: Used to play-back and inspect the selected material. When 
playing a clip, you can hover the cursor over a frame in the 
timeline to display a thumbnail and timecode for that frame. See 
the section Media Players, on page 12 for a description of other 
features of the Player. 

An Overview of Metadata in Momentum
The Momentum asset management database is the primary repository of metadata used 
by the system.

Basic Metadata
Basic metadata is defined as one or more of the following items:

• Title: User defined
• Owner: User defined 
• Category: User defined
• Description: User defined
• Duration: System generated
• Format: System generated
• Creation Date: System Generated
• Creation Time: System Generated

Basic metadata is usually only referred to in systems where the SAM sQ Server option is 
present for SDI workflows, as these are the only editable metadata fields on an sQ Server 
and consequently this is the preferred metadata included with media originating from an 
sQ Server.
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Standard Metadata
The metadata set supplied with Momentum is considered to be the Standard metadata.

Standard metadata is available to all assets regardless of the source. For example, media 
originating from an sQ Server may arrive with basic metadata, but the full standard 
metadata set is then available for that media asset. You can associate all standard metadata 
fields with non-media assets such as auxiliary files.

See Appendix C Standard Metadata Fields, on page 223 for a complete list of standard 
metadata fields.

Custom Metadata
Custom metadata is metadata that cannot be accurately represented in the standard fields. 
Custom metadata fields can be added as bespoke items on a project basis. Custom 
metadata fields can be defined as one of the following types:

• User: A reference to an existing user account on the system.
• Number: Integer.
• Date: Full format date using the system date format.
• Text: Free text up to 4000 characters.
• Timecode: Time in HH:MM:SS:FF format.
• Boolean: Either a 1 or 0.
• Clob: Character large object, used to store large text-based files, for example 

documents.

Contact your SAM representative for information on custom metadata.

Creating and Using Database Search Queries
The search panel enables you to build flexible and complex queries to search for material in 
the database. In Momentum, the simplest query is a single row query as shown in Figure 6-
136: 

Running the above search returns all the objects in the database of type TITLE and which 
contain the word News. For more information on the Momentum Search tool, see the 
section Using the Search Tool, on page 17.

Fig. 6-136:  Defining a Basic Database Search Query
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The first input field is an operator field. In a query composed of just one line, it is inactive. 
From the second row onwards, this field becomes active and enables you to select a logical 
operator. You can use the operators to establish a relationship between the current row and 
the preceding row(s).

The second input field enables you to select the main filter of the condition from the search 
filter drop-down menu:

The filter menu lists all available elements that you can use as a filter for the query. The 
following table lists the most frequently used filters and provides a description of their 
expected results:

Note: Momentum will only return results when the Contains string (for 
example, News in the example above) is included in the metadata types 
Title, Description or Keywords. Momentum does not search across all 
metadata in all schemas.

Fig. 6-137:  Search Tool Filter Menu

Search Filter Drop-
down Menu

Expression Evaluation Drop-
down Menu (Contains, Equals, 
Advanced)

Option Filter Description

Title Searches every kind of element present in the database containing the specified 
value in the metadata Title.

Contains Searches every kind of element present in the database containing the specified 
value in the metadata Title, Description or Keywords.

Kind of Searches for elements of the Genre selected from the drop-down menu. You can 
select from the following Genres: DEFECT, DOCUMENT, KEYSEGMENT, MEDIA_ASSET, 
PROJECT, THUMBNAIL, TIMELINE and TITLE.

Category Searches for elements that have a metadata category of the specified value.

Created by Searches for elements created by a specific user.

Ingest date Searches for elements ingested on a specific day or in a specific span of time.

Creation date Searches for elements created on a specific day or in a specific span of time
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Has tasks: Assigned 
to

Searches for elements that are in Assigned to status associated with a specific user.

Has tasks: 
Assignable to

Searches for elements that are in Assignable to status associated with a specific user.

Has tasks: To do for Searches for elements that are in To do status associated with a specific user.

Materials in project Searches for elements assigned to a specific project.

Ingested on Searches for elements ingested on a specific day or in a specific span of time.

Task Searches for elements that are in one of the following states: Assigned to, Assignable 
to, To do associated to a specific user.

Metadata Searches for elements which have a specific value in a selected metadata field.

Material ID Searches for elements matching a specified full or incomplete material ID.

Child of Searches for elements that are the child of another element.

Parent of Searches for elements that are the parent of another element.

Has instance with 
type

Searches for elements that have an instance matching the specified type.

Has instance with 
label

Searches for elements that have an instance matching the specified label.

Without proxy Searches for elements that don’t have a proxy.

Has Proxy Searches for elements that have a proxy.

Without thumbnails Searches for elements that don’t have thumbnails.

Has thumbnails Searches for elements that have thumbnails.

Has category Searches for elements that have a specific category.

HQ timecode in Searches for elements that have a time code in set to a specific value.

HQ timecode out Searches for elements that have a time code out set to a specific value.

Archive... Searches for elements having the archived metadata fields set to specific values. 
Possible filters are: Building, Floor, Rack, Shelf, Notes, Proavid, Archive Date and Room.

Proxy Id Searches for assets having a relation to a specific proxy ID.

HQ MediaAsset Id Searches for elements having a relation to an HQ having a specific ID.

Has waiting tasks 
on brick

Searches for tasks in waiting status on a specified element.

Has processing 
tasks on brick

Searches for tasks in processing status on a specified element.

Icon id Searches for icons for video material with a specific Icon ID.

Schema Id Searches for elements with a specific metadata schema ID.

Schema name Searches for elements with a specific metadata schema name.

Children count Searches for assets having a relationship with a number of child assets.

Parents count Searches for assets having a relationship with a number of parent assets.

Created by Searches for assets created by a matching operator.

Option Filter Description
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The next input field enables you to set an additional parameter for the main filter. It can be 
a date, a predefined type of object, a string specification or an additional metadata value.

Use the  and  buttons to remove an existing row or to add a new row as shown 
below:

In the example shown in Figure 6-138, the two rows are combined to form a single query. 
The first row states that every element in the database that has an item of metadata named 
Title is a valid query result - the empty value for the Title filter means that all values meet 
the requirements. The second row, using the and operator, adds a condition that the 
element must also have been ingested today. The Search Results table will display all 
elements having Title metadata that have been ingested during the current day.

For more information on the Search Tool and the use of the logical operators (and, or, not, 
and not, or not), see the section Using the Search Tool, on page 17.

The input text field of the values can accept regular expressions as search strings. These 
expressions must be preceded by a backslash ( \ ) character. For example, to search for a 
value of \34d, enter the expression as \\34d, otherwise the original backslash is interpreted 
as an element of the regular expression syntax.

As a rule, if a search string includes one or more of the following special characters, it 
requires a preceding backslash:

• Opening square bracket [
• Backslash \
• Caret ^
• Dollar sign $
• Period .
• Question mark ?
• Pipe symbol |
• Open and close bracket ( )
• Plus sign +
• Asterisk *

Is in projects Searches for assets in a matching project.

Has parent Searches for assets having a matching parent.

Option Filter Description

Fig. 6-138:  A Two Row Query Using the and Operator

Open Logical Operator 
Drop-down Menu

Add Row to Search Query

Remove Row from Search Query
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• Curly bracket, or brace {

Saving a Search Query
After building a complex query, it can be useful to save it for use at a later date. The saved 
queries appear as buttons in the Saved searches area of the Search Tool. 

To save a query:
1 Construct the required query.
2 Click Save... 
3 Enter the name of the query. This is the label of the saved search.

4 Select who can use the query. The Available for drop down lists the following options:
• You - makes the search private: only the user that created it has a button to recall 

this search.
• Everyone - makes the query public: all users can recall this search.
• You and roles - makes the query available for the current user and for users with 

specific roles. Those roles can be selected from a pane that opens when this option 
is selected and on clicking the Add roles button.

Fig. 6-139:  Save Query Pane

Fig. 6-140:  Save Query Add Roles Pane
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• Momentum adds the selected roles (use [ Ctrl ] and click for multiple selections) to 
the Roles list in the Save search pane. To remove a role from the list, click the icon 

 next to the role name.
5 Click Ok to save the query or Cancel to exit without saving.

Reset the Search Query Area
Click Reset to remove all additional rows and return to the default query of one row.

Running a Search Query
To run a start query:

1 Create the required search query or select a saved search query by clicking on the 
related button in the Saved searches area.

2 Click Search.

While the query is running, Momentum displays a Loading message. After retrieving the 
data, the Result area is updated with the new results.

Managing Saved Searches
To manage a saved search query, open the dropdown menu in the saved search label. A 
new menu opens as shown in Figure 6-141:

The dialog reports the status of the search query:
• Public - available for every user
• Private - available only for the current user
• Shared - available to a sub-set of users in a selected role or roles.

Clicking Edit... enables you to modify the search query, for example, you might change the 
name of the search query or assign the query for use by additional roles. as shown in 
Figure 6-142: 

Fig. 6-141:  Managing Saved Searches

Fig. 6-142:  Renaming Saved Searches
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Modify a saved search as follows:
1 Change the name of the search query, if necessary. 
2 Use the then click Save. or click Cancel to retain the original name. drop-down menu to 

assign additional roles or restrict access to the query as required.
3 Click Save to accept your changes.

Select the Delete option to remove a saved query from the Search Tool. You are asked to 
confirm the deletion.

Checking and Selecting Items in the Search Tool 
When you select an item in the search results list, Momentum actively updates the panes of 
the Catalog page with data associated with the last selected item (or the single item if only 
one item is selected.) This includes the detailed metadata for the item, its relationships and 
also, if there is a media player and the item is a video, the player displays the first frame. 
Selecting an item always puts a check in the checkbox. See Section  Actively Selecting 
Items on page 119 for more information.

When you check a checkbox next to an item in the search results, you do not automatically 
select the item, rather this activates the item-specific options in the Actions menu of the 
Search Tool. See Section  Working with Checkboxes on page 119 for more information.

Working with Checkboxes
Clicking an item’s checkbox does not actively select that item. The data for the checked 
item is not automatically displayed in the Details and Relationships panes.

Clicking a checkbox, or several checkboxes, activates the item-specific options in the 
Actions menu (Add to project, Send to, Delete) to act on the checked item(s). You can 
check any number of checkboxes in a list, irrespective of their position in the list.

If your search results span several pages, to check all items on all pages, you need to repeat 
the Select > Checkboxes > All command on every page of the results.

To uncheck checkboxes on all pages, click: Select > Checkboxes > None

Actively Selecting Items
You can actively select items in a list with the mouse cursor using one of the following 
methods:

• [ Click ]: Selects a single item in the list.
• [ Shift ] [ Click ]: Select a range of adjacent items between the first selected item 

and the last item in the range.
• [ Ctrl ] [ Click ]: Select multiple items in a list, irrespective of their position in the 

list.

An actively selected item in a list displays a darker gray background than unselected items 
and is outlined with a blue grid. The data for the selected item (or last selected item for 
multiple selections) is displayed in the panes: Details, Relationships and Player (if possible), 
see the following table.
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Checking and Selecting Items in the Search Tool
You can also select or de-select all items or checkboxes in the results list using the Select 
drop-down menu as shown in Figure 6-143:

• To select all listed items on the displayed page of the Search Tool, use: Select > Items > 
All. 

Note: It is important to note that selecting an item automatically checks its 
checkbox but checking an item does not select it.

Search Item Status Appearance Expected Results

Unselected and 
Unchecked Items

Catalog Data Panes: No Change
Active Actions Menu Options: 
Create, Bulk send to, Export as.

Unselected but 
Checked Items

Note: Checkboxes checked but NO background 
color change

Catalog Panes: No Change
Active Actions Menu Options: 
Create, Add to project, Send to, 
Delete, Bulk send to, Export as.

Selected and 
Checked Items

Note: Dark background color change and blue 
grid lines..

Catalog Panes: 
Last selected item displayed in 
Details, Player and Relationships 
Panes.
Active Actions Menu Options: 
Create, Add to project, Send to, 
Delete, Bulk send to, Export as.

Fig. 6-143:  Options in the Select Menu of the Search Tool 
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• To check all listed items on the displayed page of the Search Tool, use: Select > 
Checkboxes > All.

• To de-select any selected items on all pages of results, use: Select > Items > Nothing 
(None). 

• To uncheck all checked items on all pages of results use: Select > Checkboxes > 
Nothing (None).

Using the Actions Menu on Selected Items
On selecting an item by any method, the full Actions menu becomes available as shown in 
Figure 6-144:

The following options are available in the Actions menu:
• Create: Enables you to create a Title or Project in the database that is 

displayed in the search results, see Section  Creating a Project on 
page 136. (Always active.)

• Add to project: Enables you to add the selected item to a project. (Only active for 
selected item(s).)

• Send to: Lists all Send to elements (by name) available in the existing 
workflows. Selecting an element enables the item to enter a 
workflow using the Send To element as a starting point. (Only 
active for selected item(s).)

• Delete: Removes the selected material from the system. It deletes 
everything related to the selected material including files and 
data structure. Some elements can be deleted only by sending 
them to a Material deletion element or when the user has the 
required permissions. Momentum performs an automatic check 
to verify these conditions prior to deletion and opens a pop-up to 
notify the user. (Only active for selected item(s).)

Fig. 6-144: Options in the Actions Menu of the Search Tool 
121



Using the Catalog Page to Search the Momentum Database
Viewing Media Asset Relationships in the Material Tree Pane
• Bulk send to...: Enables you to upload the Material IDs of all search results to a file 
and select a target workflow to which to send the file. (Always 
active.)

• Export as: Enables you to export the selected item(s) to a file. You can 
choose the desired format of the output file. (Always active.)

Viewing Media Asset Relationships in the Material Tree Pane
The Catalog Material Tree pane displays all existing relationships between the item listed 
in the search results and its associations in the database. A new branch is created for each 
type of existing parent and child relationship, for example   top-level Project, associated 
media assets, titles, key segments, thumbnails, audio tracks, auxiliary files, etc.

Note: The following database elements cannot be deleted using the Delete 
action of the Catalog page: Titles, Media assets, Soundtracks and 
Captions.
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Fig. 6-14
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Using the Catalog Material Tree
Select an item in your Search results to display its associations and relationships in the 
Material Tree, see Figure 6-145.

The icons used in the Material Tree are as follows:

5:  Catalog Material Tree

t Project
HQ Media File 
Containing HQ 
Media Asset with 
Proxy, 8 Audio 
Track & 5 
Thumbnails

ns Menu

 Tasks 
ndow

se Node

nd Node

iner Icon

nail Icon

 File Icon

ck Icon

Refresh Tree 
Data

Project material

 Collapsed media asset container; click to expand.

Expanded media asset container; click to collapse.

Title, media asset, video file material

Key segment material. 
Note: If KeySegments have an InstanceLabel, they are nested under the 
media asset, otherwise they are nested under the real parent node.
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Using the Tasks Menu in the Material Tree
If a folder in the Material Tree contains a large number of items, Momentum displays a More 
button to enable you to review additional items. If necessary, click the Refresh button to 
refresh the data displayed in the Material Tree.

Using the Tasks Menu in the Material Tree
Select an item of material in the Search results, then click Tasks... in the Material tree. 

Thumbnail material; also includes the timecode at which the thumbnail 
was taken in the clip.

Soundtrack material

Picture material

Tape material

sQ material

Proxy status flag, when active shows that an HQ Media asset has an 
associated proxy file.

Caption, Sub-title material

Timeline material

Audio file material

Archived material

Social media material

Attachment / Auxiliary file material

Defective or unidentified material
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Fig. 6-146
This opens a pop-up Task pane in which the tasks are listed by Job ID, see Figure 6-146:

Using the Actions Menu in the Material Tree
The Actions drop-down menu in the Material Tree provides a list of actions that you can 
choose to perform on an item of material selected in the Material Tree. The following 
actions are available:

• Add to project...: Add a selected item of material to an existing project.
• Upload auxiliary file: Upload an auxiliary file (e.g., DOC, TXT, XLS, PDF, etc.) and 

associate with the selected an item of material. 
• Send to...: Lists all Send to elements (by name) available in the 

existing workflows. Selecting an element enables the item 
to enter a workflow using the Send to element as a starting 
point. (Only active for selected item(s).)

: Tasks Pane Accessed from the Material Tree

Tasks Pane Showing Material ID and 
title of the TITLE in the Header
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Project Relationship Details
If the selected item in your search results belongs to one or more projects, the project 
folder and name is displayed as the first item in the tree hierarchy. When you select the 
project in the Material Tree, the Project details are displayed in the Details pane in the 
lower section of the screen, see Figure 6-147.

For each project, the following information is reported:

• Title: Name of the project.

• Description: The content of the Description metadata for the project.

• Keywords: Keywords to describe the project and assist in searches.

• Created by: Name of the user that created the project.

• Creation Date: Date on which the project was created.

. 6-147:  Project Metadata Details 

Metadata for 
Selected Project 
Displayed in 
Details Pane
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• Genre: Identifies the genre to which the project belongs and used 
to define whether a Project can be deleted.

If you select any other element in the Material Tree, the project or projects with which that 
element is associated is displayed as a Projects button at the top-right of the pane, see 
Figure 6-148.

To remove an item in the; Material Tree from a project, select the item then click the 
Projects drop-down menu and select Remove...

Adding an Item to a Project in the Material Tree

To add an item of material to a project using the Material Tree:
1 Select the item in the Material Tree.
2 Select: Actions > Add to Project

This opens the Add to project dialog, listing all available projects.
3 Select the target project from the list of available projects.
4 Click Ok.

6-148: Material Tree - Projects Drop-down Menu

Projects Drop-
down Menu

Selected Media 
Asset in Project 
Original_Material

Option to Remove Item 
from Parent Project
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Media Asset Relationship Details
Any media assets associated with the selected item in the search results appear in the 
Material Tree below the Project branch, if assigned to a parent project, or as the top node if 
unassigned, see Figure 6-150:

Fig. 6-149:  Add to Project Dialog

Fig. 6-150: Media Asset Relationship Details

Select 
Media 
Asset 
Container 
to List All 
Available 
Media 
Assets in 
Details 
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Proxy Status Flag
Quality Control Status of 
Associated Media Asset 
128



Momentum
Operator’s Guide
Momentum reports the following information for each media asset:
• Label: The label used to identify the asset.
• Instance Genre: Instance Genre to which the media asset belongs. Used to sort 

the media assets listed in the Details pane by genre.
• Creation date: Date when the asset was created.
• Timecode IN: The timecode of the start of the media asset.
• Timecode OUT: The timecode of the end of the media asset.

• Width, Height: The dimensions in pixels.
• AR: The aspect ratio.
• FPS: The frame-rate value in frames per second.
• Essence type:  The essence of the related asset.
• Qc Status: The quality check status of the related media asset.
• Qc Report:  Active link to the quality check report on the related media asset.

The proxy status flag can be activated , meaning that the asset has a proxy that you 
can load into the media-player for viewing, or deactivated  when no proxy is available.

To display the detailed metadata for associated children (titles, subtitles, key segments, 
thumbnails, etc.) of the parent media asset, click the item in the Material Tree.

Title Relationship Details
Select a Title node in the Material Tree to report the metadata for the Title in the Details 
pane. The metadata listed is displayed according to the schema specified in the Results 
Config page of the Admin menu. See the section Configuring Search Result Attributes, on 
page 100 for more details.

Select Titles 
Container

Fig. 6-151: Details of Available Titles

Display 
Details of 
Available 
Titles

Select Either Title to Show 
Metadata in Details Pane
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Key Segment Relationship Details
For each Title the following summary data are reported:
• Title: Title text.
• Creation Date: The date on which the Title was created.
• Genre: Genre to which the Title belongs.
• Description: Summary description of the Title.
• Keywords: Keywords to describe the Title and assist in searches.
• Building: Used to identify building in which Title is archived, if used.
• Floor: Used to identify floor on which Title is archived, if used.

Key Segment Relationship Details
Select a Key Segment node in the Material Tree to report the metadata for that item in the 
Details pane as shown in Figure 6-152:

For each key segment the following data are reported:
• Material Id: The specific ID of the key segment, usually the same.
• Instance: The label of the instance parent of the key segment.
• Timecode IN: The timecode of the start of the key segment.
• Timecode OUT: The timecode of the end of the key segment.
• Comment: Any comment text added when creating the key segment.

Thumbnail Relationship Details
Select a Thumbnail node, if available for the selected media asset, in the Material Tree to 
report the metadata for that item in the Details pane as shown in Figure 6-153. 

Fig. 6-152: Key Segment Details 
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You can browse through the thumbnails in this pane to locate specific time-codes. The 
Material Tree reports the total number of thumbnails available for the selected item.

Audio Track Relationship Details
Select an Audio Track node, if available for the selected media asset, in the Material Tree to 
report the metadata for that item in the Details pane as shown in Figure 6-154.

If the selected item is a media asset, the listed tracks are those embedded in the asset. If the 
item is a Title, the listed audio tracks represent audio files ingested separately but linked to 
the Title. The following information is reported for each track:

• #: The number of the track.
• Lang: The language label for the track.
• QCStatus: Reports the result of an Audio Quality Check, if it has taken place 

for the track.
• QCComment: Reports any additional information compiled during the Audio 

Quality Check.

Caption Relationship Details
Select a Caption node, if available for the selected media asset, in the Material Tree to 
report the metadata for that item in the Details pane. The Material Tree lists any captions 
associated with the selected item as shown in Figure 6-155:

Fig. 6-153: Thumbnail Details 

Fig. 6-154:  Audio Track Details 
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Timeline Relationship Details
For each associated caption file the following data are reported:
• Lang: The three letter acronym stating the language of the captions.
• FORMAT: The format of the caption file (e.g., SCC, SRT, etc.)
• PATH: The path containing the caption file.

Timeline Relationship Details
A Timeline icon is displayed in the Material Tree if the selected item belongs to one or more 
project timelines, see Figure 6-156.

For each timeline the following data is reported:
• Title: Name of the timeline.
• Creation Date: Date when the timeline was created.
• Genre: Genre to which the type of timeline belongs.
• Description: Reports a description of the timeline.
• Keywords: Reports any keywords associated with the timeline.
• Status: Reports if a timeline is undergoing processing.

Auxiliary File Relationship Details
Any auxiliary files associated with an item selected in the search results appear as an icon in 
the material tree and when selected, in the Auxiliary files details pane as shown in Figure 6-
157.

Fig. 6-155: Caption Details

Fig. 6-156: Timeline Details 
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An auxiliary file is a generic object associated with a Title and may have any format, for 
example, TXT, PDF, PAC, DOC, DOCX, CSV, XLS. By default, you can upload auxiliary files up 
to a maximum size of 30 MB.

You can use the Material Tree to upload an auxiliary file and associate it with the selected 
item in the search results as follows:

1 Select: Actions > Upload auxiliary file... in the Material Tree pane.
This opens the Upload auxiliary file dialog, shown in Figure 6-158: 

2 Browse to the generic auxiliary file to be associated with the selected Project, media 
asset or title.

3 Select a label from the drop-down menu.
The labels are defined in the XML configuration file:
C:\Mantrics\InstanceLabelsConfig.xml

4 Accept the auto-filled title of the file or overwrite the entry as required.
5 Click Ok to upload and associate the file.

Fig. 6-157: Auxiliary File Details

Note: If necessary, you can increase the default maximum upload size in the IIS 
settings.

Fig. 6-158:  Upload Auxiliary File Dialog 
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Momentum displays a progress bar to show the progress of the file upload as shown in 
Figure 6-159:

On completion, the uploaded file is listed in Material Tree and saved to a remote upload 
folder defined in the XML configuration file in the section 
<AuxiliaryFilesRepository>:
C:\Mantrics\MantricsConfig.xml

Accessing Tasks from the Material Tree
To review any tasks associated with the selected asset, click the Tasks... button in the 
Material Tree pane.

The Tasks pane reports the task history for the selected asset by Job ID.

Tasks are grouped by Jobs and each job can be expanded or collapsed to examine or hide 
the details of the corresponding task. The task lists are populated in real-time according to 
the changes in the workflow.

For each task, the following information is reported:
• Job: Number identifying the Momentum Job to which the associated 

tasks belong.
Click  or  to expand or collapse the tasks in a Job respectively.

• Element: Name of the element that processed or is processing the task. The 
names are active links that open the corresponding Workflow 
page centered on the selected workflow element.

• Element Type: Specifies the type of workflow element that processed the task.

Fig. 6-159:  Progress of Auxiliary File Upload

Upload Progress Status Bar

Fig. 6-160: Catalog Task Pane
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• Agent: Specifies the IP address of the agent node and the name of the 
connecting workflow element 

• Media asset: Active link to the HQ media asset. Click the link to load the 
metadata into the Catalog panes.

• Instance Status: Current status of the instance; used to indicate whether an 
instance is available for further processing. Instance status values 
are: Null, Allocated, FileExists, Playable, Transferable, Complete, 
FullyAvailable. A Playable status indicates that a file being 
ingested is in a suitable state to be worked on. A clip with such a 
status is available for baseband review, creation of new segments 
and making a new copy. A status of FullyAvailable indicates that 
the ingest process has completed.

• Instance Type: Instance type of the media asset, e.g., MomentumInstance, 
SQInstance, DivaInstance, SocialInstance, etc.

• In Date: Specifies when the task arrived at the workflow element.
• Start Date: Specifies the date on which processing of the task began on the 

workflow element.
• End Date: Specifies the date on which the processing of the task ended on 

the workflow element.
• Status: Reports the status of the task at the workflow element 

(completed, waiting, stopped, reconnecting.)
• Result: Reports the port used by the task to exit the workflow element.
• Remark: Provides additional information related to the result.

From the Tasks pane, you can choose to export the tasks list in CSV format by clicking 
Export CSV... and entering a name for the file. Click Ok to close the window.

Working with Projects
A Project is a collection of user-selected materials. You can use a project to group any kind 
of material which then provides an easy way to find related elements in the database. Any 
material (even a project) can be part of one or more projects.

You can use the Search Tool to locate projects in the database. Any material belonging to 
the selected project is listed in the Relationships tabs below the Details pane of the Catalog 
page.

If a material is part of a project, then the project name appears in the Parents tab of the 
Relationships pane.

The list of projects to which an element is assigned is a specific metadata element that can 
be viewed in the Details pane and/or in the Search Results of the Catalog page (see the 

Note: Any customizations made to the appearance of the Tasks pane (e.g., size 
or order of the columns) are saved for each user that logs on to the 
system from a specific client machine.
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sections Customizing Metadata Schemas Using Metadata Masks, on page 96 or Configuring 
Search Result Attributes, on page 100 for more details).

Creating a Project
To create a project:

From the Results pane in the Catalog page:
1 Select: Actions > Create... > Project 
2 In the Create project... dialog enter a Title and Description for the new project, see 

Figure 6-161.: 

3 Click Ok to add the project.

Deleting a Project
To delete a project:

1 Locate the project using the Search Tool.
2 Click the project in the search results to select and activate it.
3 Select Actions > Delete... 

Adding Material to a Project
Any kind of object in the Momentum database can be included in a project. 

To add an object to a project:
1 Locate the material using the Search Tool.
2 Click the desired material in the search results to select and activate it.
3 Select Actions > Add to project... 
4 Select the target project in the displayed list.
5 Click Ok to add the material.

Removing Material from a Project
To remove an item of material from a specific project:

1 Locate the material using the Search Tool.

Fig. 6-161:  Create Project Dialog
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2 Open the Is in Project tab in the Relationships pane.
3 Click the Delete icon  associated with the item of material.

The material is removed from the parent project.
137



Using the Catalog Page to Search the Momentum Database
Removing Material from a Project
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Creating Content in the Logger Page
Using the Logger Page to Create Key Segments
The Logger page enables you to create new key segments from existing material, see 
Figure 7-162. Key segments can be objects of a query in a Search tool but they are not new 
media files; a key segment simply references a specific segment of the parent media file.

The Logger Page contains the following areas:
• Search Pane: Enables you to find relevant material.
• Segmentation Tool: Player used to create key segments and also to edit the 

associated metadata, as required.

Fig. 7-162: Overview of the Logger Page
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Segmentation Tool Key Segments Pane
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The Segmentation Tool
• Key Segments Pane: Lists all of the key segments associated with the selected 
material and enables you to export the related data in an 
XML format file.

The Segmentation Tool
The Segmentation Tool enables you to create new key segments by marking the 
timecode-in and timecode-out of new segments. In addition, you can also edit timecode-in 
and timecode-out values of existing key segments.

Fig. 7-163:  Logger Segmentation Tool 
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Fig. 7-164:  Logger Segmentation Tool Control Panel 
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Below the current frame are the Set mark in and Set mark out controls, see Figure 7-165:

Hovering over a frame on the timeline displays a thumbnail for that frame.

After setting your mark in and mark out points, use the Create key segment button 
, to create a new key segment. In addition, you can use the Display whole title 

button , to return to the parent clip from the key segment.

You can use the Seek last seconds pane to move the playback head to a set number of 
seconds before the end of a clip or a segment, see Figure 7-166:

To start playing a clip at a pre-selected number of seconds before the end:
1 Enter the required number in the input field or use the Increase and Decrease buttons 

to reach the correct value.
2 Click the Seek button. The playback head moves to the required timecode.
3 Click the Play button of the Segmentation Tool controls. 

If the player is already running the clip this step is not required.

Below the timeline slider, are the playback controls. There are three pairs of buttons more 
than available in a standard Player pane.

The Go to mark in and Go to mark out buttons move the playback head to the Mark In or 
Mark Out point in the timeline.

The Rewind and the Fast forward buttons enable you to change the playback speed. 
When you click either of these buttons, a message on the player reports the actual speed of 
the playback.

The Go to start and Go to end buttons enable you to display the start or end of the key 
segment, see Figure 7-164.

Some playback functions have keyboard shortcuts as follows:
• j - Single press: one frame back.

Prolonged press: Rewind x 8 speed.
• k - Play / Pause toggle.
• l - Single press: one frame forward.

Fig. 7-165:  Logger Segmentation Tool: Set mark in and Set mark out Controls 

Fig. 7-166:  Segmentation Tool - Seek Last Seconds

Fig. 7-167:  Segmentation Tool Buttons: Go to mark in and Go to mark out

Fig. 7-168:  Segmentation Tool Buttons: Rewind and Fast Forward
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Prolonged press: Fast Forward x 8 speed.
• Spacebar - Play / Pause toggle.

Using the Tracks Menu to Change the Media Player Controller
The View section of the Tracks menu displays a list of all media player controllers currently 
available to Momentum, including:

• Proxy Player
• Go Player
• ImagePlayer

This menu provides the ability to review any media from the Catalog by assigning 
permission to switch viewing between Proxy and GoPlayer or ImagePlayer. You can 
select the most appropriate player for the selected media asset. In the event that the 
selected media asset cannot be played by a specific player controller, its corresponding 
item in the View menu is disabled and cannot be selected.

For more information on the Tracks menu, see the section Media Players, on page 12.

Creating a Key Segment
To create a new key segment:

1 In the Logger page, use the Search Tool to select an item of material of type TITLE. 
When the material is selected, the player displays the first frame of the file. The area 
below the player controls displays the metadata related to the selected material, and 
the key segments area lists any existing key segments for the selected material.

2 In the Segmentation Tool, set the mark-in point of the new key segment. 
When a frame is marked as the start point of a segment, a Square marker highlights its 
position on the timeline slider. 
You can create a Start point for a key segment as follows:

a Use the playback controls of the Segmentation Tool or drag the playback head to 
the desired first frame, then click Set mark in . The field next to the icon 
populates with the value of the start timecode.

b Enter or select the correct timecode value, if already known, in the Edit Timecode 
dialog. To do so, click the input field next to the Set mark in icon. This opens the 
Edit Timecode dialog where you can enter the timecode. Click Save to save the 
value or Cancel to exit without saving.

Fig. 7-169:  Tracks View Menu Expanded
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3 In the Segmentation Tool, set the mark-out point of the new key-segment. 
When a frame is marked as an end-point of a segment, a square marker highlights its 
position on the timeline slider. You can create a End point as follows:

• Use the playback controls of the Segmentation Tool or drag the playback head to 
the desired last frame, then click Set mark out . The field next to the icon 
populates with the value of the end timecode.

• Enter or select the correct timecode value, if already known, in the Edit Timecode 
dialog. To do so, click the input field next to the Set mark out icon. This opens the 
Edit Timecode dialog where you can enter the timecode. Click Save to save the 
value or Cancel to exit without saving.

4 Click Create key segment .
5 Enter a description or a title for the new key segment in the Comment dialog, see 

Figure 7-170.

Click Ok to save the key segment or Cancel to exit without saving.

On creating a new segment, a new row appears in the Key segments pane. For each key 
segment created, Momentum generates a thumbnail using the frame set at the mark-in 
point, to help identify the segment in the Results lists of the search tool.

Managing Key Segments
The key segments appear in table of the Key Segments pane which displays the following 
information:

• Segment Number: Progressive number identifying each segment.
• Material ID: Material ID of the segment.
• Timecode IN: Start timecode of the segment.
• Timecode OUT: End timecode of the segment.
• Duration: Calculated duration of the segment.
• Comment: Title or description entered when creating the segment.
• Edit Segment: Icon to edit the segment comment or description.
• Delete Segment: Icon to delete the selected segment.

Key Segment Playback
To playback a key segment:

1 Click on the relevant row of the Key segments table to select a key segment. 

Fig. 7-170:  Logger Page - Key Segment Comment
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The playback head moves to the start point of the selected segment. The Start and End 
points are now marked on the timeline. The Switch to parent clip button  is 
also activated.

2 Click the Play button on the Segmentation tool controls. 

The playback ends when the mark-out endpoint is reached.

Modifying the Length of a Key Segment
To change the Start and/or End point of a key segment:

1 In the Key segments pane, select a segment. 
2 Use the Segmentation tool to locate the desired frame.
3 Mark the frame as start point or end point as required by clicking Set mark in  or 

Set mark out .

The content of the Segmentation Tool and the Key Segments pane is updated to reflect the 
length of the new segment.

Editing a Key Segment Comment
The Key segments pane can contain comments about the key segment. To modify a 
existing comment:

1 Click the Edit segment icon:  
This enables the Comment field for editing, see Figure 7-172. 

2 Enter the required description for the segment.

Note: When a segment is selected, the Segmentation tool enters a special 
playback mode, that is limited to the frames of the segment. To edit and 
playback the entire parent clip, use the Switch to parent clip button 

.

Fig. 7-171:  Logger Page Editing a Timecode

Fig. 7-172:  Logger Page - Editing a Comment Field
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3 Press Enter or click anywhere outside the Comment field to exit the editing function.

Deleting a Key Segment
To delete a key segment, click the Delete icon  and confirm the deletion.

Overlapping Key Segments
It is possible for two segments to overlap. Momentum checks for this occurrence and 
highlights the overlapping segments, see Figure 7-173

While there is an overlap, it is not possible to export or save the file, you will need to resolve 
the overlap conflict. An error message is displayed to warn you that some key segments are 
overlapping, see Figure 7-174.

To export the file, change the Start and/or End point of one of the key segments to prevent 
the overlap. 

Exporting the Segmentation Timeline
You can export the key segment information to an XML file stored in the download folder of 
the browser.

To export the segmentation timeline:
1 Click the  button at the top left corner of the Key segments pane.
2 Retrieve the exported file from the download folder of your browser.

Fig. 7-173:  Logger Page - Overlapping Segments

Overlapping 
Segments

Fig. 7-174:  Logger Page Export Failed Due to Overlapping segments
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Restoring Key Segments from Archived Files
If using Oracle / Front Porch Digital Diva to archive video contents, the  button 
is available in the Key segments pane. 

You can use the Partial Restore function to create a new title from a title in the archive, 
making the content of the new title the same as a selected key segment tagged on the 
archived material. 

To perform a partial restore from an archive:
1 Click the  button.

This opens the Partial restore dialog, see Figure 7-175.

The Target field is a drop-down from which you can select one of the Partial Restore 
elements active in your workflows. 

2 Choose the desired target archive from the drop-down list, then select one or more of 
the available key segments. 

3 Click Restore.
This sends a task to the target workflow element to render the selected key segment. 
On completion of a successful partial restore, you should see the following message 
displayed:

Fig. 7-175: Partial Restore of Key Segments

Fig. 7-176: Successful Partial Restore of Key Segments
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Using External Editing Tools with Momentum
You can also integrate Momentum with more powerful external editors, such as products in 
the Grass Valley Go! or sQ range of editors, depending on your editing requirements.

A page embedded in the sQ browser enables you to query the Momentum database and 
then drag and drop a clip from the Momentum search result into sQ using SoftMount. After 
editing the material, you can then save the changed material in the external editor back to 
the Momentum database. An sQ seat enabled with WebTools is required for this purpose.

For further information, see the documentation supplied with your editor.

Fig. 7-177: Linking to the Momentum Catalog Search Tool from an External Editor
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Working with User Tasks in the To Do Page
Overview
The To Do page provides an interface for the Momentum operator to accept and complete 
tasks requiring user actions so that the task can continue to progress through the workflow. 
Momentum reports all actions that need to be completed by the currently logged in user in 
the To Do page.

As an operator, you can choose to switch the view of the To Do page between a Materials-
based view or a Tasks-based view using the To Do drop-down menu, see Figure 8-178.

The default view of the To Do page is set in the configuration file: 
C:\Mantrics\MantricsConfig.xml by setting the tag <DefaultToDoViewType> to 
materials or tasks (case-sensitive).

Fig. 8-178: To Do Page - Drop-down Menu
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Working with User Tasks in the To Do Page
Overview
The To Do Materials view includes the following components:
• View drop-down: Enables you to switch the view of the To Do page between 

Materials and Tasks.
• Player pane: Enables you to play out material.
• Search tool: Enables you to define complex queries to search for 

relevant material.
• Search results pane: Displays the results matching the material search query.
• Details pane: Enables you to view and edit the metadata of the selected 

material.
• Actions pane: Enables you to take actions relating to the selected 

material.
• Relationships pane: Reports all the associations (parents, children, etc.) of the 

selected material in several tabs. These tabs are 
dynamically created and each one reports a specific 

Fig. 8-179:  To Do Page - Materials View
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Fig. 8-18
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relationship with the selected material, as a result, the 
aspect of this pane changes depending on the 
characteristics of the selected element.

• The To Do Tasks view includes the following components:

• View drop-down: Enables you to switch the view of the To Do page 
between Materials and Tasks.

• Player pane: Enables you to play out material.

• Task tabs: Enable you to switch between To Do tasks, Taken 
tasks, and Task History. Each tab displays the number 
of tasks in that category.

• Task search tool: Enables you to search available tasks by Material ID.

0:  To Do Page - Tasks View
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• Search results pane: Displays the tasks associated with the matching Mate-
rial ID.

• Material tree: Displays the various material components associated 
with the selected task.

• Details pane: Displays the detailed metadata of the selected mate-
rial.

• Actions pane: Enables users to make decisions about the material in 
the workflow.

• Task pop-up: Depending on the status of the task either enables you 
to take a task, or provides further information on the 
selected task.

• Relationships pane: Reports all the associations (parents, children, etc.) of 
the element selected in the Material Tree, using sev-
eral tabs. The tabs are dynamically created and each 
one reports a specific relationship with the selected 
material, as a result, the aspect of this pane changes 
depending on the characteristics of the selected ele-
ment.

• Task information bar: Displays the Material ID of the selected task. provides 
a To Do button to display the Task pop-up and enables 
you to view the workflow element generating the task 
in the Workflow page.

• Task completion pane: For Taken tasks, displays the Release and Complete 
buttons enabling you either to release a task to be 
taken by another user or to complete the task by 
entering a report comment.

Using the Search Tool
The Search Tool in the To Do page Materials view, enables you to define complex search 
queries to search for material with associated tasks requiring manual user intervention.

You can use the search tool in the same way as in other panes by creating search queries 
and saving favorite searches for later use.

For more information on the Search Tool, see the section Using the Search Tool, on page 17.

Resolving User Tasks
When required, you can accept and take control of a task using the Actions pane (in the 
Materials view see Figure 8-181) or from the To Do Tasks tab (in the Tasks view):
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The User Action task displays the date and time at which the task was created.

To log the beginning of the action, click the Take button. The corresponding task in the 
Workflow page is displayed with the status In Processing.

The available actions now appear on the Actions pane as shown in the example below:

The manual action required to resolve the manual user action is defined in the settings of 
the User action workflow element, see the Configuration Guide for details.

Perform the required manual operation on the assigned task, click OK, enter a report 
comment and click Ok again.

Momentum records your action, updating the database with the report comment, and the 
date and time of the action itself. The material is removed from the To Do list, and the 
content’s history is updated with the operator’s report and extra notes, if available.

The task itself now progresses to the next step in the workflow.

When the user has the correct permissions, the View in workflow icon  appears on the 
action header bar. Click on this icon to display the Workflow page and focus on the 
workflow element at which the task is pending.

When you take a waiting task, from the To Do Tasks tab of the Tasks view, the panel 
switches to the Taken Tasks tab and re-selects the task you have just taken that should 
now be in processing status. When you either Release or Complete a taken task, the Tasks 
panel reacts as follows:

• If there are still taken tasks available, Momentum continues to display the Taken Tasks 
tab but de-selects all tasks.

Fig. 8-181:  Viewing Unassigned Actions in the Actions Pane

Click Take to Accept the 
Manual User Task

View in Workflow

Refresh

Fig. 8-182:  Completing a Manual User Action 
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• If there are no more taken tasks Taken Tasks tab, Momentum switches back to the To 
Do Tasks tab and de-selects all tasks.

Resolving Audio QC Actions
If the name of a User Action element in a workflow begins with the words Audio QC, the 
Actions pane contains a special Audio QC button as shown below:

Click this button to open the Audio QC page as shown below:

Using this page, you can select and review audio tracks and also create a list of possible 
defects for each track.

Fig. 8-183:  Actions Pane Audio QC Button

Fig. 8-184:  Audio QC Page
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Creating an Audio Defect Report
On the left side of the page, a media player enables you to select a track and then create a 
defect report.

To create a defect report:
1 Mark a start point and an end point using the player.
2 Click the Create defect button . The following dialog appears:

The Timecode in and Timecode out values are already populated.
3 Specify a Defect code from the drop-down list as shown below:

4 Add a Comment if required.
5 Click OK. The new defect is added to the list on the right side, below the list of available 

tracks as shown below:

Fig. 8-185:  Audio QC Create Defect Pane

Fig. 8-186:  Actions Pane Audio QC Button
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Use the edit icon  to make changes to the defect report.

To delete a defect report, click the Delete icon .

Audio Track Information
In the upper right area of the Audio Tracks pane, Momentum lists the available tracks. The 
following information is available for each entry:

• #: Number of the track.
• LANGUAGE: Audio track label (usually the language).
• QC Status: Reports whether the track still needs to be reviewed or if it has 

already been checked.
• QC Comment: Contains any QC comments.
• Edit icon : Enables you to set the QC status and add QC comments if 

necessary.

Viewing Media Asset Relationships (Materials View)
The Relationships pane in the Materials view of the To Do page displays all existing 
relationships between the item listed in the search results and its associations in the 
database. A new tab is created for each type of existing relationship, for example parent 
and child relationships, associated key segments or thumbnails, auxiliary files, etc.

Fig. 8-187:  Audio QC Defect List
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Relationships Pane - Auxiliary Files Tab
Any auxiliary files associated with an item selected in the search results appear in an 
Auxiliary files tab as shown in Figure 8-188.

An auxiliary file is a generic object associated with a Title and may have any format, for 
example, TXT, PDF, PAC, DOC, DOCX, CSV, XLS. By default, you can upload auxiliary files up 
to a maximum size of 30 MB.

You can use this screen to upload an auxiliary file and associate it with the selected item in 
the search results as follows:

1 Click .
This opens the Upload auxiliary file dialog, shown in Figure 8-189:

2 Browse to the generic auxiliary file to be associated with the selected Title.
3 Select a label from the drop-down menu.

The labels are defined in the XML configuration file:
C:\Mantrics\InstanceLabelsConfig.xml

4 Accept the auto-filled title of the file or overwrite the entry as required.
5 Click Ok to upload and associate the file.

Momentum displays a progress bar to show the progress of the file upload as shown in 
Figure 8-190. 

Fig. 8-188:  Relationships - Auxiliary Files Tab 

Note: If necessary, you can increase the default maximum upload size in the IIS 
settings.

Fig. 8-189:  Upload Auxiliary File Dialog 
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On completion, the uploaded file is listed in the Auxiliary Files tab of the Catalog page 
and saved to a remote upload folder defined in the XML configuration file:
C:\Mantrics\MantricsConfig.xml

Relationships Pane - Media Assets Tab
Any media assets which are associated with the selected item in the search results appear 
in a Media Assets tab as shown in Figure 8-191:

Momentum reports the following information for each media asset:
• Label: The label used to identify the asset.
• Creation date: The date when the asset was created.
• Timecode IN: The timecode of the start of the media asset.
• Timecode OUT: The timecode of he end of the media asset.
• Width, Height: The dimensions in pixels.
• AR: The aspect ratio.
• FPS: The frame-rate value in frames per second.
• Essence type:  The essence of the related asset.
• Qc Status: The quality check status of the related asset, highlighted in 

Figure 8-191.
• Qc Report:  Active link to the quality check report on the related asset, 

highlighted in Figure 8-191.

Fig. 8-190:  Progress of Auxiliary File Upload

Upload Progress Status Bar

Fig. 8-191:  Relationships - Media Assets Tab 

Click to Display Asset Metadata 
Details

Proxy Status Flag

Quality Control Status of 
Associated Asset 
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Click the Details icon (  ) to load the metadata of the selected asset into the Details 
pane. It is also set as the current material and the Relationships pane is updated to show the 
relationships of the selected asset.

The proxy status flag can be activated , meaning that the asset has a proxy that you 
can load into the media-player for viewing, or deactivated  when no proxy is available.

Relationships Pane - Thumbnails Tab
The Thumbnails tab is available only when thumbnails are available for the selected item.

You can browse through the thumbnails in this pane to locate specific time-codes. The 
header of the tab reports the total number of thumbnails available for the selected item.

Relationships Pane - Audio Tracks Tab
The Audio Tracks tab reports any audio tracks related to the selected item as shown in 
Figure 8-193: 

If the selected item is a media asset, the listed tracks are those embedded in the asset. If the 
item is a TITLE, the listed audio tracks represent audio files ingested separately but linked to 
the TITLE. The following information is reported for each track:

• #: The number of the track.

Note: Displaying the asset details using  does not modify the Search tool 
and its results list.

Fig. 8-192:  Relationships - Thumbnails Tab 

Fig. 8-193:  Relationships - Audio Tracks Tab 
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• Lang: The language label for the track.
• QCStatus: Reports the result of an Audio Quality Check, if it has taken place 

for the track.
• QCComment: Reports any additional information compiled during the Audio 

Quality Check.

Relationships Pane - Captions Tab
The Captions tab reports any captions associated with the selected item as shown in 
Figure 8-194: 

For each associated caption file the following data are reported:
• Lang: The three letter acronym stating the language of the captions.
• FORMAT: The format of the caption file (e.g., SCC, SRT, etc.)
• PATH: The path containing the caption file.

Relationships Pane - Key Segments Tab
The Key segments tab reports the segmentation of the related Title as shown in Figure 8-
195:

For each key segment the following data are reported:
• Material Id: The specific ID of the key segment, usually the same.
• Instance: The label of the instance parent of the key segment.
• Timecode IN: The timecode of the start of the key segment.
• Timecode OUT: The timecode of the end of the key segment.
• Comment: Any comment text added when creating the key segment.

Fig. 8-194:  Relationships - Captions Tab 

Fig. 8-195:  Relationships - Key Segments Tab 
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Relationships Pane - Tasks Tab
The Tasks tab reports the task history for the selected item by Job ID.

Tasks are grouped by Jobs and each job can be expanded or collapsed to examine or hide 
the details of the corresponding task. The task lists are populated in real-time according to 
the changes in the workflow.

For each task, the following information is reported:
• Job: Number identifying the Momentum Job to which the associated 

tasks belong.
Click  or  to expand or collapse the tasks in a Job respectively.

• Element: Name of the element that processed or is processing the task. The 
names are active links that open the corresponding Workflow 
page centered on the selected workflow element.

• Element Type: Specifies the type of workflow element that processed the task.
• Agent: Specifies the IP address of the agent node and the name of the 

connecting workflow element 
• Media asset: Active link to the HQ media asset. Click the link to load the 

metadata into the Catalog panes.
• In Date: Specifies when the task arrived at the workflow element.
• Start Date: Specifies the date on which processing of the task began on the 

workflow element.
• End Date: Specifies the date on which the processing of the task ended on 

the workflow element.
• Status: Reports the status of the task at the workflow element 

(completed, waiting, stopped, reconnecting.)
• Result: Reports the port used by the task to exit the workflow element.
• Remark: Provides additional information related to the result.

Fig. 8-196:  Relationships - Tasks Tab 

Click to Open Tasks Tab in 
Expanded Standalone Window 

Note: Any customizations made to the appearance of the Tasks table in the tab 
(e.g., size or order of the columns) are saved for each user that logs on to 
the system from a specific client machine.
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You can open the Tasks table in a separate window for an expanded view by clicking the 
Open in window button as shown in Figure 8-197:

From this window, you can choose to export the tasks list in CSV format by clicking Export 
CSV... and entering a name for the file. Click Ok to close the window.

Relationships Pane - Title Tab
The Title tab reports metadata on the Title parent of the media asset. The metadata listed is 
displayed according to the schema specified in the Results Config page of the Admin 
menu. See Configuring Search Result Attributes for more details.

Relationships Pane - Project Tab
The Projects tab is available if the selected item belongs to one or more projects.

For each project, the following information is reported:
• Title: Name of the project.
• Description: The content of the Description metadata for the project.
• Created by: Name of the user that created the project.
• Children Count: The type and number of items contained in the project.

The Delete from project icon  enables you to remove the item from the project.

Fig. 8-197:  Relationships Tasks in Expanded Standalone Window

Fig. 8-198:  Relationships - Project Tab 
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Relationships Pane - Timeline Tab
The Timeline tab is displayed if the selected item belongs to one or more project timelines.

For each timeline the following data is reported:
• Title: Name of the timeline.
• Creation Date: Date when the timeline was created.
• Genre: Genre to which the type of timeline belongs.
• Description: Reports a description of the timeline.
• Keywords: Reports any keywords associated with the timeline.
• Status: Reports if a timeline is undergoing processing.

Fig. 8-199:  Relationships - Timeline Tab 
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Publishing to Social Media Sites
Overview
Momentum provides a suite of workflow elements that enable you to connect to the social 
media websites Facebook and Twitter either to publish or to remove material.

The available elements are:
• Publish to Dailymotion
• Publish to Facebook
• Publish to Twitter
• Publish toYoutube
• Remove from Dailymotion
• Remove from Facebook
• Remove from Twitter
• Remove from Youtube

Before setting-up the social media workflow elements, you need to register the target 
social media sites in the Momentum Admin page: Social.

Registering Target Sites
Register a target Twitter site in Momentum for the publishing and/or removal of material as 
follows:

1 Select: Admin > Social.
This opens the Admin Social Network page, see Figure 9-200.

Note: The social media site setup page is available only to those users assigned 
the role Has_Adm in_Page.
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2 Select Facebook or Twitter in the Social Network pane.
3 Click Add new Target to add a new target social media site.

Momentum prompts you to register the target site and provides a login button to 
Twitter or Facebook:

4 Click either Twitter Login or Facebook Login, as appropriate and enter your account 
credentials.

5 Follow the prompts to register the site.
Momentum adds the site to the list of registered target social media sites. You can now 
select the site in the Target drop-down menu when configuring the social media 
workflow elements, see Section .

0: Social Network Admin Page 

Registered Target 
Twitter Site

Registered Target 
Twitter Site

Fig. 9-201: Facebook Login Prompt
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Configuring the Social Media Workflow Elements
Once you have set-up your targetsocial media sites in the Admin pages, you can start to 
include the social media elements in your workflows.

Momentum provides a number of workflow elements to interact with various social media 
sites. These elements are available from the Workflow page in the elements folder: 
Automation > Social, see Figure 9-202.

For each of these elements, the  communication parameters for the social media sites are 
configured  in the configuration files: MantricsServer.xml and MantricsNode.xml.

See the Momentum Configuration Guide for details on configuring the individual workflow 
elements.

Fig. 9-202: Social Media Workflow Elements 

Social Media Workflow 
Elements
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Task Monitoring and Statistics
Overview
Momentum contains the following sources of information about the system that can be 
used to monitor the progress of tasks through a workflow and to report statistics related to 
task processing times:

• Workflow page: Displays the movement of the tasks along a workflow. It also 
provides information about each task and the task processing 
history of each element and enables you to interact with tasks to 
modify the task status or change its priority. See Section 3.6 
Working with Task Actions and Task Statuses on page 51.

• Catalog page: Contains a tasks history which contains all of the tasks for all jobs 
related to a specific item of material. See Viewing Media Asset 
Relationships in the Material Tree Pane, on page 122.

• Dashboard: Enables you to monitor the status of running workflow jobs and 
associated tasks. Note: This page is only available to roles 
assigned the permission: Has_Dashboard_Page.

• Services page: Contains status information for the Momentum Nodes.
• Stats page: Shows usage graphs for a wide range of workflow components.
• Logs page: Contains warning and error information.
• About page: Contains information about the Momentum version, connected 

users and any configured licenses.
• Transfers page: Enables you to monitor the status of content transfer requests, 

sent to Momentum from a Morpheus system by way of a BXF 
transfer request message. The Transfers page lists all transfer 
requests currently managed by the Momentum system. Note: 
This page is only available to roles assigned the permission: 
Has_Transfers_Page.

• Schedules page: Enables you to import schedule files into Momentum. Once 
imported, you can manipulate schedule data to filter the view by 
channel, schedule file, presence of material in database, 
occurrence or occurrences of material, or include expired 
schedules. In addition, you can export schedule data in CSV or 
XML format. Note: This page is only available to roles assigned the 
permission: Has_Schedules_Page.
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Using the Workflow Page
Each workflow element in a workflow records the history of its tasks. This can be a powerful 
tool for analyzing what has happened in a workflow over a specific length of time.

Task History
To review the tasks history of a specific element:

1 In the Workflow page, select the required element.
2 Double click on the body of the element. A dialog opens which displays the 

configuration settings for that element.
3 On the left-hand side of the pane, click the Tasks button.
4 Click the History tab.

5 Retrieve the required information about specific tasks and materials.

Fig. 10-203:  Tasks History of a Watchfolder Workflow Element
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Current Tasks And Task Actions
The Workflow page also contains information about the tasks which are currently running.

Selecting a Task
To select a task to view:

1 In the Workflow page, select the required workflow element.
2 Double click the body of the workflow element.

A dialog opens to display the configuration settings of the workflow element.

3 Select Tasks from the menu on the left-hand side of the pane.
4 Click the Waiting / Stopped or Processing / Reconnecting tabs, see Figure 10-204 

and Figure 10-205.

Note: You can browse the list of tasks using the navigation bar at the bottom 
of the pane and the scroll bar on the right-hand side. The M aterial ID , 
M edia Asset and Job fields are active links that open the Catalog page 
or Dashboard page as appropriate. The M aterial ID  and M edia Asset 
links to the Catalog page automatically open a search targeting the 
selected material for the available metadata. The Job link to the 
Dashboard page provides an overview of the whole workflow job and 
provides active links to the starting element, the M aterial ID  in a 
Catalog page and to the active tasks in the Workflow page.

Note: Alternatively, you can also double-click the status indicator displayed 
above a workflow element. This opens a dialog listing all current tasks in 
that status.
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5 Retrieve the required information about the tasks. if a task is currently in Processing, a 
percentage value of the work completed is displayed in the Remark field.

Performing Task Actions
To change the status of a task, change its priority or move the task onto another element:

1 Double-click the specific task of interest, or use the Select drop-down menu to select 
multiple items.
When you select a task, the task frame is outlined in blue and its associated checkbox is 
checked.
The Actions drop-down menu becomes active for he selected task(s).

2 Use the options in the Actions menu to manage the task.

Fig. 10-204:  Workflow Element Processing/Reconnecting Tasks Tab

Fig. 10-205:  Workflow Element Waiting/Stopped Tasks Tab
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You can take the following actions, depending on the current status of the task:
• Resume: Resume a task in stopped or waiting status.
• Stop: Stop a task in processing or waiting status.
• Change priority: Change the priority of individual tasks, or the entire job. You 

can select from: low, medium, high, urgent, or immediate.
• Skip to: Progress the task to one of the available ports without 

completing the current task, in order to move directly to 
another element or to exit the workflow.

For more information on the Actions menu, see Section 3.6.2 Performing Task Actions 
on page 53.

3 On completion close the dialog box.

Monitoring Processing Statistics for a Workflow Element 
Each workflow element on the canvas includes a Statistics tab, which displays a graphical 
report of the time that the element needed to process each task. Double-click a workflow 
element and select the Statistics option from the left-hand menu to display this dialog 
box.

You can use the Statistics tab to set a target time threshold for the processing of the task on 
that element, and set the element to generate an alert email if the threshold is exceeded.

The Statistics graph is structured as follows:
• X-axis: Displays the duration of the material related to each task.
• Y-axis: Reports the time needed to process the task.

Fig. 10-206:  Processing Statistics for a Workflow Element
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• Trend: Dashed line represents the trend of the distribution of the tasks.
• Alert Threshold: Solid black line with two circular handles - represents the current 

alarm threshold. You can change the position of the threshold by 
re-positioning either of the handles along the outer frame of the 
grid.

• Acceptable Area: Light-gray area includes all the tasks that are completed within 
the alert threshold.

• Green spots: Represent the tasks that are processed in a time within the 
acceptable threshold.

• Red spots: Represent the tasks that are processed in a time outside the area 
delimited by the alert threshold. If the active alerts option These 
require an alert message, if the option is active.

You can zoom (using the mouse wheel) or pan the canvas of the graph (by clicking and 
dragging the cursor) to change your view of the graph.

To Set Up Alerts on an Element
To activate the monitoring feature to generate alerts on unacceptable task processing 
times:

1 Select the Active Alerts checkbox.
2 Set an alert threshold by hovering the cursor over the black threshold line or either of 

its handles then click and drag to reach the desired values. 
When the new position is reached, the light area changes so that tasks included within 
the acceptable area change to a green color, showing that no alert message is 
generated for them. In the same way, the tasks that fall outside the threshold change to 
a red color, signaling that a mail alert needs to be sent for tasks having similar values.

3 Click Save to store the new settings, or Reset to frame all data available into the graph 
and reset the threshold line to its initial position.

Note: The Alert email to be generated when a threshold is exceeded is 
configured in the section <Alarm s> - <taskProcesingThreshold> of 
the file C:\M antrics\M antricsServer.xm l, see Figure 10-207

Fig. 10-207:  Alerts Configuration in Alarms Section of MantricsServer.xml
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Monitoring Tasks from the Catalog Page
The Relationships pane of the Catalog page contains displays a Tasks tab (Has n Tasks) if 
the selected material has any tasks being processed through the workflow. This tab lists all 
the tasks (by job number) which are related to the selected material.

1 Open the Tasks tab in the Relationships pane.

2 Click Open in window. 
The Material /Title dialog opens in a standalone window, listing the current tasks for 
the selected material as shown in Figure 10-209:

3 Click the element name link in the Element column to open a Workflow page in a new 
tab, centered on the selected element.
In this view, tasks are grouped by Jobs and each job can be collapsed or expanded for 
clarity. Color tags, if configured, are shown next to the name of each workflow element. 
The following data is displayed for each element in a job:

• Element: Name of the element (with active link.)
• Element Type: Specifies the type of the element.
• Agent: IP address and description of the agent node processing the task.
• Media asset: Media asset submitted for a task on a particular element (with 

active link.)
• In Date: Time and date when the task entered the element.
• Start Date: Time and date when the task started the processing on the 

element.
• End Date: Time and date when the task processing was completed.

Fig. 10-208:  Catalog Page - Relationships Pane - Tasks Tab

Fig. 10-209:  Catalog Page - Tasks Tab Pane in Window View
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• Status: Status of the task on the related element.
• Result: Out port used to move the task out of the element to the next 

element in the workflow.
• Remark: Reasons for the use of out port reported into the Result field.

Using the Dashboard for Task Monitoring
The Dashboard page enables you to monitor the progress of the workflows and associated 
tasks created in the Workflow page.

The main Dashboard area displays the information available on the current jobs in a table. 
The Dashboard reports the following items:

Jobs
The set of tasks performed by a group of connected workflow elements on the available 
material is defined as a job. In the Dashboard, each job is represented by a row and includes 
the following information:

• Job ID: Reports the ID number assigned to the job.
• Job: Sequential number assigned to the job in the order of 

processing.
• Starting Element: First workflow element of the job. This is an active link to 

open a new Workflow page in which the element is 
selected.

• Start: Reports the time and date at which the job started.
• Group / Page: Reports the group of workflow pages and the name of the 

specific workflow page containing the job.
• Material ID: Reports the name of the material subject to the listed jobs. 

The material’s name is an active link that switches to the 
Catalog page, populating the panes automatically using 
the data of the selected material.

Fig. 10-210:  Dashboard Page

User Views Pane Dashboard Pane
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• Material Title: Reports the Title associated with the Material.
• End: Reports the time and date at which the job ended.
• Active Tasks: List of tasks currently running on the workflow for that job. 

Each listed task is an active link to the workflow element in 
a new Workflow page, where the element on which the 
task is running is selected.

• Status: Reports the actual status of the selected job, see Section 
3.6 Working with Task Actions and Task Statuses on page 
51.

• View tasks list: : Opens a new pane which reports the details of all tasks 
applied in the workflow for the material object of the 
selected job.

In the Tasks pane, Momentum reports the details of each single task. At the top left side of 
the pane, you can use the buttons to switch the thumbnails or the default table view.

All the rules for managing the layout of a standard table apply. See the section Working with 
Momentum Tables, on page 10 for more details. A filter option is available on the header of 
each column of the table.

Fig. 10-211:  Link to Job Tasks from Dashboard View Options 

Click Live Logger Link to 
Open Tasks Window

User Views Pane

Note: Jobs related to material deleted from the database are not visible on the 
Dashboard.
Jobs started on workflow pages but subsequently deleted, are not 
visible on the Dashboard.
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Filtering Displayed Data Using the Column Filter Options
Each column header includes a drop-down menu containing options that you can use to 
filter the displayed content. The options available in the drop-down menu vary, depending 
on the type of data displayed in the column, e.g., text string, date, task status, etc.

Using the Text String Filters Option
A Filters option is available in the Filter drop-down menu for columns containing text 
strings that enables you to filter the displayed data based on a matching string. Open the 
Filters field for the column of interest and enter a target string to match. Momentum then 
displays only those jobs that match the specified filter string, see Figure 10-213.

Note: You can use the percentage character (% ) as a wildcard in the Active 
Tasks column when defining a filter text string.

Fig. 10-212:  Dashboard Column Filter Drop-down Menu
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Using the Date Filters Option
On a column containing a date, the options shown in Figure 10-214 are available:

You can select one of the available parameters: Before a selected day, After a selected day 
or On a specific date. For each of these options, a calendar opens enabling you to select a 
specific date. The Today button automatically selects the current date.

Using the Status Filters Option
The drop-down filter on the Status column enables you to select which statuses appear in 
the Dashboard table, see Figure 10-215. Unselected statuses are hidden. 

Fig. 10-213:  Dashboard Filtering Data Using a String

Material ID Filter 
Drop-down Menu

Enter Filter String Only Tasks Containing  
Matching Strings Displayed

Fig. 10-214:  Dashboard Filtering Column Data by Date
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Changing the Layout of the Dashboard Page
The User Views functions of the Dashboard page enable you to modify the layout of the 
Dashboard, for example, by moving, hiding or displaying columns, using column filters or 
changing column sort directions. Once you have modified a layout view you can choose to 
save your changes to the current view or to create a new view.

The aim of this feature is to enable you to dedicate each view to a specific area of interest, 
perhaps representing critical stages of your workflows. This can provide a manageable 
overview of key tasks and help to identify any failures quickly, as they occur. When a failure 
is identified, you can take the appropriate actions as necessary to resolve the problem.

Momentum assigns each new Dashboard view a label and displays it as an active button in 
the User views pane above the Dashboard pane, see Figure 10-216. If you have been 
assigned the correct permissions you can then switch between alternative views, by 
clicking the corresponding button, as required.

Fig. 10-215: Dashboard Status Column Filter

Note: Depending on the roles assigned to a user, the Dashboard page will 
display only those views that can be accessed by that user.
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You can modify the layout of the Dashboard pane by:
• Changing the order of columns (by dragging and dropping a column to a new 

position.)
• Changing the default sort direction
• Setting column filters, for more information see Section  Filtering Displayed Data Using 

the Column Filter Options on page 178.
• Hiding and/or showing columns, using the Columns drop-down checkboxes.
• Resizing columns to improve the data display.

Saving Changes to a Dashboard User View
After making any changes to the current view, you can either:

• Click Reset to revert the view to the initial configuration, and ignore any changes.
• Click Save to save any modifications to the current view, without creating a new view.

Fig. 10-216:  Dashboard Page Showing Switchable User Views

User Views Pane Available User 
Views Buttons
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• Click Save as... to create a new view, enter a name, and define which other users can 
have access to the view.

You can also delete or edit a view and/or change the accessibility of the view by clicking the 
drop-down menu available to each User View button. The menu displays the current 
availability of the view (Public, Shared, or Private), and Edit... and Delete... options, see 
Figure 10-218.

When you access the Dashboard page, Momentum displays the last layout you selected on 
your last visit to the page.

Using the Services Page
The Services page is dedicated to the monitoring and management of the nodes 
configured in a Momentum installation. This page displays the following information about 
the nodes:

Fig. 10-217:  Dashboard Page - Saving the Current User View

Fig. 10-218:  Dashboard Page - User Views Menu

Available Actions on 
User Views

Available User Views

Open User Views 
Drop-down Menu

User View 
Availability
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• Identification details, including IP address, communication port, software version, etc.
• The workload of every node, including a count of currently processing tasks and a 

count of pending tasks.
• The status of the machine on which each node is installed.

In addition to this information, an Actions menu enables you to make changes to the 
working conditions of the nodes.

Select: More > Services to open the Services page, see Figure 10-219:

The Services page reports the following information:
• The name and version number of the application node.
• The IP address of the node.
• The port number (used by the node to communicate with the Momentum Server.)
• The pool to which the node belongs.
• The number of slots available for processing node tasks.
• The number of tasks being processed.
• The number of pending tasks.
• The current status of the node e.g., online, offline, etc.
• The actions that can currently be performed on the node, e.g., take offline, take online, 

edit pool and slots count.

At the bottom left corner of the page are the options for managing the organization of the 
displayed data and their updates as described below:

• Group By IP: Lists all nodes with the same IP number in a single 
section

Fig. 10-219:  Services Page - Grouped by Node Type Display
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• Group By Application Name: Lists all nodes with the same application name in a 
single section.

• Group by Pool: Lists all nodes in the same pool in a single section.
• Hide Grouping: Removes any grouping and creates one list containing 

all nodes.
• Show grouping: Displays the information based on the previous 

grouping selection.

You can also group the information by column header as follows:
1 Select the header of the column as required.
2 Open the column drop-down menu, see Figure 10-220.

3 Select the Group by this field option. The page updates automatically.

Working with Nodes in the Service Page
The Status column reports the changes in the status of each node in real-time. A color and a 
message describe the current status which corresponds to an action selected from the 
options in the Actions column as follows:

• Green background and Online message - the node is working properly. The Make 
Offline action is available.

• Yellow background and Going Offline blinking message - the node is still working but 
when the current task is completed, no new task is accepted. The Make Online action 
becomes active.

• Yellow background and Offline message - while Offline, the server does not assign new 
tasks to the node and the Edit action becomes active.

Fig. 10-220: Service Page - Column Drop-down Menu Header Menu

Make Node Offline 

Make Node Online 

Edit Pool and Slots Count
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• Red background and Reconnecting message - the server is trying to connect to a 
specific node. The message displays the number of attempts so far and also the 
maximum of attempts available before considering the node unreachable. No action is 
possible in this mode.

• Red background and Unreachable message - the server failed to connect to the node. 
The Delete action becomes active.
The following icons are available in the Actions column (depending on the current 
status of the node):

 Make offline: Disconnect the node.
 Make online: Reconnect the node.
 Edit Pool and Slots Count: Modify the pool and slots count settings and 

save the changes in the node configuration 
file: MantricsNode.xml.

 Delete: Delete the node and/or close the pane.

Taking a Node Offline
To take a node offline:

1 Click the Disconnect icon .
2 The system runs a check on the IP address of the node. If other type of nodes are 

running, the following dialog appears: 

The dialog lists all of the running modes and enables you to select whether:
• To take all active nodes offline, or

Fig. 10-221:  Services Page - Taking a Node Offline
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• To take only the specified node offline, e.g., Just "FFmpeg Trandscoder" in 
Figure 10-221.

Click All to take all nodes offline, or Just "<Node_name>" to take only the selected 
node offline. Click Cancel to abort the action.
If the node is currently processing a task, it enters the Going Offline status until the 
process ends at which point it becomes offline.
While offline, the server does not assign tasks to the user but the user can still modify 
the node. The Edit and Make Online icons become active.

Editing a Node
While in offline mode, you can modify some of the node parameters and save the new 
values in the node configuration file. To edit the node parameters:

1 Take the node offline.
2 Click the Edit icon .
3 Modify the values for Pool and Slots Count in the Node Details dialog, see Figure 10-

222:

4 Click Save to confirm the changes and save them in the configuration file: 
MantricsNode.xml or click Cancel to exit without saving.

Deleting a Node
When in Unreachable mode, it is possible to delete a node from the list. This can be useful 
when you want to stop the server from attempting to connect to a node that it is no longer 
available. To delete a node:

1 Click the Delete icon: .The following dialog appears:

2 Click Yes to delete the node or No to cancel the operation.

Fig. 10-222:  Services Page Editing Node’s Parameter

Fig. 10-223:  Services Page Delete A Node Confirmation
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Taking a Node Back Online
To take an offline node back online, click the Connect icon: .

The connection between server and node starts and, if successfully established, the node 
becomes online. The Disconnect icon also becomes active.

Using the Statistics Page to Monitor Workflow Activities
The Statistics page provides information about the Momentum workflow activities. The 
page updates automatically according to system activity in order to present an updated 
status of the processes.

To access the Statistics page, select: More > Stats.

The aim of the Statistics page is to help identify any potential delays or bottlenecks in the 
workflow by presenting the waiting and processing times for the tasks in the workflow. The 
Stats page also enables you to predict the amount of time needed to complete all tasks and 
to modify the workflow in order to fix any inefficiencies.

The Statistics page is organized in four sections:
• Elements 
• Users 
• Schemas
• Materials

In switching between the Elements, Users and Schemas sections, you can select a target 
item (workflow element, user, or schema) and view any of the following statistical graphs 
for the selected item:

• Waiting and processing
• Longest Waiting
• Longest processing
• Task vs Material duration

Statistics on Workflow Elements
The following sections describe typical statistical analyses that you can perform when you 
select Elements in the left-hand Statistics menu. 

Creating a Graphic or a Chart
1 Select an element from the tree structure in the Elements pane. 
2 This is the same structure used in the Elements pane of the Workflow page.
3 Choose one of the four tabs at the top of the Graph pane as follows:

• Waiting and processing

Note: The Stats page is available only to those users assigned the role 
Has_Stats_Page.
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• Longest waiting
• Longest processing
• Task vs Material duration.

4 Using the Time span selector below the tabs, select the time span for collecting the 
data for the graph or chart. The following options are available:

• Last 7 days
• Last 30 days
• Last year
• Custom

If you select the Custom time span, the Start and End fields are activated in which you 
can enter a date range.

5 Click the Filter button to update the graph or chart.

Waiting and Processing Tasks
This graph shows the number of tasks which are waiting or processing and also the number 
of workload slots for the selected element for the configured timescale. Hover the mouse 
over a reading in order to see the exact task count as shown in the example below:

While moving the cursor pointer on the diagram, a vertical line highlights the intersection 
of the boundaries with the bars of each of the three charts. The intersection point is marked 
by a yellow dot and a numeric value next to the dot. This value reports the current number 
of tasks represented by the colored bars. At the top of the vertical line, the date and time 
corresponding to the actual position of the mouse pointer is reported.

Fig. 10-224:  Statistics Page - Watchfolder Element Tasks Waiting and Processing
188



Momentum
Operator’s Guide
Saturdays and Sundays are reported using an orange background color.

Longest Waiting Times
This graph shows the longest waiting times for the selected element over the selected time 
span. Hover the mouse over the graph in order to see the task details, see Figure 10-225.

The chart displays the longest waiting times for a task in the selected time span on that 
workflow element. Momentum can display values for up to a hundred elements. A straight 
red line indicates the average task waiting time.

Longest Processing Times
This graph shows the longest processing times for the selected element. Hover the mouse 
over the graph in order to see the task details.

Fig. 10-225:  Statistics Page - Longest Waiting Times
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The chart displays the longest values of processing time of a task for the selected element 
in the specified time span. Momentum displays a maximum of 100 elements. A straight red 
line indicates the average value.

Task vs Material Duration
This graph compares the duration of the material against the length of time taken to 
process each task on the selected element, see Figure 10-227:

Fig. 10-226:  Statistics Page - Longest Processing Times
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The x-axis represents the material’s duration and the y-axis represents the time spent 
processing the material.

A calculated reference line, labeled 1x and starting at the origin of the axes, subdivides the 
graph area: points above this line represent processing time higher than the material 
duration, while points below the line mark processing times shorter than the material 
duration.

Working with Users’ Data
The Users page has the same structure as the Elements page:

• Users pane Lists all of the existing users. Select a user from the list to display 
statistical data related to the selected user.

• Graph pane Displays a graphical representation of the statistical data.

Fig. 10-227:  Statistics Page - Tasks vs Material Duration
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Working with Schema Data
The Schema sub-page has the same two panes structure of the Elements sub-page:

• Schema pane: Lists all of the existing schemas. Select a schema from the list to 
display statistical data related to the selected schema.

• Graph pane: Displays a graphical representation of the statistical data.

Fig. 10-228:  Stats Page - Users Sub-page
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Statistics for Material Tasks
In the Materials section, you can search for an item of material and view the tasks that are 
currently assigned to the selected material as shown below:

Fig. 10-229:  Stats Page - Schema Sub-page
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The Materials sub-page summarizes the lifespan of an item of material in the workflow. 
Each workflow element involved with processing the material is identified by a gray box 
containing the following information:

• Element name
• Number of tasks carried out
• Waiting time
• Processing time

For each element, a bar graph displays the tasks performed using the standard task status 
colors. The graph enables you to compare the processing time and waiting time for the 
selected material, identify the most time-consuming tasks and understand whether there 
are interruptions or bottlenecks in the workflow. This is useful for estimating the 
production costs for each item of material.

Using the Logs Page
Every new process submitted to the workflow is constantly monitored, tracked and 
reported in the Logs page.

To access the Logs page, select: More > Logs.

The Momentum logging system reports logs with the following labels:

Fig. 10-230:  Stats Page - Material and Tasks

Note: The Logs page is available only to those users assigned the role 
Has_Logs_Page.
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• Info
• Warning - highlighted in orange
• Error - highlighted in red

Using the Logs Control Panel
The control panel along the top of the Logs page enables you to switch between a static or 
real-time display of log messages and to set different criteria on which to filter the 
displayed messages.

Fig. 10-231:  Example Logs Page

Note: Each Momentum module generates a log entry; however, most of the 
log information is generated by the workflow activity and concerns the 
Transcoder Service, the Workflow service and the Watchfolder service.
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Using the filters options, you can filter the list of displayed log messages by:
• Date and time
• Log message type (Info, Warning or Error)
• Module - Momentum server, Momentum node, Watchfolder server, etc. 
• Message string

The real time checkbox, when activated, enables you to choose to display log messages in 
real-time, as they are registered on the system.

To submit a query using filters:
1 Select date and time by clicking on the From and To fields and by using the calendar 

and the time drop-down list.
2 Select the type of logs to see in the result list by clicking the Error, Warning or Info 

options.
3 Enter a keyword in the module field to refine the search of a single module, for 

example, transcoder.
4 Enter a target text string in the Message field to search on the content of the message 

column.
5 Click Filter button to apply the filter criteria to the list.

If necessary, click the Details icon:  to display more information about the log entry, see 
Figure 10-233.

Fig. 10-232:  Logs Page Control Panel

Activate Real Time 
Logging

Apply Filter

Filter by Message 
String

Filter by Momentum 
Module

Filter by Date / Time 
Range
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Using the About Page
The Momentum About page provides information about the installed version of 
Momentum, currently connected users and license expiry dates.

To access the Logs page, select: More > About.

The About page contains the following information:
• The installed version of Momentum software
• A list of currently connected users
• Any configured licenses for Momentum components
• Details of all third-party license agreements.

The Database area contains the following information:

Fig. 10-233:  Log Message Details

Fig. 10-234:  Example About Page
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• the release of the Momentum software that is running
• the Oracle User that Momentum is using to connect to the database

The Connected users area displays, in real-time, all users currently connected to the 
Momentum system. For each user, the following information is displayed:

• User name
• Date and time of the last activity of this user
• Agent in use for the connection
• Host IP address
• Host name 

The Licenses area lists all the active feature’s licenses running on the server and their 
expiration date.

At the top left-hand corner of the page, the About third party button enables you to 
display license information for all installed third-party components.

Monitoring the Transfers Page
The Momentum Transfers page is intended to report material that is required for air but is 
missing from a Morpheus play-out database. As an operator with the correct permissions, 
you can monitor the list for urgent pending items, filter on available categories, and export 
data. You can also configure the Momentum workflow to make missing material available 
to Morpheus for play-out.

To access the Transfers page, select: More > Transfers.

Note: The Transfers page is available only to those users assigned the role 
Has_Transfers_Page.
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The Transfers page monitors the status of the transfer requests received as BXF messages 
from a Morpheus system. The page is structured as a table, showing a different transfer 
request on each row with each request defining content that has been identified as missing 
from the Morpheus play-out database. New transfer requests are added to the list when 
received and ordered by descending Request date. You can manage the transfer requests 
from this page. Momentum shows transfer requests in gray if they are expired, and in 
white if they are active.

Use the checkbox Include expired to toggle the display of expired transfer requests on or 
off, without removing them from the table. To clear expired transfer requests from the table 
permanently, click the Remove expired transfer request... button.

The content of the Transfers page is defined in the configuration file 
C:\Mantrics\TransferRequestsConfig.xml and can be customized as required. The 
default Transfers page displays the data contained in the transfer request in the following 
configurable columns:

Column Description

Network Identifies the intended playout network or channel.

Type Defines the type of missing material.

First Air Date Planned to-air date by which Morpheus requires the missing material.

Fig. 10-235: Transfers Page Showing Missing Materials
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A transfer request that has a First Air Date falling within a pre-configured deadline time 
threshold (for example, four hours or less to on-air) is considered urgent. If configured, 
Momentum can highlight any urgent transfer requests on the Transfers page using a yellow 
bullet next to the time and date in the First Air Date column, as shown in Figure 10-236. 

You can set the deadline for urgent transfer requests, in hours, using the tag 
<deadlineHours> in the configuration file: TransferRequestsConfig.xml. If the tag 
<deadlineHours> is not present in the configuration file, or is set to zero (0) then 
Momentum will not display a highlight.

You can choose to export data from the Transfers page using either of the following 
methods:

• Export CSV... enables you to export the content of the Transfers table to a file as 
comma separated values

• Export as... enables you to export the content of the Transfers table to an HTML format 
file in which Momentum converts the dates and times to UTC form. When an operator 
opens the exported file in a browser, an automated script converts the dates to the 
local timezone.

If you use filters to change the data displayed in the table, the button Reset filters becomes 
active. Click Reset filters to de-activate all filters.

The header of the Transfer Requests table reports the time of the last update of the 
displayed list. Time reported is local time, so that it is consist with the system time for 
operators consulting the page.

If you have been assigned the correct permission, you can delete a transfer request from 
the list by clicking .

Changing the Layout of the Transfers Page
The User Views functions of the Transfers page enable you to modify the layout of the 
screen, for example, by moving, hiding or displaying columns, using column filters or 
changing column sort directions. Once you have modified a layout view you can choose to 
save your changes to the current view or to create a new view.

Morpheus ID Identifier of the material in the Morpheus database.

Actions Click to delete a transfer request from the displayed list.

Column Description

Fig. 10-236:  Highlighting of Urgent Transfer Requests

Urgent Transfer 
Request
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The aim of this feature is to enable you to dedicate each view to a specific area of interest, 
perhaps representing specific channels, or transmission types. This can provide a 
manageable overview of key transfer requests and help to identify high-priority requests 
quickly, as they arrive.

Momentum assigns each new view a label and displays it as an active button in the User 
views pane above the Transfer Requests pane, see Figure 10-216. If you have been assigned 
the correct permissions you can then switch between alternative views, by clicking the 
corresponding button, as required.

You can modify the layout of the Transfer Requests pane by:
• Changing the order of columns (by dragging and dropping a column to a new 

position.)
• Changing the default sort direction
• Setting column filters, for more information see Section  Filtering Displayed Data Using 

the Column Filter Options on page 178.
• Hiding and/or showing columns, using the Columns drop-down checkboxes.
• Resizing columns to improve the data display.

Saving Changes to a Transfer Request User View
After making any changes to the current view, you can either:

• Click Reset to revert the view to the initial configuration, and ignore any changes.
• Click Save to save any modifications to the current view, without creating a new view.
• Click Save as... to create a new view, enter a name, and define which other users can 

have access to the view.

Note: Depending on the roles assigned to a user, the Transfer Requests page 
will display only those views that can be accessed by that user.

Fig. 10-237:  Transfer Requests Page Showing Switchable User Views
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You can also delete or edit a view and/or change the accessibility of the view by clicking the 
drop-down menu available to each User View button. The menu displays the current 
availability of the view (Public, Shared, or Private), and Edit... and Delete... options.

When you access the Transfer Requests page, Momentum displays the last layout you 
selected on your last visit to the page.

Working with Play-out Schedules
The Momentum Schedules page enables you to import playlist schedule files (generally 
exported by a Morpheus Playout Automation system and having a .SCH file extension) into 
Momentum. Operators need to check these advance schedules to determine whether any 
scheduled material is missing from either the attached NAS or an incoming watchfolder.

You can filter the schedule view by channel, schedule file, material availability in the 
database, first, or all occurrences and then choose to include or exclude expired schedule 
entries.

When required, you can export schedule reports in CSV or XML format using a predefined 
template.

To access the Schedules page, select: More > Schedules, see Figure 10-239.

Fig. 10-238:  Transfers Page - Saving the Current User View

Note: The Schedules page is available only to those users assigned the role 
Has_Schedules_Page.
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Importing a Schedule File
Import a playlist schedule into Momentum as follows:

1 In the Schedules page, click Import Schedule...
This opens the Upload Schedule dialog, see Figure 10-240.

2 Click Browse... to locate the desired schedule file(s).
3 Click Ok to upload the schedule.

Momentum lists the schedule details in the Schedule table and reports the following 
information, by default:

• Channel: Lists all nodes with the same IP number in a single section
• To Air Date: Date and time on which the scheduled material is due to go on 

air.
• Duration: Duration of the scheduled material.
• Exists: Indicates whether the scheduled material is available or not. A 

green spot shows that the material is available, a red spot shows 
that the material is missing.

• Material ID: Material ID of the scheduled material. 
• Event name: Description of the scheduled event; includes both primary and 

secondary (subtitles, graphic stills and audio files) events.

Fig. 10-239: Schedules Page
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Fig. 10-240:  Schedules Upload Dialog
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The following optional columns may be displayed, depending on the configuration of 
SchedulesConfig.xml:

• Device: Device generating the schedule, for example, ICE.
• Schedule file: Name of the imported schedule file.
• Creation Date: Date on which the Schedule file was generated.
• Error/Failed: Displays the most recent errors which the system has 

encountered.
• QC_STATUS: Displays the quality checking status of the material.
• Long File ID: Reference ID for the schedule file in the database.

Exporting Schedule Data
As required, you can export the current view of the Schedules page in CSV or XML format 
using the appropriate template located in the folder:

C:\Mantrics\ExportTemplates\TransferRequests

The missing materials XML template (Missing Materials.xml) contains the following 
detail:
<BROADCAST_SCHEDULE>

<BROADCAST_DATE_TIME>{[0].StartDate.ToString("yyyy-MM-dd
 HH:mm:ss")}</BROADCAST_DATE_TIME>
<DATE>{YYYY}</DATE>
{#ForEach()}<PROGRAM>

<TID>{MaterialId}</TID>
<PID>{MaterialId}</PID>
<START_DATE_TIME>{StartDate.ToString("dd/MM/yyyy
 HH:mm:ss")}</START_DATE_TIME>
<DURATION>{Duration.Substring(0, 8)}</DURATION>
<FORMAT>{DeviceId}</FORMAT>
<EPG>0</EPG>
<TITLE>{EventName}</TITLE>
<DESCRIPTION/>
<CatID>{CategoryId}</CatID>

</PROGRAM>
{/ForEach}

</BROADCAST_SCHEDULE>

The missing materials CSV template (Missing Materials.csv) contains the following 
detail:

Channel,Time to Air,Duration,Material ID,Title,Device ID,Reason,

{#ForEach()}{#EscapeCSV()}{ChannelName} ({ChannelId}){/
EscapeCSV},{StartDate.ToString("dd-MMM-yyyy 
HH:mm:ss:00").ToUpper()},{#EscapeCSV()}{MaterialId}{/
EscapeCSV},{#EscapeCSV()}{EventName}{/
EscapeCSV},{#EscapeCSV()}{DeviceId}{/EscapeCSV},Not in database,

{/ForEach}
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The exported report includes the content required for these playlists which is not currently 
stored in Momentum. The report should be ordered by ascending transmission time and 
show the transmission times, Material IDs, Titles and Channel Names of the missing items.

Export playlist schedule data from Momentum as follows:
1 In the Schedules page, click Export as...

This opens the Export as... dialog, see Figure 10-240.

2 Enter the file name of the exported file without an extension.
3 Select the export template from the format drop-down menu.

You can choose either the XML template (MissingMaterials.xml) or the CSV 
template (MissingMaterials.xml).

4 Set the page range of the data to include in the exported report using the From page 
and To page selectors.

5 Click Preview to view a preview of the missing materials report before it is exported.
The Export as dialog opens two fields, logger and preview, see Figure 10-242.

Fig. 10-241:  Schedule Export Dialog

Select CSV or XML 
Export Template
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The logger field lists any issues occurring in rendering the output by line number.
The preview field displays a preview of the XML or CSV output in the missing materials 
report.

6 Click Download to export the missing materials report.
Momentum exports the specified file to your browser’s Downloads folder.

Fig. 10-242:  Schedule Export Dialog

Report Output 
Rendering Errors

Preview of Report 
Output
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Archiving to an Oracle DivArchive System
Overview of the DivArchive System
Momentum is designed to integrate with an Oracle DivArchive1 digital archive solution for 
the archiving of digital media assets and assistance in providing material for production 
workflows.

The Oracle DIVArchive solution has interfaces to broadcast and post-production devices; it 
understands how content is organized on the device, and stores all files belonging to this 
content as a single object. The DivArchive system supports the storage and management of 
several instances of the same object, for example, it can store and track one instance on 
disk, one instance on tape within a robotic tape library, and one instance on tape stored on 
an external shelf.

The DIVArchive solution consists of, and uses, a number of related DIVA products. 

1.Formerly known as Front Porch Digital DIVA and acquired by Oracle in September 2014.

Fig. 11-243:  Overview of a Typical DivArchive System
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Configuring the Diva Workflow Elements
The following are the most relevant to a Momentum Installation: 
• DIVArchive Manager: Manages the overall archive solution. It also hosts 

the archive system database. Typically runs on 
dedicated hardware.

• DIVArchive Partial File Restore: Allows restoration of a segment of a piece of content 
that is managed by the DIVArchive. This is specified 
by an in timecode and an out timecode and is more 
efficient than restoring a full media asset when only 
a short clip is required.

• DIVArchive Application Filter: Limits access to DIVArchive managed content by 
third-party systems based on user permissions.

• DIVAnet: Facilitates a direct connection between separate 
DIVArchive Systems and automatically replicates 
content from one site to the other, typically for 
disaster recovery (DR) purposes.

• DIVAdirector: Asset Management System that provides direct 
interfaces into edit systems and provides some 
workflow management and search with low 
resolution proxy viewing, thumbnails and metadata 
management. This module also allows file upload 
with time-code based logging and tagging.

Configuring the Diva Workflow Elements
Momentum provides four workflow elements (Archive, Delete, Restore and Partial Restore) 
to integrate workflows with the DivArchive archiving system. These elements are available 
from the Workflow page in the elements folder: Archive > Oracle, see Figure 11-244.

Fig. 11-244:  Diva Archive Workflow Elements 

Oracle Diva Archive 
Workflow Elements
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The location of the DIVArchive Manager is configured for each of these archiving elements 
in the configuration files: MantricsServer.xml and MantricsNode.xml.

In addition, the configuration file Diva.xml contains a list of the Diva error codes together 
with their associated error descriptions. The file MantricsNode.xml defines the default 
communication port between Momentum and the DIVArchive system as port 9763.

See the Momentum Configuration Guide for details on configuring the individual workflow 
elements.
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 Scripting
Overview
Momentum supports the use of scripts in order to allow a greater degree of customization 
of a workflow. The following programming languages are supported:

• Visual Basic (.NET)
• C# 
• Python
• IronPython 2.7

Adding a Script element to the workflow enables the user to write a script directly into the 
Settings pane or paste the script in from an external editor. The script field of the pane can 
be maximized using the Open in window button.

For Visual Basic and C# you can import external DLLs as follows:
1 Copy all the referenced DLL files into a folder that can be accessed by the Momentum 

system
2 Enter this path into the External DLLs Folder field.

This chapter contains a reference of the Objects available in Momentum and their related 
methods. At the end of this chapter, there are some examples.

Object: MaterialPeer
The MaterialPeer object has the following options:

• String MaterialId
Gets/sets the materialId for the associated task.

• string InstanceId
Gets/sets the instanceId for the associated task.

• bool  RemoveMaterial (string materialId)
Returns true if a specific material is deleted, false in all the other cases.

• string AddInstance(int type, string label, string instPath)
Adds a new instance to the current material. 

• Type   0 > HQ; 1 > LQ
Returns the ID of the newly created instance.

• InstancePeer Instance
Gets/sets the InstancePeer for the associated task.

• List<string>getProjectIdsList()
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Object: InstancePeer
Returns the projectId for current materialId.
• String getMetadata(String name)

Returns a metadata for current materialId using fullName metadata.
• public void setMetadata(String name, Object value)

Sets the metadata called ‘name’ for the current materialId.
• public void setMetadata(String materialId, String name, Object value)

Sets the metadata called ‘name’ for the specified materialId.
• MaterialPeer CreateVideoMaterial(string title)

Returns a new MaterialPeer object with the same schema of materialpeer object which 
has invoked it.

• MaterialPeer CreateVideoMaterial(string title,string schemaId)
Returns a new MaterialPeer object with a specific title and schema.

• MaterialPeer CreateVideoMaterial(string title,List<string>projectsIds,string 
schemaId)
Returns a new MaterialPeer object with a specific title and schema. the newly created 
material is also added to the list of specified projects.

• double GetTotalSecsFromTimecode
Returns a double variable containing the seconds corresponding to the input 
timecode.

• string GetTotalSecsFromTimecode
Returns a string containing the string representation of a timecode corresponding to 
the number of seconds in input.

Object: InstancePeer
This object is accessible using methods of MaterialPeer. This object has the following 
methods:

• string InstanceId
Get/sets the instanceId of the peer.

• int getWidth()

Returns the Width attribute for current instanceId.
• int getHeight()

Returns the Height attribute for current instanceId.
• int getSampleRate()

Returns the SampleRate attribute for current instanceId.
• string getAr()

Returns the Aspect Ratio attribute for current instanceId.
• string getFrameRate()

Returns the FrameRate attribute for current instanceId.
• string getBitrate()

Returns the birRate attribute for current instanceId.
• int getChannels()
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Returns the channels attribute for current instanceId.
• string getLocalPath()

Returns the localPath attribute for current instanceId.
• void setLocalPath(string path)

Sets the localPath attribute for current instanceId.
• string getFileName()

Sets the filename associated to current instanceId (for example, 
\\10.10.0.221\myShare\sample.mxf > sample.mxf).

• string getType()
Type   0 > HQ; 1 > LQ
Gets the type of current instanceId.

• public double getDuration()
Returns the duration for current instanceId.

• public string getCodecName()
Returns the codec name attribute for current instanceId.

• string getEssenceType()
Returns the essence type attribute for current instanceId.

• string getMediaType()
Returns the media type.

• string GetDurationInTimecode()
Returns the duration of the media asset in timecode format.

Object: ScriptPeer
This object is accessible using the variable script. This object has the following methods:

• string Choice
Gets/sets the exit port of the script.

• string ErrorString
Returns the last known error if any.

• string CurrentTaskId
Returns the ID of the current task.

• XmlDocumentgetPreviousTaskList
Returns an XML document describing the task list. For example:
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Object: LoggerPeer
• string OutMaterialId
Gets/sets the MaterialId associated to the task propagated to the next element.

• string OutInstanceId
Gets/sets the InstanceId associated to the task propagated to the next element.

Object: LoggerPeer
This object is accessible using the variable logger. This object has the following methods:

• void log(string toLog)
Logs the message as INFO to Momentum logger.

• void logToEventViewer(string toLog)
Logs the message as INFO to the Windows EventViewer.

Object: FileWatcherPeer
This object is accessible using the variable fileWatcher. This object has the following 
methods:

• String wait(string fname)
Wait for a specific file (check every 3 seconds).
This is a blocking thread. Always returns null.

<TasksList>
<task id='823482346'>

<nodeId>387453463847634</nodeId>
<priority>5</priority>
<materialId>3874837634</materialId>
<instanceId>74383875387</instanceId>
<Data_operation_in>20132003</Data_operation_in>
<Data_operation_end>20132003</Data_operation_end>
<jobId>78234628</jobId>
<ErrorCode>

<![CDATA[Error1]]>
</ErrorCode>
<BrickName>

<![CDATA[Send Mail to Joe]]>
</BrickName>
<TaskIsProcessing>true</TaskIsProcessing>

</task>
</TasksList>
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Object: FileManagerPeer
This object is accessible using the variable filemanager. This object has the following 
methods:

• string getExtension(string fName)

Returns the extension of the fName specified.

• string GetFileNameWithoutExtension(string fName)

Returns the filename of the fName specified without extension (C:\win-
dows\clock.avi > clock).

• string GetDirectoryName(string fName)

Returns the directory of the fName specified (C:\windows\clock.avi > C:\windows).

• string Combine(string dir, string fname)

Combines in a safe way, the directory and fname with correct slash.

• bool Rename(string old, string newfname)

Renames old in newfname (can be used also for move).

Object: ConsolePeer
This object is accessible using the variable console. Used only for development purposes. 
This object has the following methods:

• void writeLine(string toPrint)

Writes a line to console.

• void write(string toPrint)

Writes to console (no new line).

• void readLine()

Reads a line from the console.

Examples
The following examples demonstrate how to add useful features to a workflow.
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Connecting to the utils.asmx Web Service
This is a version of the script which works on x86 servers only. After connecting to the 
utils.asmx Web Service, the script passes the userId and then retrieves a unique ID.

Public Function EvaluateIt()

    dim oXMLHTTP = CreateObject("MSXML2.XMLHTTP.6.0") 
    dim oXMLDoc = CreateObject("MSXML2.DOMDocument") 
    dim param
    dim metadataName
    metadataName = "Core.Description"
    param = ""
    call console.WriteLine("------ Script CallWS -------")
    call oXMLHTTP.open("POST", "http://localhost/Momentum/WebAPI/

WebAPI.asmx/GetValidLabels", false) 
    call oXMLHTTP.setRequestHeader("Content-Type","application/x-www

-form-urlencoded") 
    oXMLHTTP.send("" & param) 
    dim response
    response = oXMLHTTP.responseText
    'call console.WriteLine(response) 
    call oXMLDoc.loadXML(response) 
    if(oXMLDoc.parseError.errorCode <> 0) then 
        call console.writeLine("ERROR") 
        response = oXMLHTTP.responseText & " " & 

oXMLDoc.parseError.reason 
        call console.writeLine(oXMLDoc.parseError.reason) 

 script.ErrorString = oXMLDoc.parseError.reason
        script.Choice = "failed"
    else 

response = oXMLDoc.selectSingleNode("//
node").getAttribute("label")

logger.log("The returned value for label is: " & response)
call material.setMetadata(material.MaterialId, 

metadataName, response)
script.Choice = "ok"

end if
Catch e As Exception

script.ErrorString = e.Message
script.Choice = "failed"

End Try
End Function

The SD/HD Router Script
Here is the script used in the Virtual SD/HD Router element.

The ‘HDPORT’ and ‘SDPORT’ values are the names of the two custom ports added to 
the element and through which the materials (having the appropriate Width values) are 
sent.

'route the flow checking the HD/SD property
'declare a function to be used in the body
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Public Function isHD()
isHD = true
if (material.INSTANCE.getWidth <> 1920) Then
  isHD = false
end if
if (material.INSTANCE.getHeight <> 1080) Then
  isHD = false
end if
End Function

Public Function EvaluateIt()
if isHD=true then
  script.Choice = "HDPORT"
else
  script.Choice = "SDPORT"
end if
End Function

Fill Empty Metadata
The following short Python script takes the current material, makes a check to verify if some 
of its metadata are empty (the metadata to check are those into the toCheck list) and, 
finally, the empty ones are filled using the value of a specified string (defaultStr).
toCheck = ["Core.Title" , "Core.CreationDate" , "Core.Genre" , 
"Core.Description" , "Core.Keywords" , "Core.CreatedBy"] 

defaultStr = "THIS FIELD IS EMPTY" 

for metadata in toCheck: 
str = material.GetMetadata(metadata) 
if not str: 
material.SetMetadata(material.MaterialId, metadata, defaultStr) 

script.Choice = "ok"

Creating a Custom Log File
The following Python script creates a custom Log file (CustomBricLog.txt) and writes in it 
the title of the current material.
fileAddress = "C:/Users/andrea/Desktop/CustomBricLog.txt" # NB: insert a 
correct path here!!! 

fileName = open(fileAddress , "a+") 

title = material.GetMetadata("Core.Title") 

str = "Title: " + title + " under processing. \n" 

fileName.write(str) 


217



Scripting
Using the Logger Windows
fileName.close() 

script.Choice = "ok" 

Using the Logger Windows
The following Python script modifies the title of a material and uses the logger windows to 
log a message reporting the result of this action.
oldTitle = material.GetMetadata("Core.Title") 
newTitle = "" 

for index, letter in enumerate(oldTitle): 
newTitle += letter.upper() if (index%2 == 0) else letter.lower() 

material.SetMetadata(material.MaterialId, "Core.Title", newTitle) 

logger.log("Title changed from " + oldTitle + " to " + newTitle) 

script.Choice = "ok"
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Supported Container Formats
Momentum supports the following media container or wrapper formats:

Supported Video Formats
Momentum supports the following video file formats:

Wrapper Description Wrapper For Filename 

MPEG-TS (also MTS, TS) MPEG-2 Transport Stream Audio, Video, Data .ts, .tsv, .tsa

MPEG-PS (also PS) MPEG-2 Program Stream Audio, Video, Data .mpg, .mpeg, .m2p, .ps

MPEG-4 Parts 1, 14 and 15 MPEG-4 Audio, Video, Text .mp4, .m4a, .m4p, .m4b, 
.m4r and .m4v

3GPP 3rd Generation 
Partnership Project 

Audio, Video, Text .3gp, .3gpp

MOV QuickTime File Format 
(QTFF)

Audio, Video, Text .mov, .qt

ASF Advanced Systems Format
(Microsoft digital audio /
video container format.)

Windows Media Audio, 
Windows Media Video

.asf, .wmv, .wma, 

BXF Broadcast eXchange 
Format (SMPTE standard)

XML-based 
communication schema 
for near-real-time 
messaging of Schedule 
and as-run data, content 
metadata, content 
movement instructions.

.bxf

GXF General eXchange Format Container format for the 
transfer of simple and 
compound audiovisual 
clips between television 
program storage systems.

.gxf

MXF Material eXchange Format 
(SMPTE standard)

Container format for 
audiovisual material and 
rich metadata.

.mxf
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Supported Video Formats
Video Format Codec Bitrates (Mb/s) Resolution & 
Standard

Notes

Sony XDCAM

SD DVCAM 25 50i, 59.94i

MPEG IMX 30, 40, 50 

HD MPEG-2 18,25,35 1080 @ 50i, 59.94i MP@HL

MPEG-2 50 720 @ 50p, 59.94p 4:2:2P@HL

EX DVCAM 25 50i, 59.94i

MPEG-HD 25 1080 @ 50i, 59.94i MPEG-2 MP@HL

MPEG-HD 35 1080 @ 50i, 59.94i
720 @ 50p, 59.94p

MPEG-2 MP@HL 
JVC HM-650 camera

Panasonic P2 (Professional Plug-in Storage Media)

SD DV 25 50i, 59.94i

DVCPRO 25

DVCPRO 50

HD DVCPRO HD 100 1080 @ 50i, 59.94i
720 @ 50p, 59.94pAVC-Intra Class 50 50

AVC-Intra Class 100 100

Canon MXF

HD MPEG-2 4:2:2 50 1080i / 720p 422@HL

MPEG-2 4:2:0 35 MP@HL

MPEG-2 4:2:0 25 1080i MP@H14

XAVC - I frame

HD H.264 50 1080 @ 50/59.94i

100 1080 @ 25/50p, 
29.97/59.94p, 50/
59.94i

100 720 @ 50p, 59.94p

2K H.264 100 2K @ 25/50p, 29.97/
59.94p

UHD H.264 600 UHD @ 25/50p, 
29.97/59.94p

4K H.264 300 4K @ 25/50p, 29.97/
59.94p480
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XAVC-S

HD H.264 100 1080 @ 25/50p, 
29.97/59.94p

H.264 100 2K @ 25/50p, 29.97/
59.94p

XAVC Long GOP

HD H.264 High422, 4:2:2 
10-bit

50 1280 x 720 @ 50p, 
59.95p

H.264 High422, 4:2:2 
10-bit

50 1920 x 1080 @ 25p, 
29.97p, 50p, 59.94p, 
50i, 59.94i

H.264 High422, 4:2:2 
10-bit

25,35 1920 x 1080 @ 25p, 
29.97p, 50i, 59.94i

4K H.264 188 3840 x 2160 @ 25p, 
29.97p

H.264 300 3840 x 2160 @ 50p, 
59.94p

Sony F55 DNxHD (Digital Nonlinear Extensible High Definition)

HD DNxHD 145 / 220X 1080 @ 29.97p, 
59.94i

OP1a

120 / 185X 1080 @ 25p, 50i OP1a

Ikegami GFCAM

SD MPEG-2 (IMX) 30 / 40 / 50 50i, 59.94i OPAtom

HD MPEG-2 50 (Long-GOP)
100 (Intra)

1080 @ 25/50p, 
29.97/59.94p, 50i, 
59.94i

OPAtom

AVC-LongG

HD H.264 (4:2:0 8bit) G6, G12 1080 @ 50i, 59.94i, 
50p, 59.94p
720 @ 50p, 59.94p

OP1b

H.264 (4:2:2 10bit) G25, G50 1080 @ 25/50p, 
29.97/59.94p, 50i, 
59.94i
720 @ 50p, 59.94p

OP1b

Video Format Codec Bitrates (Mb/s) Resolution & 
Standard

Notes
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AVC-Ultra

UHD H.264 4K 422 400 UHD @ 25/50p, 
29.97/59.94p

OP1b

4K H.264 4K @ 25/50p, 29.97/
59.94p

OP1b

2K H.264 2K 422 220 2K @ 25/50p, 29.97/
59.94p

OP1b

DNxHD (SMPTE-VC3)

HD 10 bit 175 / 220 720p @ 50, 59.94 OP1a

8 bit 175, 115 / 220, 145

10 bit 185 / 220 1080i @ 50, 59.94

8 bit 185, 120 / 220, 145

10 bit 365 / 440

8 bit 340, 365, 75 / 90, 
290, 440

Video Format Codec Bitrates (Mb/s) Resolution & 
Standard

Notes
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Standard Metadata Fields
Momentum supports the use of scripts in order to allow a greater degree of customization 
of a workflow.

Name Metadata ID Data Type

AudioInstance

Channels AudioInstance.AtrackInstance.CHANNELS Number

Codec name AudioInstance.AtrackInstance.CODECNAME Text

DURATION AudioInstance.AtrackInstance.DURATION Timecode

LANGUAGE AudioInstance.AtrackInstance.LANGUAGE Text

Path AudioInstance.AtrackInstance.PATH Text

POSITION AudioInstance.AtrackInstance.POSITION Number

QCComment AudioInstance.AtrackInstance.QCCOMMENT Text

QCStatus AudioInstance.AtrackInstance.QCSTATUS Text

Sample rate AudioInstance.AtrackInstance.SAMPLERATE Number

Sample size AudioInstance.AtrackInstance.SAMPLESIZE Number

ARCHIVE AudioInstance.MomentumCore.ARCHIVE Text

ASPECT_RATIO AudioInstance.MomentumCore.ASPECT_RATIO Text

ASSIGNED_CHANNELS AudioInstance.MomentumCore.ASSIGNED_CHANNELS Text

CATEGORY_ID AudioInstance.MomentumCore.CATEGORY_ID Text

DURATION AudioInstance.MomentumCore.DURATION Text

EPISODE_NUMBER AudioInstance.MomentumCore.EPISODE_NUMBER Number

FILED_DATE AudioInstance.MomentumCore.FILED_DATE Date

FRAMERATE AudioInstance.MomentumCore.FRAMERATE Number

MATERIAL_TYPE AudioInstance.MomentumCore.MATERIAL_TYPE Text

MORPHEUS_ID AudioInstance.MomentumCore.MORPHEUS_ID Text

NOTES AudioInstance.MomentumCore.NOTES Text

NUMBER_OF_TAPES AudioInstance.MomentumCore.NUMBER_OF_TAPES Number

ON_AIR_DURATION AudioInstance.MomentumCore.ON_AIR_DURATION Text

OWNER_ID AudioInstance.MomentumCore.OWNER_ID Number

PURGE_DATE AudioInstance.MomentumCore.PURGE_DATE Date

REQUIRED_DATE AudioInstance.MomentumCore.REQUIRED_DATE Date
 223



Standard Metadata Fields
REVIEWED_BY AudioInstance.MomentumCore.REVIEWED_BY Text

RUN_ON_DURATION AudioInstance.MomentumCore.RUN_ON_DURATION Text

SCAVENGE AudioInstance.MomentumCore.SCAVENGE Number

SOM AudioInstance.MomentumCore.SOM Text

STATUS AudioInstance.MomentumCore.STATUS Text

SUBTITLE_REF AudioInstance.MomentumCore.SUBTITLE_REF Text

TITLE AudioInstance.MomentumCore.TITLE Text

AUDIO_COMPRESSION AudioInstance.MomentumInstance.AUDIO_COMPRESSION Number

AUDIO_MODE AudioInstance.MomentumInstance.AUDIO_MODE Text

AUDIO_SAMPLE_RATE AudioInstance.MomentumInstance.AUDIO_SAMPLE_RATE Number

AUDIO_SHUFFLING_ID AudioInstance.MomentumInstance.AUDIO_SHUFFLING_ID Text

AUTO_QC AudioInstance.MomentumInstance.AUTO_QC Date

CLIP_REF AudioInstance.MomentumInstance.CLIP_REF Number

DELETE_AFTER AudioInstance.MomentumInstance.DELETE_AFTER Date

DEVICE_ID AudioInstance.MomentumInstance.DEVICE_ID Text

ENCODED AudioInstance.MomentumInstance.ENCODED Number

INSTANCE_LABEL AudioInstance.MomentumInstance.INSTANCE_LABEL Text

INSTANCE_STATUS AudioInstance.MomentumInstance.INSTANCE_STATUS Number

LAST_AIRED_DATE AudioInstance.MomentumInstance.LAST_AIRED_DATE Date

LAST_USED_DATE AudioInstance.MomentumInstance.LAST_USED_DATE Date

LONG_FILE_ID AudioInstance.MomentumInstance.LONG_FILE_ID Text

LTC AudioInstance.MomentumInstance.LTC Text

MAT_ID AudioInstance.MomentumInstance.MAT_ID Text

ProcAmp AudioInstance.MomentumInstance.ProcAmp Text

QUALITY_CHECK AudioInstance.MomentumInstance.QUALITY_CHECK Date

RECORDED_DATE AudioInstance.MomentumInstance.RECORDED_DATE Date

RUN_ON AudioInstance.MomentumInstance.RUN_ON Number

SCAN AudioInstance.MomentumInstance.SCAN Number

SOURCE_DEVICE_ID AudioInstance.MomentumInstance.SOURCE_DEVICE_ID Text

TECHNICAL_COMMENT AudioInstance.MomentumInstance.TECHNICAL_COMMEN
T

Text

TIMECODE_IN AudioInstance.MomentumInstance.TIMECODE_IN Text

TIMECODE_OUT AudioInstance.MomentumInstance.TIMECODE_OUT Text

TV_STD AudioInstance.MomentumInstance.TV_STD Number

USAGE_COUNT AudioInstance.MomentumInstance.USAGE_COUNT Number

VIDEO_COMPRESSION AudioInstance.MomentumInstance.VIDEO_COMPRESSION Number

Name Metadata ID Data Type
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VITC AudioInstance.MomentumInstance.VITC Text

AudioTrack

Channels AudioTrack.AtrackInstance.CHANNELS Number

Codec name AudioTrack.AtrackInstance.CODECNAME Text

DURATION AudioTrack.AtrackInstance.DURATION Timecode

LANGUAGE AudioTrack.AtrackInstance.LANGUAGE Text

Path AudioTrack.AtrackInstance.PATH Text

POSITION AudioTrack.AtrackInstance.POSITION Number

QCComment AudioTrack.AtrackInstance.QCCOMMENT Text

QCStatus AudioTrack.AtrackInstance.QCSTATUS Text

Sample rate AudioTrack.AtrackInstance.SAMPLERATE Number

Sample size AudioTrack.AtrackInstance.SAMPLESIZE Number

Basicmetadata

Basicmetadata.Demo.TipoStringa Text

Basicmetadata.Topic.TipoStringa Text

Commercial

CAMPAIGN Commercial.Commercial.CAMPAIGN Text

ORIG_LANGUAGE Commercial.Commercial.ORIG_LANGUAGE Text

PRODUCT Commercial.Commercial.PRODUCT Text

PROD_YEAR Commercial.Commercial.PROD_YEAR Number

RIGHTS_HOLDER Commercial.Commercial.RIGHTS_HOLDER Text

SCHEDULING_REF_1 Commercial.Commercial.SCHEDULING_REF_1 Text

SCHEDULING_REF_2 Commercial.Commercial.SCHEDULING_REF_2 Text

SUPPLIER Commercial.Commercial.SUPPLIER Text

Defect

defect_code Defect.Defect.DEFECT_CODE Text

Delivery

DELIVERYDATE Delivery.Delivery.DELIVERYDATE Date

ENTRYPOINT Delivery.Delivery.ENTRYPOINT Text

METAXML Delivery.Delivery.METAXML Clob

NOTE Delivery.Delivery.NOTE Clob

ORIGDATE Delivery.Delivery.ORIGDATE Date

ROLE Delivery.Delivery.ROLE Text

STARTED Delivery.Delivery.STARTED Number

Name Metadata ID Data Type
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DivaInstance

ARCHIVE_DATE DivaInstance.DivaInstance.ARCHIVE_DATE Date

CATEGORY DivaInstance.DivaInstance.CATEGORY Text

MEDIA DivaInstance.DivaInstance.MEDIA Text

OBJECT_FILE_SIZE DivaInstance.DivaInstance.OBJECT_FILE_SIZE Number

OBJECT_NAME DivaInstance.DivaInstance.OBJECT_NAME Text

SOURCE DivaInstance.DivaInstance.SOURCE Text

SOURCE_PATH DivaInstance.DivaInstance.SOURCE_PATH Text

FlashnetInstance

GUID FlashnetInstance.FlashnetInstance.GUID Text

ImageInstance

CODECNAME ImageInstance.ImageInstance.CODECNAME Text

HEIGHT ImageInstance.ImageInstance.HEIGHT Number

SAMPLESIZE ImageInstance.ImageInstance.SAMPLESIZE Text

WIDTH ImageInstance.ImageInstance.WIDTH Number

ARCHIVE ImageInstance.MomentumCore.ARCHIVE Text

ASPECT_RATIO ImageInstance.MomentumCore.ASPECT_RATIO Text

ASSIGNED_CHANNELS ImageInstance.MomentumCore.ASSIGNED_CHANNELS Text

CATEGORY_ID ImageInstance.MomentumCore.CATEGORY_ID Text

DURATION ImageInstance.MomentumCore.DURATION Text

EPISODE_NUMBER ImageInstance.MomentumCore.EPISODE_NUMBER Number

FILED_DATE ImageInstance.MomentumCore.FILED_DATE Date

FRAMERATE ImageInstance.MomentumCore.FRAMERATE Number

MATERIAL_TYPE ImageInstance.MomentumCore.MATERIAL_TYPE Text

MORPHEUS_ID ImageInstance.MomentumCore.MORPHEUS_ID Text

NOTES ImageInstance.MomentumCore.NOTES Text

NUMBER_OF_TAPES ImageInstance.MomentumCore.NUMBER_OF_TAPES Number

ON_AIR_DURATION ImageInstance.MomentumCore.ON_AIR_DURATION Text

OWNER_ID ImageInstance.MomentumCore.OWNER_ID Number

PURGE_DATE ImageInstance.MomentumCore.PURGE_DATE Date

REQUIRED_DATE ImageInstance.MomentumCore.REQUIRED_DATE Date

REVIEWED_BY ImageInstance.MomentumCore.REVIEWED_BY Text

RUN_ON_DURATION ImageInstance.MomentumCore.RUN_ON_DURATION Text

SCAVENGE ImageInstance.MomentumCore.SCAVENGE Number

SOM ImageInstance.MomentumCore.SOM Text

Name Metadata ID Data Type
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STATUS ImageInstance.MomentumCore.STATUS Text

SUBTITLE_REF ImageInstance.MomentumCore.SUBTITLE_REF Text

TITLE ImageInstance.MomentumCore.TITLE Text

AUDIO_COMPRESSION ImageInstance.MomentumInstance.AUDIO_COMPRESSION Number

AUDIO_MODE ImageInstance.MomentumInstance.AUDIO_MODE Text

AUDIO_SAMPLE_RATE ImageInstance.MomentumInstance.AUDIO_SAMPLE_RATE Number

AUDIO_SHUFFLING_ID ImageInstance.MomentumInstance.AUDIO_SHUFFLING_ID Text

AUTO_QC ImageInstance.MomentumInstance.AUTO_QC Date

CLIP_REF ImageInstance.MomentumInstance.CLIP_REF Number

DELETE_AFTER ImageInstance.MomentumInstance.DELETE_AFTER Date

DEVICE_ID ImageInstance.MomentumInstance.DEVICE_ID Text

ENCODED ImageInstance.MomentumInstance.ENCODED Number

INSTANCE_LABEL ImageInstance.MomentumInstance.INSTANCE_LABEL Text

INSTANCE_STATUS ImageInstance.MomentumInstance.INSTANCE_STATUS Number

LAST_AIRED_DATE ImageInstance.MomentumInstance.LAST_AIRED_DATE Date

LAST_USED_DATE ImageInstance.MomentumInstance.LAST_USED_DATE Date

LONG_FILE_ID ImageInstance.MomentumInstance.LONG_FILE_ID Text

LTC ImageInstance.MomentumInstance.LTC Text

MAT_ID ImageInstance.MomentumInstance.MAT_ID Text

ProcAmp ImageInstance.MomentumInstance.ProcAmp Text

QUALITY_CHECK ImageInstance.MomentumInstance.QUALITY_CHECK Date

RECORDED_DATE ImageInstance.MomentumInstance.RECORDED_DATE Date

RUN_ON ImageInstance.MomentumInstance.RUN_ON Number

SCAN ImageInstance.MomentumInstance.SCAN Number

SOURCE_DEVICE_ID ImageInstance.MomentumInstance.SOURCE_DEVICE_ID Text

TECHNICAL_COMMENT ImageInstance.MomentumInstance.TECHNICAL_COMMEN
T

Text

TIMECODE_IN ImageInstance.MomentumInstance.TIMECODE_IN Text

TIMECODE_OUT ImageInstance.MomentumInstance.TIMECODE_OUT Text

TV_STD ImageInstance.MomentumInstance.TV_STD Number

USAGE_COUNT ImageInstance.MomentumInstance.USAGE_COUNT Number

VIDEO_COMPRESSION ImageInstance.MomentumInstance.VIDEO_COMPRESSION Number

VITC ImageInstance.MomentumInstance.VITC Text

Instance

On Air Date Core.OnAirDate Date
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LOCATION Core.Path Text

Qc Errors Core.QCErrors Number

Qc Infos Core.QCInfos Number

Qc Report Core.QCReport Text

Qc Status Core.QCStatus Text

Qc Warnings Core.QCWarnings Number

Type Core.Type Text

ARCHIVE_DATE Instance.Archive.ARCHIVE_DATE Date

BUILDING Instance.Archive.BUILDING Text

FLOOR Instance.Archive.FLOOR Text

NOTES Instance.Archive.NOTES Text

PROAVID Instance.Archive.PROAVID Text

RACK Instance.Archive.RACK Text

ROOM Instance.Archive.ROOM Text

SHELF Instance.Archive.SHELF Text

AURORA_ERROR_RESUME Instance.Generic Instance.AURORA_ERROR_RESUME Clob

Label Instance.Generic Instance.LABEL Text

INSTANCE_GENRE Instance.InstanceGenre Text

INSTANCE_STATUS Instance.InstanceStatus Number

Junction

PRES_EVENT Junction.Junction.PRES_EVENT Text

SCHEDULING_REF_1 Junction.Junction.SCHEDULING_REF_1 Text

SCHEDULING_REF_2 Junction.Junction.SCHEDULING_REF_2 Text

KeySegment

DURATION KeySegment.Clip.DURATION Number

INSTANCELABEL KeySegment.Clip.INSTANCELABEL Text

Timecode IN KeySegment.Clip.TIMECODEIN Timecode

MaterialInfo

Created By Core.CreatedBy User

Creation Date Core.CreationDate Date

Description Core.Description Text

Genre Core.Genre Text

Keywords Core.Keywords Text

Preferred Page View Core.PreferredPageView Text

Title Core.Title Text
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Media

AR Core.AR Text

Bit rate Core.BitRate Text

Channels Core.Channels Number

Codec name Core.CodecName Text

Duration Core.Duration Text

Essence type Core.EssenceType Text

Frame rate Core.FrameRate Text

Height Core.Height Number

ISDROPFRAME Core.IsDropFrame Number

Sample rate Core.SampleRate Number

Sample size Core.SampleSize Number

Timecode IN Core.TimecodeOut Timecode

Width Core.Width Number

FILETYPE Media.File.FILETYPE Text

AFD Media.MMInstance.AFD Text

MomentumCore

ARCHIVE MomentumCore.ARCHIVE Text

ASPECT_RATIO MomentumCore.ASPECT_RATIO Text

ASSIGNED_CHANNELS MomentumCore.ASSIGNED_CHANNELS Text

CATEGORY_ID MomentumCore.CATEGORY_ID Text

DURATION MomentumCore.DURATION Text

EPISODE_NUMBER MomentumCore.EPISODE_NUMBER Number

FILED_DATE MomentumCore.FILED_DATE Date

FRAMERATE MomentumCore.FRAMERATE Number

XML MomentumCore.KSStore.XML Clob

MATERIAL_TYPE MomentumCore.MATERIAL_TYPE Text

MORPHEUS_ID MomentumCore.MORPHEUS_ID Text

NOTES MomentumCore.MomentumCore.NOTES Text

NUMBER_OF_TAPES MomentumCore.MomentumCore.NUMBER_OF_TAPES Number

ON_AIR_DURATION MomentumCore.MomentumCore.ON_AIR_DURATION Text

OWNER_ID MomentumCore.MomentumCore.OWNER_ID Number

PURGE_DATE MomentumCore.MomentumCore.PURGE_DATE Date

REQUIRED_DATE MomentumCore.MomentumCore.REQUIRED_DATE Date

REVIEWED_BY MomentumCore.MomentumCore.REVIEWED_BY Text
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RUN_ON_DURATION MomentumCore.MomentumCore.RUN_ON_DURATION Text

SCAVENGE MomentumCore.MomentumCore.SCAVENGE Number

SOM MomentumCore.MomentumCore.SOM Text

STATUS MomentumCore.MomentumCore.STATUS Text

SUBTITLE_REF MomentumCore.MomentumCore.SUBTITLE_REF Text

TITLE MomentumCore.MomentumCore.TITLE Text

BESCHREIBUNG MomentumCore.TPCCustomDef.BESCHREIBUNG Clob

CATEGORY MomentumCore.TPCCustomDef.CATEGORY Text

CLIP_FILE_DATE MomentumCore.TPCCustomDef.CLIP_FILE_DATE Date

DREHDATUM MomentumCore.TPCCustomDef.DREHDATUM Date

EBU_INHALT MomentumCore.TPCCustomDef.EBU_INHALT Text

EBU_SHOTLISTE MomentumCore.TPCCustomDef.EBU_SHOTLISTE Text

FORMAT MomentumCore.TPCCustomDef.FORMAT Text

KAMERA MomentumCore.TPCCustomDef.KAMERA Text

KOMMENTAR MomentumCore.TPCCustomDef.KOMMENTAR Text

ORIGINAL_ID MomentumCore.TPCCustomDef.ORIGINAL_ID Text

OWNER MomentumCore.TPCCustomDef.OWNER Text

QUELLE MomentumCore.TPCCustomDef.QUELLE Text

RECHTE MomentumCore.TPCCustomDef.RECHTE Text

REDAKTOR MomentumCore.TPCCustomDef.REDAKTOR Text

SCHNITT MomentumCore.TPCCustomDef.SCHNITT Text

AUDIOFORMATS MomentumCore.sQTitle.AUDIOFORMATS Text

CATEGORY MomentumCore.sQTitle.CATEGORY Text

CLIPGUID MomentumCore.sQTitle.CLIPGUID Text

CLIPID MomentumCore.sQTitle.CLIPID Number

CLIPNUMBER MomentumCore.sQTitle.CLIPNUMBER Number

CLONECLIPID MomentumCore.sQTitle.CLONECLIPID Number

CLONEZONE MomentumCore.sQTitle.CLONEZONE Number

COMPLETED MomentumCore.sQTitle.COMPLETED Date

CREATED MomentumCore.sQTitle.CREATED Date

DESTINATION MomentumCore.sQTitle.DESTINATION Text

DIVISION MomentumCore.sQTitle.DIVISION Text

FRAMES MomentumCore.sQTitle.FRAMES Number
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HASEDITDATA MomentumCore.sQTitle.HASEDITDATA Boolean

INPOINT MomentumCore.sQTitle.INPOINT Number

JOBID MomentumCore.sQTitle.JOBID Number

MODIFIED MomentumCore.sQTitle.MODIFIED Date

NUMAUDTRACKS MomentumCore.sQTitle.NUMAUDTRACKS Number

NUMVIDTRACKS MomentumCore.sQTitle.NUMVIDTRACKS Number

OUTPOINT MomentumCore.sQTitle.OUTPOINT Number

OWNER MomentumCore.sQTitle.OWNER Text

PLACEHOLDER MomentumCore.sQTitle.PLACEHOLDER Boolean

PLAYASPECT MomentumCore.sQTitle.PLAYASPECT Text

PLAYMODE MomentumCore.sQTitle.PLAYMODE Text

POOLID MomentumCore.sQTitle.POOLID Text

PUBLISHEDBY MomentumCore.sQTitle.PUBLISHEDBY Text

TAPE MomentumCore.sQTitle.TAPE Text

TEMPLATE MomentumCore.sQTitle.TEMPLATE Number

UNEDITED MomentumCore.sQTitle.UNEDITED Number

VDCPID MomentumCore.sQTitle.VDCPID Text

VIDEOFORMATS MomentumCore.sQTitle.VIDEOFORMATS Text

ZONEID MomentumCore.sQTitle.ZONEID Text

MomentumInstance

AUDIO_COMPRESSION MomentumInstance.AUDIO_COMPRESSION Number

AUDIO_MODE MomentumInstance.AUDIO_MODE Text

AUDIO_SAMPLE_RATE MomentumInstance.AUDIO_SAMPLE_RATE Number

AUDIO_SHUFFLING_ID MomentumInstance.AUDIO_SHUFFLING_ID Text

AUTO_QC MomentumInstance.AUTO_QC Date

CLIP_REF MomentumInstance.CLIP_REF Number

DELETE_AFTER MomentumInstance.DELETE_AFTER Date

DEVICE_ID MomentumInstance.DEVICE_ID Text

ENCODED MomentumInstance.ENCODED Number

INSTANCE_LABEL MomentumInstance.INSTANCE_LABEL Text

INSTANCE_STATUS MomentumInstance.INSTANCE_STATUS Number

LAST_AIRED_DATE MomentumInstance.LAST_AIRED_DATE Date

LAST_USED_DATE MomentumInstance.LAST_USED_DATE Date

LONG_FILE_ID MomentumInstance.LONG_FILE_ID Text

LTC MomentumInstance.LTC Text
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MAT_ID MomentumInstance.MAT_ID Text

ARCHIVE MomentumInstance.MomentumCore.ARCHIVE Text

ASPECT_RATIO MomentumInstance.MomentumCore.ASPECT_RATIO Text

ASSIGNED_CHANNELS MomentumInstance.MomentumCore.ASSIGNED_CHANNE
LS

Text

CATEGORY_ID MomentumInstance.MomentumCore.CATEGORY_ID Text

DURATION MomentumInstance.MomentumCore.DURATION Text

EPISODE_NUMBER MomentumInstance.MomentumCore.EPISODE_NUMBER Number

FILED_DATE MomentumInstance.MomentumCore.FILED_DATE Date

FRAMERATE MomentumInstance.MomentumCore.FRAMERATE Number

MATERIAL_TYPE MomentumInstance.MomentumCore.MATERIAL_TYPE Text

MORPHEUS_ID MomentumInstance.MomentumCore.MORPHEUS_ID Text

NOTES MomentumInstance.MomentumCore.NOTES Text

NUMBER_OF_TAPES MomentumInstance.MomentumCore.NUMBER_OF_TAPES Number

ON_AIR_DURATION MomentumInstance.MomentumCore.ON_AIR_DURATION Text

OWNER_ID MomentumInstance.MomentumCore.OWNER_ID Number

PURGE_DATE MomentumInstance.MomentumCore.PURGE_DATE Date

REQUIRED_DATE MomentumInstance.MomentumCore.REQUIRED_DATE Date

REVIEWED_BY MomentumInstance.MomentumCore.REVIEWED_BY Text

RUN_ON_DURATION MomentumInstance.MomentumCore.RUN_ON_DURATION Text

SCAVENGE MomentumInstance.MomentumCore.SCAVENGE Number

SOM MomentumInstance.MomentumCore.SOM Text

STATUS MomentumInstance.MomentumCore.STATUS Text

SUBTITLE_REF MomentumInstance.MomentumCore.SUBTITLE_REF Text

TITLE MomentumInstance.MomentumCore.TITLE Text

ProcAmp MomentumInstance.MomentumInstance.ProcAmp Text

QUALITY_CHECK MomentumInstance.MomentumInstance.QUALITY_CHECK Date

RECORDED_DATE MomentumInstance.MomentumInstance.RECORDED_DAT
E

Date

RUN_ON MomentumInstance.MomentumInstance.RUN_ON Number

SCAN MomentumInstance.MomentumInstance.SCAN Number

SOURCE_DEVICE_ID MomentumInstance.MomentumInstance.SOURCE_DEVICE
_ID

Text

TECHNICAL_COMMENT MomentumInstance.MomentumInstance.TECHNICAL_CO
MMENT

Text

TIMECODE_IN MomentumInstance.MomentumInstance.TIMECODE_IN Text
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TIMECODE_OUT MomentumInstance.MomentumInstance.TIMECODE_OUT Text

TV_STD MomentumInstance.MomentumInstance.TV_STD Number

USAGE_COUNT MomentumInstance.MomentumInstance.USAGE_COUNT Number

VIDEO_COMPRESSION MomentumInstance.MomentumInstance.VIDEO_COMPRE
SSION

Number

VITC MomentumInstance.MomentumInstance.VITC Text

Movie

CLASSIFICATION Movie.Movie.CLASSIFICATION Text

EPG_LONG Movie.Movie.EPG_LONG Text

EPG_SHORT Movie.Movie.EPG_SHORT Text

LANGUAGE Movie.Movie.LANGUAGE Text

ORIG_LANGUAGE Movie.Movie.ORIG_LANGUAGE Text

PART_NUMBER Movie.Movie.PART_NUMBER Number

PROD_YEAR Movie.Movie.PROD_YEAR Number

RIGHTS_HOLDER Movie.Movie.RIGHTS_HOLDER Text

SCHEDULING_REF_1 Movie.Movie.SCHEDULING_REF_1 Text

SCHEDULING_REF_2 Movie.Movie.SCHEDULING_REF_2 Text

SEQUENCE_NUMBER Movie.Movie.SEQUENCE_NUMBER Text

SEX Movie.Movie.SEX Text

SUPPLIER Movie.Movie.SUPPLIER Text

SYNOPSIS_LONG Movie.Movie.SYNOPSIS_LONG Text

SYNOPSIS_SHORT Movie.Movie.SYNOPSIS_SHORT Text

THEME Movie.Movie.THEME Text

TOTAL_PARTS_SEGMENTS Movie.Movie.TOTAL_PARTS_SEGMENTS Number

VERSION_TITLE Movie.Movie.VERSION_TITLE Text

VIOLENCE Movie.Movie.VIOLENCE Text

Programme

CLASSIFICATION Programme.Programme.CLASSIFICATION Text

EPG_LONG Programme.Programme.EPG_LONG Text

EPG_SHORT Programme.Programme.EPG_SHORT Text

EPISODE_NUMBER Programme.Programme.EPISODE_NUMBER Number

EPISODE_TITLE Programme.Programme.EPISODE_TITLE Text

LANGUAGE Programme.Programme.LANGUAGE Text

ORIG_LANGUAGE Programme.Programme.ORIG_LANGUAGE Text

PART_NUMBER Programme.Programme.PART_NUMBER Number
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PROD_YEAR Programme.Programme.PROD_YEAR Number

RIGHTS_HOLDER Programme.Programme.RIGHTS_HOLDER Text

SCHEDULING_REF_1 Programme.Programme.SCHEDULING_REF_1 Text

SCHEDULING_REF_2 Programme.Programme.SCHEDULING_REF_2 Text

SEQUENCE_NUMBER Programme.Programme.SEQUENCE_NUMBER Text

SERIES Programme.Programme.SERIES Text

SERIES_NUMBER Programme.Programme.SERIES_NUMBER Number

SERIES_TITLE Programme.Programme.SERIES_TITLE Text

SEX Programme.Programme.SEX Text

SUPPLIER Programme.Programme.SUPPLIER Text

SYNOPSIS_LONG Programme.Programme.SYNOPSIS_LONG Text

SYNOPSIS_SHORT Programme.Programme.SYNOPSIS_SHORT Text

THEME Programme.Programme.THEME Text

TOTAL_EPISODES Programme.Programme.TOTAL_EPISODES Number

TOTAL_PARTS_SEGMENTS Programme.Programme.TOTAL_PARTS_SEGMENTS Number

VERSION_TITLE Programme.Programme.VERSION_TITLE Text

VIOLENCE Programme.Programme.VIOLENCE Text

Promo

AUTO_TEXT_1 Promo.Promo.AUTO_TEXT_1 Text

AUTO_TEXT_2 Promo.Promo.AUTO_TEXT_2 Text

AUTO_TEXT_3 Promo.Promo.AUTO_TEXT_3 Text

AUTO_TEXT_4 Promo.Promo.AUTO_TEXT_4 Text

AUTO_TEXT_5 Promo.Promo.AUTO_TEXT_5 Text

EPISODE_TITLE Promo.Promo.EPISODE_TITLE Text

PROD_YEAR Promo.Promo.PROD_YEAR Number

SCHEDULING_REF_1 Promo.Promo.SCHEDULING_REF_1 Text

SCHEDULING_REF_2 Promo.Promo.SCHEDULING_REF_2 Text

SERIES_TITLE Promo.Promo.SERIES_TITLE Text

VERSION Promo.Promo.VERSION Text

sQInstance

AudioFormats SQInstance.SQInstance.AUDIOFORMATS Text

Category SQInstance.SQInstance.CATEGORY Text

ClipGUID SQInstance.SQInstance.CLIPGUID Text

ClipId SQInstance.SQInstance.CLIPID Number

ClipNumber SQInstance.SQInstance.CLIPNUMBER Number
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CloneClipID SQInstance.SQInstance.CLONECLIPID Number

CloneZone SQInstance.SQInstance.CLONEZONE Number

Completed SQInstance.SQInstance.COMPLETED Date

Created SQInstance.SQInstance.CREATED Date

Destination SQInstance.SQInstance.DESTINATION Timecode

Division SQInstance.SQInstance.DIVISION Text

Expiry SQInstance.SQInstance.EXPIRY Date

Frames SQInstance.SQInstance.FRAMES Number

HasEditData SQInstance.SQInstance.HASEDITDATA Boolean

Inpoint SQInstance.SQInstance.INPOINT Number

JobID SQInstance.SQInstance.JOBID Number

Modified SQInstance.SQInstance.MODIFIED Date

NumAudTracks SQInstance.SQInstance.NUMAUDTRACKS Number

NumVidTracks SQInstance.SQInstance.NUMVIDTRACKS Number

Outpoint SQInstance.SQInstance.OUTPOINT Number

Owner SQInstance.SQInstance.OWNER Text

PlaceHolder SQInstance.SQInstance.PLACEHOLDER Boolean

PlayAspect SQInstance.SQInstance.PLAYASPECT Text

PlayMode SQInstance.SQInstance.PLAYMODE Text

PoolId SQInstance.SQInstance.POOLID Text

PublishedBy SQInstance.SQInstance.PUBLISHEDBY Text

Tape SQInstance.SQInstance.TAPE Text

Template SQInstance.SQInstance.TEMPLATE Number

UnEdited SQInstance.SQInstance.UNEDITED Number

VDCPID SQInstance.SQInstance.VDCPID Text

VideoFormats SQInstance.SQInstance.VIDEOFORMATS Text

ZoneId SQInstance.SQInstance.ZONEID Text

OriginalOwner SQInstance.TPCOwnerDetect.ORIGINALOWNER Text

OwnerChngCount SQInstance.TPCOwnerDetect.OWNERCHNGCOUNT Number

SocialInstance

post_id SocialInstance.SocialInstance.POST_ID Text

post_text SocialInstance.SocialInstance.POST_TEXT Clob

Sport

COMPETITION Sport.Sport.COMPETITION Text

KEYWORD1 Sport.Sport.KEYWORD1 Text
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KEYWORD2 Sport.Sport.KEYWORD2 Text

KEYWORD3 Sport.Sport.KEYWORD3 Text

KEYWORD4 Sport.Sport.KEYWORD4 Text

KEYWORD5 Sport.Sport.KEYWORD5 Text

RESULT Sport.Sport.RESULT Text

SDATE Sport.Sport.SDATE Date

SPORT Sport.Sport.SPORT Text

SROUND Sport.Sport.SROUND Text

TEAM_A Sport.Sport.TEAM_A Text

TEAM_B Sport.Sport.TEAM_B Text

VENUE Sport.Sport.VENUE Text

SubtitleInstance

FORMAT Subtitle.Subtitle.FORMAT

LANGUAGE Subtitle.Subtitle.LANGUAGE

TEXT Subtitle.Subtitle.TEXT

ARCHIVE SubtitleInstance.MomentumCore.ARCHIVE

ASPECT_RATIO SubtitleInstance.MomentumCore.ASPECT_RATIO

ASSIGNED_CHANNELS SubtitleInstance.MomentumCore.ASSIGNED_CHANNELS

CATEGORY_ID SubtitleInstance.MomentumCore.CATEGORY_ID

DURATION SubtitleInstance.MomentumCore.DURATION

EPISODE_NUMBER SubtitleInstance.MomentumCore.EPISODE_NUMBER

FILED_DATE SubtitleInstance.MomentumCore.FILED_DATE

FRAMERATE SubtitleInstance.MomentumCore.FRAMERATE

MATERIAL_TYPE SubtitleInstance.MomentumCore.MATERIAL_TYPE

MORPHEUS_ID SubtitleInstance.MomentumCore.MORPHEUS_ID

NOTES SubtitleInstance.MomentumCore.NOTES

NUMBER_OF_TAPES SubtitleInstance.MomentumCore.NUMBER_OF_TAPES

ON_AIR_DURATION SubtitleInstance.MomentumCore.ON_AIR_DURATION

OWNER_ID SubtitleInstance.MomentumCore.OWNER_ID

PURGE_DATE SubtitleInstance.MomentumCore.PURGE_DATE

REQUIRED_DATE SubtitleInstance.MomentumCore.REQUIRED_DATE

REVIEWED_BY SubtitleInstance.MomentumCore.REVIEWED_BY

RUN_ON_DURATION SubtitleInstance.MomentumCore.RUN_ON_DURATION

SCAVENGE SubtitleInstance.MomentumCore.SCAVENGE

SOM SubtitleInstance.MomentumCore.SOM
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STATUS SubtitleInstance.MomentumCore.STATUS

SUBTITLE_REF SubtitleInstance.MomentumCore.SUBTITLE_REF

TITLE SubtitleInstance.MomentumCore.TITLE

AUDIO_COMPRESSION SubtitleInstance.MomentumInstance.AUDIO_COMPRESSIO
N

AUDIO_MODE SubtitleInstance.MomentumInstance.AUDIO_MODE

AUDIO_SAMPLE_RATE SubtitleInstance.MomentumInstance.AUDIO_SAMPLE_RAT
E

AUDIO_SHUFFLING_ID SubtitleInstance.MomentumInstance.AUDIO_SHUFFLING_I
D

AUTO_QC SubtitleInstance.MomentumInstance.AUTO_QC

CLIP_REF SubtitleInstance.MomentumInstance.CLIP_REF

DELETE_AFTER SubtitleInstance.MomentumInstance.DELETE_AFTER

DEVICE_ID SubtitleInstance.MomentumInstance.DEVICE_ID

ENCODED SubtitleInstance.MomentumInstance.ENCODED

INSTANCE_LABEL SubtitleInstance.MomentumInstance.INSTANCE_LABEL

INSTANCE_STATUS SubtitleInstance.MomentumInstance.INSTANCE_STATUS

LAST_AIRED_DATE SubtitleInstance.MomentumInstance.LAST_AIRED_DATE

LAST_USED_DATE SubtitleInstance.MomentumInstance.LAST_USED_DATE

LONG_FILE_ID SubtitleInstance.MomentumInstance.LONG_FILE_ID

LTC SubtitleInstance.MomentumInstance.LTC

MAT_ID SubtitleInstance.MomentumInstance.MAT_ID

ProcAmp SubtitleInstance.MomentumInstance.ProcAmp

QUALITY_CHECK SubtitleInstance.MomentumInstance.QUALITY_CHECK

RECORDED_DATE SubtitleInstance.MomentumInstance.RECORDED_DATE

RUN_ON SubtitleInstance.MomentumInstance.RUN_ON

SCAN SubtitleInstance.MomentumInstance.SCAN

SOURCE_DEVICE_ID SubtitleInstance.MomentumInstance.SOURCE_DEVICE_ID

TECHNICAL_COMMENT SubtitleInstance.MomentumInstance.TECHNICAL_COMME
NT

TIMECODE_IN SubtitleInstance.MomentumInstance.TIMECODE_IN

TIMECODE_OUT SubtitleInstance.MomentumInstance.TIMECODE_OUT

TV_STD SubtitleInstance.MomentumInstance.TV_STD

USAGE_COUNT SubtitleInstance.MomentumInstance.USAGE_COUNT

VIDEO_COMPRESSION SubtitleInstance.MomentumInstance.VIDEO_COMPRESSIO
N

VITC SubtitleInstance.MomentumInstance.VITC
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Thumb

height Thumb.Thumb.HEIGHT Number

offset Thumb.Thumb.OFFSET Number

path Thumb.Thumb.PATH Text

width Thumb.Thumb.WIDTH Number

TimeLine

EdlContent TimeLine.Editlist.Content Clob

FRAMERATE TimeLine.Editlist.FRAMERATE Text

ISDROPFRAME TimeLine.Editlist.ISDROPFRAME Number

WJZ

BROADCASTVIDEOFORMAT WJZ.WJZ.BROADCASTVIDEOFORMAT Text

EXPIREDDATE WJZ.WJZ.EXPIREDDATE Date

HASCONTENT WJZ.WJZ.HASCONTENT Boolean

IMPORTSTATUS WJZ.WJZ.IMPORTSTATUS Text

ISOFFLINE WJZ.WJZ.ISOFFLINE Boolean

ISPROTECTED WJZ.WJZ.ISPROTECTED Boolean
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Product Support
Providing Information to Grass Valley
If you experience any technical or operational difficulties with a Grass Valley product please 
do not hesitate to contact us to request assistance.

There is a lot of information you can give us that will enable us to diagnose your problem 
swiftly. Please read the following guidelines, as these suggestions will help us to help you.

Basic Information
• For Units: Provide the exact product Model, unit Serial Number and Software 

Version information.

Software Application
• Inputs: Provide full details of the Input Signals being used including any 

references, etc., and where they are being generated.
• Outputs: Provide full details of the Output Signals required and how they are being 

monitored.
• System: Provide a brief description of the system in which your equipment is 

currently being used.

Your Contact Details
In addition to the above, remember to provide us with your contact details to enable us to 
get in touch with you swiftly:

• Name(s)
• Telephone
• E-mail addresses
• Business address
• Contact Details

Customer Support
For details of our Regional Customer Support Offices, please visit the Grass Valley website 
and navigate to Support/Contacts Support.

http://www.grassvalley.com/support

Customers with a support contract should call their personalized number, which can be 
found in the contract, and be ready to provide their contract number and details.
 239
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Contact Us
Grass Valley Technical Support
For details of our Regional Customer Support Offices please visit the Grass Valley web site 
and navigate to: Support > Customer Care.

https://grassvalley.com/support

Customers with a support contract should call their personalized number, which can be 
found in their contract, and be ready to provide their contract number and details.

Corporate Head Office
Grass Valley
3499 Douglas-B.-Floreani
St-Laurent, Quebec H4S 2C6
Canada
Telephone: +1 514 333 1772
Fax: +1 514 333 9828
www.grassvalley.com

https://grassvalley.com/support
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